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Change History

This table lists changes made to this guide. Most recent changes appear at the top.

Changes Section Date

New chapter added for digital channels | Digital Channels with imiconnect August, 2021
with imiconnect
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Changes Section

Date

Initial release of this document

+ Agent Greeting

* Whisper Announcement
* Courtesy Callback

* DB Integration (DB Lookup)
* Outbound Option

* Post Call Survey

* A-law Codec

* CM Silent Monitoring

* Music on Hold

» Agent Request

» Extension Mobility

* Precision Queue

* Task Routing

Added the following HCS for CC for CC features:

January, 2019

About This Guide

This guide explains features you can use in conjunction with Cisco Hosted Collaboration Solution for Contact
Center for Contact Center. For each feature, there is a description, procedures for initial setup, and details on

Audience
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the functionality the feature provides.

This document is prepared for:

* Contact center administrators who configure and run the contact center, manage agents and supervisors,

and address operational issues.

* Contact center supervisors, who lead agent teams and are responsible for team performance

This document is written with the understanding that your system has been deployed by a partner or service
provider who has validated the deployment type, virtual machines, and database and has verified that your

contact center can receive and send calls.
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Related Documents

Document or resource Link

Documentation Guide for Cisco Hosted | https://www.cisco.com/c/en/us/support/unified-communications/
Collaboration Solutions for Contact | hosted-collaboration-solution-contact-center/
Center products-documentation-roadmaps-list.html

Solution Design Guide for Cisco Hosted | https://www.cisco.com/c/en/us/support/unified-communications/
Collaboration Solutions for Contact | hosted-collaboration-solution-contact-center/
Center products-implementation-design-guides-list.html

Configuration Guide for Cisco Hosted | https://www.cisco.com/c/en/us/support/unified-communications/
Collaboration Solutions for Contact | hosted-collaboration-solution-contact-center/

Center products-installation-guides-list.html

Release Notes for Cisco Hosted https://www.cisco.com/c/en/us/support/unified-communications/
Collaboration Solutions for Contact | hosted-collaboration-solution-contact-center/

Center products-release-notes-list.html

Communications, Services, and Additional Information

* To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.
* To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.
* To submit a service request, visit Cisco Support.

* To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit
Cisco Marketplace.

* To obtain general networking, training, and certification titles, visit Cisco Press.

* To find warranty information for a specific product or product family, access Cisco Warranty Finder.

Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system
that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides
you with detailed defect information about your products and software.

Field Notice

Cisco publishes Field Notices to notify customers and partners about significant issues in Cisco products that
typically require an upgrade, workaround, or other user action. For more information, see Product Field Notice
Summary at https://www.cisco.com/c/en/us/support/web/tsd-products-field-notice-summary.html.

You can create custom subscriptions for Cisco products, series, or software to receive email alerts or consume
RSS feeds when new announcements are released for the following notices:
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* Cisco Security Advisories

* Field Notices

* End-of-Sale or Support Announcements

* Software Updates

+ Updates to Known Bugs

For more information on creating custom subscriptions, see My Notifications at https://cway.cisco.com/

mynotifications.

Documentation Feedback

To provide comments about this document, send an email message to the following address:
contactcenterproducts_docfeedback@cisco.com

We appreciate your comments.

Conventions

This document uses the following conventions:

Convention

Description

boldface font

Boldface font is used to indicate commands, such as user entries, keys, buttons,
folder names, and submenu names.

For example:
* Choose Edit > Find.
* Click Finish.

italic font

Italic font is used to indicate the following:

* To introduce a new term. Example: A skill group is a collection of agents
who share similar skills.

* A syntax value that the user must replace. Example: IF (condition, true-value,
false-value)

* A book title. Example: See the Cisco Unified Contact Center Enterprise
Installation and Upgrade Guide.

window font

Window font, such as Courier, is used for the following:

* Text as it appears in code or that the window displays. Example:
<html><title>Cisco Systems, Inc. </title></html>
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Convention

Description

Angle brackets are used to indicate the following:

* For arguments where the context does not allow italic, such as ASCII output.

* A character string that the user enters but that does not appear on the window
such as a password.
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CHAPTER 1

A-law Codec

* Configure Gateway, on page 1
* Configure Unified CVP, on page 3
* Configure Unified Communication Manager, on page 5

Configure Gateway

* Configure Ingress Gateway, on page 1

* Configure VXML Gateway, on page 2

Configure Ingress Gateway

Procedure

Step 1 Add the voice class codec 1 to set the codec preference in dial-peer:

Example:

voice class codec 1
codec preference 1 g729r8
codec preference 2 g7llalaw
codec preference 3 g7llulaw

dial-peer voice 70021 voip
description Used for Switch leg SIP Direct
preference 1
max-conn 225
destination-pattern xXxxx...... # Customer specific destination
session protocol sipv2
session target ipvd:###.###. ##4#.### # IP Address for Unified CVP
session transport tcp
voice class codec 1
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
no vad

Step 2 Modify the dial-peer to specify the codec explicitly for a dial-peer:
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. Configure VXML Gateway

dial-peer voice 9 voip

description For Outbound Call for Customer

destination-pattern <Customer Phone Number Pattern>

session protocol sipv2

session target ipv4:<Customer SIP Cloud IP Address>

session transport tcp

voice-class sip rellxx supported "100rel"

voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte

codec g7llalaw

no vad

dial-peer voice 10 voip

description ***To CUCM Agent Extension For Outbound***
destination-pattern <Agent Extension Pattern to CUCM>
session protocol sipv2

session target ipv4:<CUCM IP Address>

voice-class sip rellxx supported "100rel"

dtmf-relay rtp-nte

codec g7llalaw

Configure VXML Gateway

Procedure

Modify the following dial-peer to specify the codec explicitly for a dial-peer:

dial-peer voice 919191 voip

description Unified CVP SIP ringtone dial-peer
service ringtone

incoming called-number 9191T

voice-class sip rellxx disable

dtmf-relay rtp-nte

codec g7llalaw

no vad

dial-peer voice 929292 voip

description CVP SIP error dial-peer
service cvperror

incoming called-number 9292T
voice-class sip rellxx disable
dtmf-relay rtp-nte

codec g7llalaw

no vad

dial-peer voice 7777 voip

description Used for VRU leg #Configure VXML leg where the incoming called
service bootstrap

incoming called-number 7777T

dtmf-relay rtp-nte

codec g7llalaw

no vad

dial-peer voice 5 voip

description for SIP TTS Media Call
preference 1

session protocol sipv2

session target ipvé4: <ASR primary server IP>
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Configure Unified CVP [

destination uri tts

voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte

codec g7llalaw

no vad

dial-peer voice 6 voip
description for SIP ASR Media Call
preference 1
session protocol sipv2
session target ipv4: <TTS primary server IP>
destination uri asr
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
codec g7llalaw
no vad

dial-peer voice 7 voip
description for SIP TTS Media Call
preference 2
session protocol sipv2
session target ipv4: <ASR secondary server IP>
destination uri tts
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
codec g7llalaw
no vad

dial-peer voice 8 voip
description for SIP ASR Media Call
preference 2
session protocol sipv2
session target ipv4: <TTS secondary server IP>
destination uri asr
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
codec g7llalaw
no vad

Configure Unified CVP

Unified CVP does not require any specific configuration in OAMP.
You must convert the following files to A-law:

C:\inetpub\wwwroot\en-us\app
C:\inetpub\wwwroot\en-us\app\ag_gr
C:\inetpub\wwwroot\en-us\sys
C:\Cisco\CVP\OPSConsoleServer\GWDownloads in OAMP server
C:\Cisco\CVP\VXMLServer\Tomcat\webapps\CVP\audio

g rwbdE
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. Enable Recording for Agent Greeting and Courtesy Callback

\)

Note * After converting the files in the OAMP server, access the Unified CVP OAMP page to upload the newly
converted A-law files to the gateway.

* [f gateways are previously used for u-law, then restart the gateway to clear the u-law files in the gateway
cache.

Complete the following procedure to convert mu-law audio files to a-law format:

Procedure
Step 1 Copy the wav file from Unified CVP to your local desktop.
Step 2 Go to All programs> Accessories> Entertainment.
Step 3 Open the Sound Recor der.
Step 4 Select File and click Open.
Step 5 Browse for the mu-law audio file and click Open.
Step 6 Go to Properties.
Step 7 Click Convert Now.
Step 8 Select CCITT A-Law from Format.
Step 9 Click OK.
Step 10 Select Files> Save As and provide a filename.
Step 11 Copy the new a-law format file into the following directory of media server:

C:\inetpub\wwwroot\en-us\app

Enable Recording for Agent Greeting and Courtesy Callback

Complete the following procedure to enable recording for Agent Greeting and Courtesy Callback.

Procedure

Step 1 Open the call studio and go to the callback entry application.
Step 2 Double-click app.callflow.

Step 3 Go to Record Name element settings and change the File Type to other (default is wav).
Step 4 Set the MIME type to audio/x-alaw-basic.
Step 5 Set the File extension as wav

Step 6 Validate, save, and deploy the application.
Step 7 Restart the Unified CVP services.
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Configure Unified Communication Manager

Complete the following procedure to provision a-Law through Cisco Unified Communications Manager:

Procedure
Step 1 Login to the Cisco Unified Communication Manager Administration page.
Step 2 Navigate to System > Service Parameter.
Step 3 Choose publisher server from Server drop-down list.

Step 4 Choose Cisco CallManager (Active) from Service drop-down list.

Step 5 In Cluster Wide Parameter s (System - L ocation and region), choose Enabled for All Devices from G.711
A-law Codec Enabled drop-down list.

Step 6 Choose Disable from following drop-down lists:
+ G.711 mu-law Codec Enabled

» G.722 Codec Enabled
» iLBC Codec Enabled
* iISAC Codec Enabled

Step 7 Click Save.
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CHAPTER 2

Agent Request

» Agent Request Feature Description, on page 7

* Configure Unified CCE for Agent Request, on page 10

* Configure SocialMiner for a Voice Callback Agent Request, on page 13

» Agent Request Script, on page 14

* Use the Sample Code to Create a Customer Callback Request, on page 16
» Agent Request Reporting, on page 17

Agent Request Feature Description

The Agent Request feature allows a customer to initiate a request on the web that results in a call from an
agent.

To use Agent Request, your solution requires the Cisco SocialMiner optional component. Cisco SocialMiner
works in a Contact Center Enterprise (Unified CCE) solution to process the request from its inception through
the delivery of the callback.

|

Important  The Agent Request feature can be used only if the customer or a partner develops a custom application. There
is sample code on DevNet (formerly Cisco Developer Network) that you can use to understand how to start
building your custom application to submit callback requests to SocialMiner.

SocialMiner and Agent Request

SocialMiner provides the Callback API used by a custom application to request a phone call from a contact
center agent.

The API works in conjunction with SocialMiner callback feeds, campaigns, and notifications to pass callback
requests to the contact center for routing.

The Callback API:

+ Allows custom applications to initiate a callback.

* Forwards the callback request and callback details to Unified CCE using a notification mechanism (the
Connection to Unified CCE notification type) through a Media Routing (MR) connection.
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+ Allows custom applications to retrieve the state of the callback as well as the estimated wait time (EWT)
until an agent becomes available.

+ Allows custom applications to cancel a requested callback.

The Callback API supports the use of Call variables and ECC variables for callback requests. Call variables
and ECC variables send customer-specific information with the request. When you create a callback contact,
the social contact associated with the callback contact includes all of the specified variables as extension
fields.
Unified CCE and Agent Request
When it receives an Agent Request, Unified CCE performs these tasks:

* Process the callback request.

* Route the callback request to an agent and place a call from the agent's phone to the customer.

* Notify SocialMiner that the agent has been selected.

Agent Desktops and Agent Request
Cisco Finesse supports Agent Request.

Enterprise Chat and Email and Agent Request
To configure prefixes and filters for dialed numbers in Enterprise Chat and Email, you must use the Unified
CCE Script Editor.
Unsupported Environments
Agent Request is not supported:
* In a Parent/Child deployment
» With Mobile Agents

* In a hybrid deployment

Agent Request Prerequisites

Install and configure SocialMiner before implementing Agent Request. SocialMiner must be geographically
colocated with one side of the Media Routing Peripheral Gateway (MR PG).

The customer or partner must build a custom application for the Agent Request feature. See Use the Sample
Code to Create a Customer Callback Request, on page 16.

SocialMiner is always deployed in a DMZ. Remember to open the port you have configured for the MR PG.
See Set up the Media Routing PG and PIM, on page 12.

Agent Request Call Flow

The flow proceeds as follows:
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3.

SocialMiner sends the request to the Media Routing PG.
a. The Media Routing PG sends the request to the Router.

b. The Router sends the request to the Agent PG.

Cc. The Agent PG sends the request to the agent.

\}

The customer application initiates an agent request by requesting a callback.

Agent Request Scenarios .

A call is initiated from the agent's phone, on behalf of the agent, dialing the customer's phone number.

Note

The agent does not control when the call is placed.

Figure 1: Agent Request Call Flow

Customer

Social
Miner

MR PG i = Router --» AgentPG

Agent
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Agent Request Scenarios

1.

2
3.
4

From the web, the customer requests to speak to an agent.

The customer receives feedback that the request is accepted.

The customer receives feedback that a call is on its way.

The customer receives feedback that the call is queued and the estimated wait time.
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5. The agent's phone places an outbound call.

6. The agent is presented with call context.

If Then
The customer is available The customer receives and answers the call, and speaks to the
agent

The customer is busy when the callback | The agent receives a busy tone
occurs

The customer does not answer when the | The agent hears ringing
callback occurs

The customer cancels the callback before | There is no impact on the agent
an agent is selected

Configure Unified CCE for Agent Request

The following information describes how to configure Agent Request for a Unified CCE deployment.

| A

Important  Configure Unified CCE before you configure SocialMiner.

Configuration Manager

Use these Configuration Manager tools and procedures to configure Agent Request.
Configure Network VRU and Network VRU Script

Procedure

Step 1 In the Configuration Manager, use the Network VRU Explorer tool to configure and save a type 2 VRU. The
Network VRU is used to queue voice callback tasks if an agent is not available to handle them.

Step 2 In the Configuration Manager, use the Network VRU Script List tool to add a Network VRU Script that
references the Network VRU that you configured in Step 1.

The Network VRU Script is used for Estimated Wait Time.
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Configure the Media Routing PG and PIM

Procedure
Step 1 In Configuration Manager, open the PG Explorer tool to configure a media routing PG.
Step 2 Create a media routing PIM and routing client for SocialMiner.

Write down the Logical Controller ID and the Peripheral ID. You will use them when you set up the PG.

Step 3 On the Peripheral tab in the PG Explorer tool, check the Enable post routing check box.

Step 4 On the Routing Client tab in the PG Explorer tool, select the Multichannel option from the Routing Type
drop-down list box.

Step 5 On the Advanced tab in the PG Explorer tool, select the type 2 Network VRU that you created.

Configure Call Type

Procedure

Open the Call Type List tool, and create a call type to handle calls from an agent request voice callback.

Configure Dialed Number/Script Selector

Procedure

Step 1 Open the Dialed Number/Script Selector List tool, and create a script selector on the routing client that you
configured. SocialMiner uses this script selector to request agents for voice callback. (The script selector
configured here must be the same as the one entered in the SocialMiner notification.)

Step 2 On the Attributes tab, select Cisco_Voice from the M edia routing domain drop-down list box.
Step 3 On the Dialed Number M apping tab, map the script selector to the call type you created.

Configure ECC Variables

Procedure

Step 1 Open the Expanded Call Variable List tool.
Step 2 Add one or more ECC Variables for the callback request.
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Note Arrays are not supported with the Agent Request feature.

CCE solutions support the Latin 1 character set only for Expanded Call Context variables and Call
variables when used with CVP, Finesse, and SocialMiner. CCE also supports the use of multi-byte
character sets in limited usage for ECC and call variables when setting them in Script Editor using
double quotes.

Set up the Media Routing PG and PIM

Step 1
Step 2

Step 3
Step 4
Step 5

Step 6

Step 7
Step 8
Step 9
Step 10
Step 11
Step 12

Procedure

From Cisco Unified CCE Tools, select Peripheral Gateway Setup.

On the Components Setup screen, in the Instance Components panel, select the PG Instance component. If
the PG does not exist, click Add. If it exists, click Edit.

In the Peripheral Gateways Properties screen, click M edia Routing. Click Next.
Click Yesat the prompt to stop the service.

From the Peripheral Gateway Component Properties screen, click Add, select the next PIM, and configure
with the Client Type of Media Routing as follows.

a) Check Enabled.

b) In the Peripheral Name field, enter MR.

¢) For Application Hostname (1), enter the hostname or IP address of SocialMiner.

Note The system does not support IP address change. Use the hostname if you foresee a change in
IP address. This is applicable for all the Hostname/ | P Address fields.

d) By default, SocialMiner accepts the MR connection on Application Connection Port 38001. The
Application Connection Port setting on SocialMiner must match the setting on the MR PG; if you change
the port on one side of the connection, you must change it on the other side.

e) Leave the Application Hostname (2), field blank.

f) Keep all other values.

g) Click OK.

On the Peripheral Gateway Component Properties screen, enter the Logical Controller ID that you recorded
when you configured the Media Routing PG and PIM.

Accept defaults and click Next until the Setup Complete screen opens.

At the Setup Complete screen, check Yesto start the service. Click Finish.

Click Exit Setup.

Repeat from Step 1 for Side B.

Navigate to Unified CCE Administration > I nfrastructure Settings> Inventory.
Add SocialMiner as an external machine.

a) Click Add.

b) Select SocialMiner from the drop-down list.

c) Enter the required information.
d) Click Save.
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The system automatically enables and completes the CCE Configuration for Multichannel Routing settings
in SocialMiner Administration, including the Application Connection Port you specified.

Configure SocialMiner for a Voice Callback Agent Request

To support a callback request, SocialMiner must be configured with:

* A callback feed
* A campaign

* A Connection to CCE notification configured for the campaign mentioned above that will be triggered
by incoming callback requests with a matching tag.

Create Feed

Procedure

Step 1 Sign in to SocialMiner.

Step 2 Click Configuration.

Step 3 On the Manage Feeds panel, click New.

Step 4 For Type, select Callback.

Step 5 Name the feed.

Step 6 For Reply Template, retain the default, No reply template.

Step 7 Configure the feed to automatically tag all callback requests that come in on that feed. For example, autotag
with 'sendtocontactcenter’.

Make a note of the tag. It is used to trigger the notification to CCE.
Step 8 Click Save.

Create Campaign

Procedure

Step 1 Sign in to SocialMiner.

Step 2 Click Configuration.

Step 3 On the Manage Campaigns panel, click New.

Step 4 Name the campaign.

Step 5 Enter an optional description.

Step 6 Make no selection in the Chat I nvitation Feed drop-down list.
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Step 7
Step 8

Agent Request |

Locate the Callback feed in the Available panel and move it to Selected.
Click Save.

Create Notification

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Step 8
Step 9

Step 10

Procedure

Sign in to SocialMiner.

Click Administration.

On the Manage Notifications panel, click New.

For Type, select Connection to CCE.

Name the notification.

From the Campaigns drop-down list, select the campaign that you created for the callback.

In the Tags field, enter the tag that is automatically applied to callback requests by the feed. In our example
'sendtocontactcenter’.

For Request Type, select Callback.
In the Dialed Number/Script Selector field, enter the dialed number string that you have configured.

See Configure Dialed Number/Script Selector, on page 11.

Click Save.

What to do next

For more SocialMiner configuration information, see the Cisco SocialMiner User Guide at
https://www.cisco.com/c/en/us/support/customer-collaboration/socialminer/products-user-guide-list.html.

Agent Request Script

The Agent Request Script is used to implement an optional dial-plan, queue a call to the skill group node, and
calculate the estimated wait time for a voice callback to a customer.

A customer who requests a voice callback might want to know approximately how long it will be before the
call is returned. You can configure voice callback to provide an estimate of the wait time back to the customer.
The estimated wait time is calculated once, when the call enters the queue. The time is not updated as the
position in the queue changes.

The default estimated wait time algorithm is based on a running five minute window of the rate of calls leaving
the queue. Any calls that are routed or abandoned during the first five minutes are taken into account as part
of the rate leaving queue. For Precision Queues, the rate leaving queue represents the rate at which calls are
delivered or abandoned from the entire Precision queue, not any individual Precision Queue steps. The
algorithm computes the wait time for each of the queues against which the call is queued (Skill Groups or
Precision Queues) and then returns the minimum estimated wait time. Queue to Agent is not supported.

. Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.0(1)


https://www.cisco.com/c/en/us/support/customer-collaboration/socialminer/products-user-guide-list.html

| AgentRequest

Create Agent Request Script .

While the queue builds, the small number of calls in the queue makes the estimated wait time less accurate
and the value fluctuates rapidly. As the queue operates with more calls over time, the estimated wait time is
more accurate and consistent.

\)

Note The built-in function also applies to inbound calls that queue.

: Start

Call.CalingLine=ID
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-
| ueue to Skill Grou -
8 | g s = Set Variable
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Create Agent Request Script

To create a Agent Request script:

Procedure

Step 1 Start node: Create the Start node by selecting a new Routing Script from the Script Editor.

Step 2 Set Variable (Call.Calling Line ID) node: (optional). If required, you can set the CallingLineID (CLID/
ANI) variable to implement a "dial-plan," pre-pending a set of digits to the phone number provided by the
customer so that it can be correctly routed. For example, it is often necessary to add 9 to the phone number
to reach an outside line. In other cases, more pre-pended digits may be required to reach the end customer.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.0(1) .



Agent Request |

. Use the Sample Code to Create a Customer Callback Request

Step 3

Step 4

Step 5

Step 6
Step 7

You can also set up Unified Communications Manager Route Patterns to respond to a certain set of digits by
routing the call to an outside line with a specified area code. To implement a dial-plan, add a Set Variable
node before the queue, as shown in this example. In this case, a 9 is pre-pended to the customer phone number
using the built-in concatenate function.

Queueto SKkill Group node: The Agent Request call can be queued against one or more Skill Groups,
Precision Queues, or a queue-to-agent node. In the example script, the call is queued against a single skill
group.

Set Variable (Call.Estimated Wait Time) node: Set the Call Wait time as follows:

a) From the Set Variable node, select Call from the Object type drop-down menu.

b) From the Variable drop-down menu, choose Estimated Wait Time(). You can then work with the
Formula Editor to use the default estimated wait value or create a formula and use your own value.

¢) Click Formula Editor. You can either use the default estimated wait value, by clicking the Built-In
Functionstab and choosing EstimatedWaitTime() . Or to create a formula and use your own estimated
time value, click the Variablestab, and choose an entry in the Object type list and Object list. Then
double-click a variable in the Variable list.

Run Ext Script node: Apply the Network VRU script as follows:

a) Click the Queue tab.

b) Click Run External Script.

c) Click inside the script. A Run External Script node appears.

d) Double-click the node and choose the Network VRU script from the list and then click OK. The call
variable Estimated Wait Time now contains a value in the EstimatedWaitTime field and can be passed
to peripherals.

Note that a Run External Script node is required to send the EstimatedWaitTime to SocialMiner.

Wait node: The wait period for an agent becomes available.
End node: The script ends if no agent becomes available.

Use the Sample Code to Create a Customer Callback Request

Step 1

Cisco Systems has made sample callback application code available to use as a baseline in building your own
application. This sample includes retrieving and displaying the estimated wait time, assuming it has been
configured in Unified CCE. You can find the sample code on DevNet.

)

Note You cannot copy and paste this code to achieve a working application. It is a only a guideline.

For more information about how to use the Callback API, see the Cisco SocialMiner Developer Guide at
https://developer.cisco.com/site/socialminer/documentation/.

Procedure

Retrieve the feed id by entering this URL in a browser:
https.//<SocialMiner_Hostname _or_| p>/ccp-webapp/ccp/feed.
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In the example output below, note that the value in the <name> field is "Callback." Look for the number of
the feed id identified at the end of the refURL path (in this case, it is 100000) just before the </refURL> tag.
Copy this number.

<feeds>

<Feed>

<changeStamp>0</changeStamp>

<name>Callback</name>
<pushFeedURL>https://128.107.81.27/ccp/callback/feed/100000</pushFeedURL>
<refURL>https://128.107.81.27/ccp-webapp/ccp/feed/100000</refURL>
<status>1</status>

<tags>

<tag>trial</tag>

</tags>

<type>10</type>

</Feed>

</feeds>

Step 2 Access the sample application from DevNet: https://developer.cisco.com.
Step 3 Enter values in the fields:

* Title: A title or subject for the callback request.
* Author: The name of the person submitting the callback request.
* Phone: The phone number to call back.

 Feed Id: The value from the refURL above.

Step 4 Click Call me back.

Agent Request Reporting

Cisco Unified Intelligence Center CCE reports include data for Agent Requests

\}

Note  Agent requests that fail before being routed to CCE will not be included in the CCE solution-level reports.
The SocialMiner search function can be used to identify these requests.

Call Type and Call Type Skill Group Metrics
+ Calls Offered — Incremented when Call Type is entered (through Script Selector or Call Type node).

+ CallsAbandoned in Queue — Incremented when a Queued Callback request is canceled by the customer
prior to when an Agent is selected to handle the Voice Callback call.

* CallsAnswered — Incremented if the call is placed from the agent and represents work accepted by the
agent.

 CallsHandled — Incremented if the customer answers the call. Calls Answered minus Calls Handled
indicates how many calls failed to reach the intended customer.
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* Service L evel Offered — Incremented for all routed calls, including voice callback calls initiated through
the agent request API.

* Servicel evelCalls— Incremented if the call is presented to the agent within a service level.

» Answer Intervals (1 - 10) — The appropriate bucket is incremented based on how long the call was in
the queue.

Skill Group Metrics

Call Type Skill Group and Skill Group metrics are not counted in the same way. The skill group metric treats
each call as agent-initiated; therefore, Calls Answered and Calls Handled are not incremented.
AgentOutCallsTime, AgentOutCalls, AgentOutCallsTalkTime, AgentOutCallsOnHold, and
AgentOutCallsOnHoldTime are incremented.

Agent Real Time

The direction in the Agent Real Time table is listed as Outbound.

Termination Call Detail
For custom reporting, the Termination Call Detail records contain a PeripheralCallType of 41 -Voice Callback.

Calls which do not successfully connect to a customer have a call disposition of 10 - Disconnect/Drop no
answer. This includes agent request calls to busy numbers.
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Agent Greeting

* Capabilities, on page 19

* Configure Agent Greeting, on page 22
* Reporting, on page 35

* Serviceability, on page 36

Capabilities

With Agent Greeting, you can play a configurable, automated greeting to callers. Every caller receives a clear,
well-paced, language-appropriate, and enthusiastic introduction from the answering agent. Agent Greeting
relieves your agents from speaking opening scripts. Instead, your agents can spends the time reviewing the
desktop screen pop-ups while the greeting plays.

Recording a greeting is much the same as recording a message for voice mail. Depending on how you set up
the call center, agents record different greetings that play for different types of callers (for example, an English
greeting for English speakers or an Italian greeting for Italian speakers).

Agent Greeting is available to agents and supervisors who use IP Phones with Built-in-Bridge (BiB) that are
controlled by the Unified CCE and Unified CM.

Figure 2: Agent Greeting
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Thank you'
for calling
Super Tablet

Thank you'
faor calling
Super Tablet

Let's get
that camera
fimed.

Thank you'
for calling
Super Tablet

Thank you'
for ealling
Super Tablet

2113

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.0(1) .



Agent Greeting |
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Agent Greeting Phone Requirements for Local Agents

Agent Greeting is available to agents and supervisors who use IP Phones with Built-In Bridge (BIB). These
agents are typically located within a contact center. Phones used with Agent Greeting must meet these
requirements:

* The phones must have the BIB feature.

\}

Note If you disable BIB, the system attempts to use a conference bridge for agent
greeting call flow and raises a warning event.

* Ensure that the phone's firmware is up to date. (Usually, phone firmware upgrades automatically when
you upgrade your Unified CM installation.)

* For a list of supported phones for contact center enterprise solutions, see the Compatibility Matrix for
your solution at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-device-support-tables-list.html.

Agent Greeting Call Flows

Figure 3: Agent Greeting Call Flow

Contact Center Enterprise Solutions
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1.  The incoming call arrives from CUBE or a TDM gateway at CVP.
2. CVP sends the incoming call to Unified CCE.
3. Unified CCE instructs CVP to queue the call.
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CVP sends the call to the Voice Browser for VRU treatment.

When an agent is available, Unified CCE sends the agent number to CVP.
CVP sends the call to Unified CM.

Unified CM establishes the connection to the agent phone.

The caller connects to the agent phone and stops hearing the ringback.

© © N o g k&

Unified CCE determines which CVP to invoke, and instructs Unified CM to tell the phone BIB to open
a stream to CVP.

10. Unified CCE and CVP shake hands to set the trigger for CVP to let it know which greeting to play.
11. CVP instructs the Voice Browser to have the Media Server play the greeting.

12. The phone's BIB mixes the greeting. After the greeting plays, CVP disconnects and the agent speaks
with the caller.

Agent Greeting Considerations

Consider these points when you add Agent Greeting to your solution:

» Agent Greeting does not support outbound calls made by an agent. The announcement plays for inbound
calls only.

* Only one Agent Greeting file plays per call.
* Supervisors cannot listen to agent recorded greetings.
» Agent Greetings do not play when the router selects the agent through a label node.

» Agent Greeting supports Unified CM-based Silent Monitoring with this exception: Supervisors cannot
hear the greetings themselves. If a supervisor starts a silent monitoring session while a greeting plays, a
message appears that a greeting is playing and to try again shortly.

* Use either G.711 a-law or mu-law for the VRU leg on the Voice Browser dial-peer. Do not use the
voice-class codec.

* In general, Agent Greeting feature requires shorter latency across the system. For example, the public
network has a maximum round-trip latency of 100 ms to support Agent Greeting feature as designed.

Agent Greeting requires the following:

* The phones have the BIB feature.
* The phones must run the latest firmware version delivered with Unified Communications Manager.

* The phones must be have BIB enabled in Unified Communications Manager.

Agent Greeting with Whisper Announcement

You can use Agent Greeting with the Whisper Announcement feature. Consider these points when using them
together:

* The Whisper Announcement always plays first.
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* To shorten your call-handling time, use shorter Whisper Announcements and Agent Greetings than if
you were using either feature by itself. A long Whisper Announcement followed by a long Agent Greeting
equals a long wait before an agent actively handles a call.

* If you use a Whisper Announcement, your agents probably handle different types of calls: for example,
“English-Gold Member-Activate Card,” “English-Gold Member-Report Lost Card,” “English-Platinum
Member-Account Inquiry.” Ensure that greetings your agents record are generic enough to cover the
range of call types.

Configure Agent Greeting

This section describes how to deploy and configure the Agent Greeting feature.

Initial Setup

This section is intended for system administrators responsible for installing and configuring Unified CCE. It
describes the one-time tasks required to set up Agent Greeting.

Configuration Requirements

The following configuration components must be in place to deploy Agent Greeting.

Where What

Unified Communications Manager For phones that use Agent Greeting, you must set the
Built-in-Bridge option to On or Default (if the value of Default
is On). To verify, in Unified CM Administration, select Device>
Phone > Built in Bridge.
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Where What

Unified CCE Agent Greeting is supported with Type 10 Network VRUs only.
(Type 10 is required to allow CVP to control the call). If your
current Unified CCE deployment is not configured for a Type 10
VRU, you must modify it accordingly.

Agent Greeting requires at minimum three expanded call variables.

« user.microapp.ToExtVXML: This is used twice in an Agent
Greeting record script: the first time is to queue the Unified
CVP RecordAgentGreeting application; the second time is
to tell the recording application where to save greeting files.
Configure it as an array with size 3.

Use the Unified CCE Administration tool to ensure this
variable includes these settings: Maximum Length - 100 and
Enabled.

* user.microapp.app_media_lib:This is required in Agent
Greeting record and play scripts to specify the dedicated
directory on the media server where your greeting audio files
are stored. Maximum Length - 100 and Enabled.

* user.microapp.input_type: This is required in Agent Greeting
record scripts to limit the allowable input type to DTMF.
Maximum Length - 100 and Enabled.

No other ECC (Expanded Call Variable) are needed if you serve
your files from the Unified CVP default media server, and your
files are in the media server default locale directory
("<web_server_root>\en-us\app"). However, if you store your
files in a location other than these defaults, you must use one or
more of the ECC in the next row in your scripts.

Unified CCE (optional variables, used to override defaults) To make these variables available to your script authors, confirm
that they are defined in the Unified CCE Administration tool. For
instructions about defining ECC variables for CVP, see the
Administration Guide for Cisco Unified Customer Voice Portal
at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-customer-voice-portal/
tsd-products-support-series-home.html.

* user.microapp.media_server: Use to identify the Unified
CVP media server if it is other than the default.

* user.microapp.locale: Use to specify the name of the locale
directory on the media server if it is other than the default
(“en-us”).

+ user.microapp.UseVXMLParams: Required in your record
script if you include the user.microapp.media_server variable.
It tells the external VXML recording script to use the
name/value pair of the application that you pass in the
user.microapp.ToExtVXML variable.
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. Agent Greeting Deployment Tasks

Where

What

Unified CVP

Unified CVP Server must be installed and configured, as described
in the Cisco Unified Contact Center Enterprise Installation and
Upgrade Guide at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/
products-installation-guides-list.html.

Unified CVP Server must be installed and configured. as described
in the Installing and Upgrading Guide for Cisco Hosted
Collaboration Solution for Contact Center at

(3 4121800059 8°15010 08 (214 GARILIR 20398 02 LT 0 ) l:i :H

Agent Greeting Deployment Tasks

Step 1

Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

Step 8
Step 9
Step 10
Step 11

Step 12

Procedure

Ensure your system meets the baseline requirements for software, hardware, and configuration described in
the System Requirements and Limitations section.

Configure IIS and FTP on Media Server.
In Unified CVP, add media servers, configure FTP connection information, and deploy the media servers.

Configure a Unified CVP media server, if you have not already done so. See Configure Unified CVP Media
Server, on page 27.

In Unified CVP Operations Console, republish the VXML Gateway.tcl scripts with updated Agent Greeting
support. See Republish the tcl scripts to VXML Gateway, on page 25 for Agent Greeting support.

Set the cache size on the VXML Gateway. See Set Cache Size on VXML Gateway, on page 25.

Record the voice prompts to play to agents when they record a greeting and to deploy the audio files to your
media server, see Create Voice Prompts for Recording Greetings, on page 26.

Configure Call Types, on page 31 to record and play agent greetings.
Configure Dialed Numbers, on page 31 to record and play agent greetings.
Schedule the Script, on page 32
In Script Editor:
* To use the installed scripts to record and play agent greetings, see Import the Example Agent Greeting
Scripts, on page 31.
» To create your own scripts, see Import the Example Agent Greeting Scripts, on page 31.

Modify the Unified CCE call routing scripts to use Play Agent Greeting script, on page 32.
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Configure Gateway .

Configure Gateway

Republish the tcl scripts to VXML Gateway

Step 1
Step 2
Step 3

Step 4
Step 5

The .tcl script files that ship with Unified CVP include updates to support Agent Greeting. You must republish
these updated files to your VXML Gateway.

Republishing scripts to the VXML Gateways is a standard task in CVP upgrades. You must republish the
scripts before you can use Agent Greeting.

Procedure

In the Unified CVP Operation Console, select Bulk Administration > File Transfer > Scriptsand Media.
Set Device to Gateway.

Select the gateways you want to update. Typically you would select all of them unless you have a specific
reason not to.

Select Default Gateway Files.
Click Transfer.

Set Cache Size on VXML Gateway

To ensure adequate performance, set the size of the cache on the VXML Gateway to the maximum allowed.
The maximum size is 100 megabytes; the default is 15 kilobytes. Failure to set the VXML Gateway cache to
its maximum can result in slowed performance to increased traffic to the media server.

Use the following Cisco IOS commands on the VXML Gateway to reset the cache size:

conf t

http client cache memory pool 100000
exit

wIr

For more information about configuring the cache size, see the Configuration Guide for Cisco Unified Customer
Voice Portal at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/
tsd-products-support-series-home.html.

Configure Unified CVP

Complete the following procedures for Unified CVP configuration:

* Configure FTP Enabled in Server Manager, on page 25
* Configure Unified CVP Media Server, on page 27

* Configure the Call Studio Scripts for Record Agent Greeting, on page 28

Configure FTP Enabled in Server Manager

Complete the following procedure to configure the FTP enabled in server manager.
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. Create Voice Prompts for Recording Greetings

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Step 8

Step 9

Step 10

Step 11

Procedure

Right- Click Rolesin the left navigation page of server manager.

Select Add Roles.

Click Next.

Check the checkbox Web Server (11S) and click Next.

Check the checkbox FTP Server and click Next.

After the successful installation, click Close.

Make sure that the FTP and the IIS share the same root directory, because the recording application writes

the file to the media server directory structure, and the greeting playback call uses IIS to fetch the file. The
en-us/app directory should be under the same root directory for FTP and IIS.

Create a dedicated directory on the server to store your greeting files.

This lets you specify a lower cache timeout of 5 minutes for your agent greeting files that does not affect other
more static files you may be serving from other directories. By default, the Record Greeting application posts
the .wav file to the en-us/app directory under your web/ftp root directory. You may create a dedicated directory
such as ag_gr under the en-us/app directory, and then indicate this in the Unified CCE script that invokes the
recording application. Use the array for the ECC variable call.user.microapp.TOExtVXML to send the
ftpPath parameter to the recording application. Make sure the ECC variable length is long enough, or it may
get truncated and fail.

In IIS Manager, set the cache expiration for the dedicated directory to a value that allows re-recorded greetings
to replace their predecessor in a reasonable amount of time, while minimizing requests for data to the media
server from the VXML Gateway.

The ideal value varies depending on the number of agents you support and how often they re-record their

greetings. Two minutes may be a reasonable starting point.

Find the site you are using, go to the agent greeting folder you created (ag_gr), and then select HT TP Response
Headers.

Select Add, then Set Common Headers.

Create Voice Prompts for Recording Greetings

You must create audio files for each of the voice prompts that agents hear as they record a greeting. The
number of prompts you require can vary, but a typical set can consist of:

» A welcome followed by a prompt to select which greeting to work with (this assumes you support multiple
greetings per agent)

* A prompt to select whether they want to hear the current version, record a new one, or return to the main
menu

* A prompt to play if a current greeting is not found.

To create voice prompts for recording greetings:
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Procedure

Step 1 Create the files using the recording tool of your choice. When you record your files:

* The media files must be in . wav format. Your . wav files must match Unified CVP encoding and format
requirements (G.711, CCITT A-Law 8 kHz, 8 bit, mono).

* Test your audio files. Ensure that they are not clipped and that they are consistent in volume and tone.

Step 2 After recording, deploy the files to your Unified CVP media server. The default deployment location is to the
<web server root>\en-us\app directory.

Step 3 Note the names of the files and the location where you deployed them on the media server. Your script authors
need this information for the Agent Greeting scripts.

Built-In Recording Prompts

The Unified CVP Get Speech micro-application used to record Agent Greetings includes the following built-in
prompts:

* A prompt that agents can use to play back what they recorded
» A prompt to save the greeting, record it again, or return to the main menu

* A prompt that confirms the save, with an option to hang up or return to the main menu

You can replace these . wav files with files of your own. For more information, see the Unified Customer
Voice Portal Call Studio documentation at https://www.cisco.com/c/en/us/support/unified-communications/
unified-call-studio/tsd-products-support-series-home.html.

Configure Unified CVP Media Server

Procedure

Step 1 In the CVP Operations Console, navigate to Device Management > M edia Server.
Step 2 Click Add New.
Step 3 On the General tab, configure the following.

a) Enter the IP address and the hostname of the Unified CVP server.

b) Check FTP Enabled.

¢) Either Check Anonymous Access or enter the credentials.

d) Click Test Signln to validate the FTP access.

Step 4 Click Save.

Step 5 Repeat Steps 1 through 4 for all CVP Servers.

Step 6 In the CVP Operations Console, navigate to Device Management > M edia Server.

Step 7 Change Default Media Server from None to any one of the Unified CVP servers. Then click Set.
Step 8 Click Deploy.
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. Configure the Call Studio Scripts for Record Agent Greeting

Configure the Call Studio Scripts for Record Agent Greeting

Step 1

Step 2

Step 3
Step 4

Step 5
Step 6

Step 7

Step 8

Step 9

Step 10
Step 11
Step 12

Step 13

Step 14
Step 15
Step 16
Step 17
Step 18

The Record Agent Greeting is controlled by a combination of Call Studio script and ICM script. Complete
the following procedure to configure the Call Studio script:

Procedure

Access the .zip file from the CVP OAMP machine from the location
C:\Cisco\CVP\OPSConsoleServer\StudioDownloads\RecordAgentGreeting.zip.

Extract the example Call Studio Record Agent Greeting scripts contained in RecordAgentGreeting.zip to a
folder of your choice on the computer running CallStudio. The folder contains a CallStudio project having
the same name as the folder.

Start Call Studio by selecting Start > Programs > Cisco > Cisco Unified Call Studio.

Select File> Import.
The Import dialog box displays.

Expand the Call Studio folder and select Existing Call Studio project Into Workspace.

Click Next.
The Import Call Studio Project From File System displays.

Browse to the location where you extracted the call studio projects. Select the folder and select Finish.

Example:
RecordAgentGreeting
Follow the below steps, to save the file in a defined path:

a) Inthe Call Studio Navigator panel, open the Recor dAgentGreeting project and double click app.callflow
to display the application elements in the script window.

b) Select the Record Greeting With Confirm node.

¢) Inthe Element Configuration panel, choose the Setting tab and modify the default path settings to
c:\inetpub\wwwroot\en-us\app\ag gr. Save the project after you modify it.

d) Validate the project associated with the Record Agent Greeting and deploy them to your VXML Server.
Right-click on Record Agent Greeting project in the Navigator window and select Validate.

Right-click on the Record Agent Greeting project and click Deploy.

In the Deploy Destination area, select Archive File and click Browse.

Navigate to the archive folder that you have set up:

Example:

C:\Users\Administrator\Desktop\Sample.

Enter the name of the file.

Example:

Samplefile.zip

Click Save.

In the Deploy Destinationarea click Finish.

Log in to OAMP and choose Bulk Administration\File Transfer\VXM L Applications.
Select the VXML Server to which you want to deploy the applications.

Select the zip file that contains the applications.
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Example:

Samplefile.zip

Click Transfer.

Right-click on the project and click Deploy, then click Finish.

Step 19
Step 20

Step 21 Using windows explorer, navigate to

$CVP_HOMES%\VXMLServer\applications\RecordAgentGreeting, open the project's admin
folder and double-click deployApp.bat to deploy the application to the VXML Server.

Step 22 Verify that the application is running in the following path

$CVP_HOMES$\VXMLServer\applications\RecordAgentGreeting\admin and double-click
status.bat. The application should display under Application Name and with the status Running.

Configure Unified CCE

Complete the following procedures forUnified CCE configuration:
* Create Agent Greeting Play Script, on page 29
* Create Agent Greeting Recording Script, on page 30

 Import the Example Agent Greeting Scripts, on page 31

Create Agent Greeting Play Script

A dedicated routing script plays the Agent Greeting. This script is invoked by the PlayAgent Greeting dialed
number on the specific routing client. You must create the dialed number and associate it with a call type that
executes the script.

Figure 4: Agent Greeting Play Script
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Create Agent Greeting Recording Script

The Agent Greeting Recording script lets agents record a greeting. The agent desktop calls the script when
an agent clicks the Record Agent Greeting button, prompting the agent to select which greeting to play or
record. Create the dialed number RecordAgentGreeting for the specific routing client and associate it with a
call type that then executes this script.

Figure 5: Agent Greeting recording script
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Unified CCE Configuration for Record Agent Greeting

* user.microapp.TOExtVXML : This is used twice in an Agent Greeting record script, the first time is to
queue the Unified CVP Record Agent Greeting application and the second time is to tell the recording
application where to save greeting files. Configure it as an array with size 3. Use the Unified CCE
Administration tool to ensure this variable includes Maximum Length as 100 and Enabled.

» user.microapp.app_media_lib :This is required in Agent Greeting record and play scripts to specify
the dedicated directory on the media server where your greeting audio files are stored. Maximum Length
is 100 and Enabled.

* user.microapp.input_type: This is required in Agent Greeting record scripts to limit the allowable
input type to DTMF. Maximum Length is 100 and Enabled.

\)

Note For more information on how to enable the ECC variables, see the Cisco Hosted Collaboration Solution for
Contact Center Configuration Guide at
https/Avwweiscocomicenisisuppartinifiedco icat
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Import the Example Agent Greeting Scripts

To view or use the example Agent Greeting scripts, you must first import them into theUnified CCE Script
Editor. Complete the following procedure to import the example Agent Greeting scripts:

Procedure

Step 1 Launch Script Editor.

Step 2 Select File>Import Script and select a script to import.

The scripts are located in the icm\bin directory on the data server (DS) node.

Step 3 In addition to importing the script, Script Editor maps imported objects. You must manually create some
objects referenced in the example scripts, such as the external Network VRU scripts or the skill group, or
change these references to point to existing scripts and skill groups in your system.

Step 4 Repeat for the remaining scripts.

Note For Small Contact Center Deployment Model, Default Routing Scripts are available in the partners
Community. Download the Routing Scripts to the Desktop where ISE is Installed and Login as the
Sub Customer User into the ISE to perform the Step 2 and 3. To Download the Routing Script, see
https://communities.cisco.com/docs/DOC-35245.

Note For Small Contact Center Deployment Model ensure the resources used in this Routing script, like
Network VRU Scripts , ECC variables etc are specific to the sub customer.

Configure Call Types

Procedure

Step 1 Sign-in to Unified CCDM Portal as Tenant or Sub Customer user.

Step 2 Click the burger icon and select Provisioning > Resour ce M anager

Step 3 Select the folder where you want to create the call type.

Step 4 Click Resour ce, then click Call Types.

Step 5 Create a call type to record agent greetings and enter Recor dAgentGreeting as the name.

Step 6 Create a call type to play agent greetings and enter PlayAgentGreeting as the name.

Configure Dialed Numbers

Step 1
Step 2
Step 3
Step 4

Procedure

Sign-in to Unified CCDM Portal as Tenant or Sub Customer user.
Click the burger icon and select Provisioning > Resour ce M anager
Select the folder where you want to create the dialed number.

Click Resource, then click Dialed Number .
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Step 5 Create a dialed number to record agent greetings and enter Recor dAgentGreeting as the name.
Step 6 Create a dialed number to play agent greetings and enter PlayAgentGr eeting as the name.
Step 7 Complete the following for each dialed number:
a) Select Internal Voice for the Routing type.
b) Retain the default domain value.
¢) Select the call type appropriate to the dialed number.
This helps to associate each number to its call type and to a script that executes.
Schedule the Script
Procedure
Step 1 In the Script Editor, select Script > Call Type Manager.
Step 2 From the Call Type Manager screen, select the Schedules tab.
Step 3 From the Call type drop-down list, select the call type to associate with the script; for example,
PlayAgentGreeting.
Step 4 Click Add and select the script you want from the Scripts box.
Step 5 Click OK twice to exit.

Modify the Unified CCE call routing scripts to use Play Agent Greeting script

For an Agent Greeting play script to run, you must add an AgentGreetingType Set Variable node to your
existing Unified CCE call routing scripts: This variable's value is used to select the audio file to play for the
greeting. Set the variable before the script node that queues the call to an agent (that is, the Queue [to Skill
Group or Precision Queue], Queue Agent, Route Select, or Select node).

Specify AgentGreetingType Call Variable

To include Agent Greeting in a script, insert a Set Variable node that references the AgentGreetingType call
variable. The AgentGreetingType variable causes a greeting to play and specifies the audio file it should use.
The variable value corresponds to the name of the greeting type for the skill group or Precision Queue. For
example, if there is a skill group or Precision Queue for Sales agents and if the greeting type for Sales is '5',
then the variable value should be 5.

You can use a single greeting prompt throughout a single call type. As a result, use one AgentGreetingType
set node per script. However, as needed, you can set the variable at multiple places in your scripts to allow
different greetings to play for different endpoints. For example, if you do skills-based routing, you can specify
the variable at each decision point used to select a particular skill group or Precision Queue.

\)

Note

Only one greeting can play per call. If a script references and sets the AgentGreetingType variable more than
once in any single path through a script, the last value to be set is the one that plays.

Use these settings in the Set Variable node for Agent Greeting:

. Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.0(1)



| Agent Greeting
Scripting Agent Greeting for Multiple Customers .

* Object Type: Call.
* Variable: Must use the AgentGreetingType variable.
* Type: Must use the PersonID_AgentGreetingType type.

* Value: Specify the value that corresponds to the greeting type you want to play. For example: “2” or
“French”

* You must enclose the value in quotes.
* The value is not case-sensitive.

* The value cannot include spaces or characters that require URL encoding.

The following script example illustrates how to include Agent Greeting in a script using the Set Variable node:
Figure 6: Modified Call Routing Script to Enable Greeting Play
Prompt the caller: For Sales,

Setthe userinput to press 1; Customer Service,
“DTHF only press 2; Suppor press 3.

Selact the Agent Greeting
type, based on the
CallerEnterad digit

User.misroapp.app_|
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SetVa
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b}
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g | Queue to Skill Group Run Ext. Script

Skill Group No.
IPCC_1.Cisco_Woice.Customer
IPCC_1.Cisco_Voice.Sales
IPCC_1.Cisco_Woice.Support

Scripting Agent Greeting for Multiple Customers

In the out-of-box method for deploying Agent Greeting, Unified CCE uses the customer information from

the built-in “PlayAgentGreeting” dialed number to choose the correct network VRU to play the greeting. If
your deployment has multiple customers configured within your Unified CCE instance and you want to use
Agent Greeting with all of them, you must configure things differently to work around customer associations.

Configure Custom Dialed Number for Agent Greeting Play

To play Agent Greetings for multiple customer instances, configure the built-in PlayAgentGreeting dialed
number for each Unified CM routing client, but do not associate it with a specific customer. The Unified CM
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. Configure Custom Dialed Number for Agent Greeting Record

peripheral uses this number to initiate Agent Greeting play. If you want your greetings to be played from a
different network VRU, use the TranslationRouteToVRU node in your routing scripts to explicitly choose
the network VRU.

Configure Custom Dialed Number for Agent Greeting Record

To record Agent Greetings when you have multiple customers, you must create your own custom dialed
number for recording. You may want to create different dialed numbers for different customers. As with Agent
Greeting play, if you want to use different network VRUs to record Agent Greetings for different customers,
use the TranslationRouteToVRU node in your routing script to explicitly select the network VRU.

Create your own custom button or have your agents enter the record dialed number using the dial pad on their
desktops.

Configure Unified Communications Manager

Built-in-Bridge

Built-in-Bridge (BIB) is not enabled by default for the phones. It is disabled at the system level as it is not
used by all the customer by default. It is used only by the customers having Contact Center.

The provider has to perform the following procedures to enable BIB for the customers having contact center.

)

Note Create a new Field Display Policies at the customer level and add Built-in Bridge to the list.

* Configure the Built-in-Bridge , on page 34

* Enable or Disable the Built-in-Bridge , on page 35

Configure the Built-in-Bridge

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9
Step 10

Procedure

Login to Cisco Unified Communication Domain Manager as provider.
Navigate Role Management > Field Display Policies.

Ensure that hierarchy is set to the appropriate customer.

Select the Subscriber PhoneM enultemProvider.

In the details page, go to Action menu and click Clone.

Enter Subscriber PhoneM enultemProvider as the name.

Select relation/Subscriber Phone from the Target Model Type drop-down list.
Expand Groups section and enter Phone for Title.

Select builtlnBridgeStatus from the Available list and click Select.

Click Save.
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Enable or Disable the Built-in-Bridge

Step 1
Step 2
Step 3
Step 4

Step 5

Reporting

Before you begin

Ensure that you configure Built-in-Bridge. See, Configure the Built-in-Bridge , on page 34.

Procedure

Login to Cisco Unified Communication Domain Manager as a provider.
Ensure that hierarchy is set to the appropriate customer.

Navigate Subscriber Management > Phones and select the appropriate phone.
In the Phone tab:

* To enable BIB choose On from the Built in Bridge drop-down list.
* To disable BIB choose Off from the Built in Bridge drop-down list.

Click Save.

In agent, skill group, and precision queue reports, greeting time is not specifically broken out. The period
during which the greeting plays is reported as talk time. Record time is counted as an internal call by the
default skill group.

Calls that involve Agent Greeting consist of two call legs: the inbound call from the customer and the call to
Unified CVP for the greeting. Both of these legs have the same RouterCallKeyDay and RouterCallKey values
in the TCD and RCD tables in the database. You can use these values to link the two legs together for reporting
purposes.

Greeting Call Statistics

To view greeting call statistics, create a separate call type and associate it with the routing script that plays
agent greeting. New Cisco Unified Intelligence Center templates for the agent greeting call type are created
based on the data in the existing Call Type Real Time and Call Type Interval table in the database.

Peripheral Call Types for Agent Greeting

There are two peripheral call types specific to Agent Greeting that you can use to track and report on the
feature.

* Call Type 39: Play Agent Greeting. Route request to play an Agent Greeting.

* Call Type 40: Record Agent Greeting. Agent call for recording an Agent Greeting.

Extra TCDs and RCDs are generated for the agent greeting call leg, and they can be linked to the first call leg
by the same RouterCallKeyDay and RouterCallKey.
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Serviceability

Serviceability for Agent Greeting includes SNMP events captured by your Network management software
that indicate reasons for greeting failures and counters to track the number of failed greeting events.

\)

Note There is no counter for the number of failed agent greeting calls.

When system components fail, Agent Greeting may be impacted. For example, if a requested greeting audio
file cannot be found for any reason, the call proceeds normally without the Agent Greeting.
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Unified CM-based Silent Monitoring

* Capabilities of Silent Monitoring , on page 37
* Configure Silent Monitoring , on page 38

Capabilities of Silent Monitoring

Silent Monitoring

Silent monitoring allows supervisors to monitor the conversations of agents within their team. Supervisors
cannot participate actively in the conversations and agents and callers are not aware that they are being
monitored. Cisco Finesse provides solution support for silent monitoring.

Cisco Finesse supports Unified Communications Silent Monitoring only. You configure silent monitoring on
Unified Communications Manager. No additional configuration is required on the Cisco Finesse server.

\)

Note Even for regions that are configured to use G.711, Unified CCE uses G.722 as the default codec for devices
that support G.722. However G.722 is not supported with Silent Monitoring and Call Recording based on
Unified Communications Manager. To disable this default, in Unified Communications Manager Administration,
go to Enterprise Parameters and set Advertise G.722 Codec to disabled.

N

Note If voice streams are encrypted, silent monitoring does not work correctly. Although the voice streams can still
be captured, the silent monitoring service cannot decode them correctly.

Unified CM-Based Silent Monitoring

Unified Communications Manager accomplishes silent monitoring with a call between the supervisor
(monitoring) device and the agent (monitored) device. The agent phone mixes and sends the agent's conversation
to the supervisor phone, where it is played out to the supervisor.

Unified CCE supports the Silent Monitoring functionality available in Unified CM. Unified CM Silent
Monitoring supports only one silent monitoring session and one recording session for the same agent phone.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.0(1) .



Unified CM-based Silent Monitoring |
. Configure Silent Monitoring

\)

Note Unified CM Silent Monitoring does not support mobile agents.

Unified CM Silent Monitoring can monitor any Unified CCE agent desktop, including Siebel, if the following
conditions exist:

* The monitored agents use a compatible Cisco Unified IP phone or Cisco IP Communicator. For details,
see the Compatibility Matrix for your solution at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list.html

* The contact center uses a compatible version of Cisco Unified CM. For more information, see the
Compatibility Matrix for your solution.

* The contact center uses a compatible version of Cisco Unified CM.
Unified CM Silent Monitoring works the same as other call control functionality provided by Unified CM

(such as conference and transfer). When the silent monitoring session begins, the desktop sends a message
through Unified CCE, through Unified CM, and out to the phones where silent monitoring is executed.

Messaging through Unified CCE and Unified CM impacts Unified CCE performance.

Configure Silent Monitoring

Add Monitoring Calling Search Space

Before you begin

Ensure that agent phones are added.

)

Note During CTIOS Server installation, for IPCC Silent Monitor Type, select CCM Based.

Procedure

Step 1 Log in to Unified Communication Domain Manager as provider, reseller or customer.
Step 2 Add Calling Search Space for monitoring purpose.

Step 3 Edit Lines, choose newly added Calling Search Space from the drop-down list.
Step 4 Click Save.

Example

For information on how to perform on any of the tasks listed in this section, see Cisco Hosted
Collaboration Solution for Contact Center Configuration Guide at
s/ cRoocoMoentsaUpparttnifiadao icatiorshosied aolbbaation soluioncontacteanirproducsasialition a
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CHAPTER 5

Context Service

* Context Service, on page 39

* Design Considerations, on page 42

* Omnichannel Customer Journey, on page 42

* Task Flow to Enable Context Service , on page 43

* Context Service Setup, on page 44

» Component Configuration and Registration, on page 47

* Solution Serviceability, on page 53

* Deregister a Component with Context Service, on page 58

Context Service

Cisco Context Service is a cloud-based, omnichannel solution. Context Service captures customer interaction
history and provides flexible storage of the customer interaction data across all channels (including voice,
chat, email, and Internet of Things).
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Context Service provides an out-of-the-box integration with Unified Contact Center Enterprise. You do not
need to install any additional components. With Context Service integrated with your contact center, agents
can access a customer's previous interactions with your organization. Context Service provides this information
to your agents through the Customer Context gadget in the Cisco Finesse desktop.

Enterprise

Cloud Services

Contact
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Applications

Context
Service

Unified
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:

Context Service provides a flexible data store for storing customer interaction data. You can define what data
you want to store and how to store it. Cisco hosts and manages the service, eliminating the need for your
organization to deploy and manage servers. Your organization owns the data, even though it's stored in the
cloud. Your organization controls access to sensitive data. Cisco partners cannot access protected data unless
you grant them access.

The Context Service object stores context data:

 Customer data—Describes who the customer is and includes information such as name, address, and
phone number. A Customer provides a way to link personally identifiable information (PII) with a
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customer ID. It can link to an existing data store that contains your customer data with key fields, such
as name or account number, stored in Context Service. The agent's desktop displays these details in the
Customer Context gadget.

* Activity—Describes a specific interaction associated with a customer or request. An activity reflects one
or more steps in the customer journey. Activities tie together all objects within a particular customer
journey. For example:

¢ VRU menu that a customer selects.

* Notes made by the agent.

« A website URL that the customer visited.
¢ Chat metadata.

* Request data—Describes what the customer wants. Requests are about one or more customer interactions
for a specific issue. The request reflects the customer's view of an issue, indexes the customer journey
and interaction, and groups related requests together. For example, a customer goes online to make a
credit card payment and runs into an issue. The customer decides to call to make the payment instead.

The separate requests represent the two interactions but belong to the same request (making a credit card
payment).

The following contact center components integrate with Context Service:
* Cisco Unified CVP—Looks up customer and creates or updates activities for every voice call.
* Cisco Enterprise Chat and Email—Creates activities for every nonvoice chat and email task.
* Cisco SocialMiner—Creates customer records for every Task Routing task.

* Cisco Finesse—Contains the Customer Context gadget where agents can view and update customers and
activities for the tasks that they handle.

For more information about Context Service, see Cisco Context Service Help Central at https://help.webex.com/
community/context-service.
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Omnichannel Customer Journey

The omnichannel customer journey captures and displays a customer's complete interaction history.

A customer purchases a motorcycle from a company (Cumulus Motorcycle). The customer now has a problem
with the motorcycle, so he needs to schedule an appointment with Cumulus Motorcycle for repair. The customer
browses the Cumulus web site to locate the nearest service center and chats with a Cumulus agent to determine
if the service center that he selected is open on Sundays. In the chat, he tells the agent that he will call when
he is ready to schedule an appointment.

The customer calls to schedule a service appointment. The VRU detects his chat and sends his call to a Cumulus
Motorcycle agent who is context aware. The customer agrees on a date for service. The agent confirms the
appointment, and sends the appointment details to the customer. When the customer realizes that he has a
conflict with the appointment, he sends the SMS a new proposed date. The agent receives a screen pop with
the customer's proposed date. The agent sends the customer the details for the new appointment. The customer
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brings his motorcycle into Cumulus Motorcycle for the scheduled service appointment, then picks up his

repaired motorcycle.

Table 1: Components that enable the omnichannel customer journey

Activity

Components

The motorcycle dashboard indicates an error, and
instructs the customer to contact Cumulus Motorcycle
Customer Service immediately.

The motorcycle sends diagnostic metadata to the
Cumulus data center which is connected to Context
Service.

The customer browses the Cumulus website to locate
the nearest service center. He clicks the Schedule
Service Appointment link to view the Cumulus
Service Centers located near him. The customer views
the nearest Cumulus Service Center and clicks the
link to chat with a Cumulus agent.

Enterprise Chat and Email
Finesse

The Cumulus backend server sends the IoT event data
and creates an activity to show the current
breadcrumbs in Context Service.

The customer calls to schedule a service appointment.
The VRU detects his chat and sends his call to an
agent.

SMS
Unified CVP
Finesse

Other components

The customer receives the appointment details.

SMS

The customer has a conflict with the scheduled date.
The customer proposes a new date. The agent receives
a screen pop with the customer's new date.

SMS

Finesse

The customer receives a SMS confirmation with the
new date.

SMS (for example, Tropo).

The customer picks up his repaired motorcycle.

To enable Context Service in your contact center solution, follow this task flow:

Sequence Task
Enable Context Service
1 Work with your Cisco account partner to onboard your organization:

Enable Context Service for Your Organization, on page 45

Configure and Register Components

2 Register your Unified CVP Call Servers: Register Unified CVP with

Context Service, on page 47.
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Sequence

Task

3

Configure connection data in CVP Call Studio: Configure Context
Service Connection Data in Call Studio, on page 49.

Register your Cisco Finesse Servers: Register Cisco Finesse with Context
Service, on page 49.

Set the principal Administration & Data Server: Set the Principal AW
for Context Service, on page 50.

Register Unified CCE Administration to support SocialMiner and ECE
servers: Register Unified CCE Administration to Support Components,
on page 51.

Enable the POD.ID expanded call variable: Enable the POD.ID Expanded
Call Variable, on page 52.

Create scripts

8

Add Context Service to your CVP scripts: https://developer.cisco.com/
site/context-service/index.gsp.

Context Service Setup

Context Service Prerequisites

Complete the following tasks before you enable Context Service.

* Install and configure your contact center solution and any components that you plan to integrate with
Context Service (Unified CVP, SocialMiner, ECE, and Cisco Finesse).

* Ensure that port 443 (HTTPS) is available for Context Service to use.

* Add the following URLSs to your allowed list in your firewall so that your contact center components
can connect to, and receive data from, the internet:

* * . webex.com

® * . wbx2.com

® *.ciscoccservice.com

)

Note  You must use wildcard URLs in your allowed list because Context Service is
accessed through multiple subdomains. Context Service subdomain names can

dynamically change.

« If Context Service uses a proxy server, configure the browser proxy with the URL specified in the Context

Service Management gadget.
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Enable Context Service for Your Organization

Context Service enables you to store and access customer interaction data in the cloud, creating a flexible and
seamless omnichannel customer journey experience. To use Context Service:

» Work with your Cisco account partner to enable Context Service for your organization.
* Register Context Service for your organization to use with your contact center application.

+ Connect your contact center application to Context Service.

)

Note You need Java Runtime Environment (JRE) version to 1.8.0 151 or later to use Context Service. Refer to the
Compatibility Information for your specific release and update accordingly.

Create a Customer Organization and Enable Context Service

Your Cisco account partner can provide Context Service entitlement to your Cisco Webex Control Hub
account.

This example shows how a partner adds a Context Service subscription to a customer organization. The
example assumes that:

* The partner is a full administrator or sales administrator and can add trials.

* The Cisco Webex Control Hub account or the organization and accounts associated with the organization
have been created.

Example: Add a Trial Service
Context Service is not tied to the trial services, and does not expire when the trial period is complete.

1. Log in with your partner credentials to the Cisco Webex Control Hub.

2. Click Start Trial on the Overview page. The Start New Trial window opens.
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Trial Services

Licenses Quantity Licenses Quantity

Trial Duration Duration of the Trial

Non Trial Services

510027

oves [ e

3. Enter details about the trial:
 Customer Infor mation: Enter the name of the customer company and an email for the administrator.
* Trial Services. Select the trials to add to this customer. To enable Context, select M essage.

* Licenses Quantity: Specify the number of licenses required for this customer trial. This number is
usually the number of users who use this service. This option applies only to the Trial Services.
Context Service is not bound by the number of licenses specified here.

* Trial duration Specify the duration the trial lasts before you must purchase the service. This option
applies only to the Trial Services and not Context Service.
S

Note Context Service entitlement does not expire when the specified trial period ends.
The organization can continue to use Context Service beyond the date of the
specified Trial Duration.

\}

Note  You cannot change the customer name and administrator email after you create the trial. You can modify the
other terms of the trial as needed.

Make sure that the email you provide is not already associated with a Cisco Webex Control Hub account.
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4. Scroll down to the Non Trial Services section and select Enable Context Service for Cisco Unified
Contact Center.

5. Click Next.

6. A message is displayed that asks if you want to set up the services for the customer. Click No.

You now have provided Context Service entitlement to the organization. The customer now receives a welcome
email at the specified email address with the subject line Welcometo Cisco Spark Service.

Welcome to Cisco Spark

Your trial starts today

Your 90 day trial powered by Cisco CCBU Test Partner Org has begun
and ends on Aug 24,2017

Go to Cisco Spark Control Hub to begin using your services.

Get Started

The Cisco Spark Team

510231

The customer must click Get Started in the email and sign in to Cisco Webex Control Hub to begin their
trial. The customer uses the credentials in the email to sign in and is prompted to create a password.

Your Cisco Context Service is ready. To use the service, connect to Cisco Contact Center with Context Service
Enabled. See Register Context Service for more information.

Component Configuration and Registration

Register Unified CVP with Context Service

The registration process has an inactivity session timeout of 10 minutes. If the session times out, sign in again.

\}

Note For Unified CVP, Context Service is not supported for a VXML Server that is deployed in a standalone mode.
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. Register Unified CVP with Context Service

Step 1

Step 2

Step 3

Step 4

Step 5

Before you begin

* Ensure that Unified CVP 11.6 is installed.
* Ensure that your web browser allows popups.

* If you are using Microsoft Internet Explorer, add a registry key, TabProcGrowth, at
HKEY CURRENT USER\Software\Microsoft\Internet Explorer\Main. Set the type to String or
DWORD (32-bit) and set the value to 0.

» When your organization was entitled for Cisco Context Service, you received an email requesting a
sign-in and a password change. Sign in using the registration email, and change the password. Now your
organization is entitled to use Context Service.

Procedure

In the CVP Oper ations Console, choose System > Cloud Services> Context Serviceto launch the Context
Service Management page.

Provide the following information for the CVP VXML server:

* Proxy server URL—Specify the URL if your solution uses an optional proxy server to reach Context
Service.

* Timeout—The amount of time, in milliseconds, that the system waits for a response from Context Service
for each operation.

See the application's online help for the minimum, maximum, and default values for this setting for the
component you are registering. Test this setting and tune it to match the latency for your solution.

 Lab Mode—Indicates whether Context Service is in lab mode. In lab mode, you can test, develop, and
debug Context Service. Lab mode allows you to delete objects from Context Service.

Click Register.

A popup window appears in your browser prompting you to sign in to Cisco Spark.

Enter your Cisco Webex Control Hub admin credentials and complete the registration. (See
https://help.webex.com/docs/DOC-4165 for more information.)

Note Use the same organization admin account to register all components in one contact center solution.

Check the Allow Accessto Your Hybrid Services Node check box and then click Continue.
Cisco Webex Control Hub redirects the browser back to the application from which you began the registration.

If the registration is successful, the connection details are deployed on all running VXML Servers in the pool.
Ifyou add a VXML Server after registration, click Save & Deploy on the VXML server deviceconfiguration
page to deploy the connection data to the new server.
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Configure Context Service Connection Data in Call Studio

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6

Step 7

To debug a solution that uses Context Service, Call Studio requires your Context Service credentials and
connection details.

Procedure

Go to CVP Server and navigate to the C:\Cisco\CVP\conf folder.

Copy the connection data from the vxml.properties file to clipboard.

VXML.ContextService.ConnectionData: <connection data>

Launch Cisco Unified Call Studio.

Choose Window > Preferences.

On the Preferences window, choose Call Studio > Debug Preferences.
In the Context Service area enter the following connector properties:

a) In the Connection Data field, paste the connection data from the clipboard.
b) Inthe Proxy URL field, enter the Proxy URL in the format: hostname:port or IP_address:port.

¢) Inthe Timeout field, enter how long the client waits for a response from Context Service. The allowed
values are from 1200ms to 5000ms, with a default of 2400ms.

Click OK.
Note To check the validity of connection data through the Proxy URL, click Test connection.

Register Cisco Finesse with Context Service

Step 1

Before you begin

* Ensure that your web browser allows popups.

» When your organization was entitled for Cisco Context Service, you received an email requesting a
sign-in and a password change. Sign in using the registration email, and change the password. Now your
organization is entitled to use Context Service.

* If you wish to configure a proxy server for Context Service, configure the browser proxy with the proxy
server URL you specified. Refer to your browser’s documentation for information about configuring
proxy settings.

Procedure

Register Cisco Finesse with Context Service from the Finesse administration console Context Service
Management gadget.

Note Ensure to register all Finesse primary nodes.
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Step 2 Provide the following information:

* Proxy server URL—Specify the URL if your solution uses an optional proxy server to reach Context
Service.

* Timeout—The amount of time, in milliseconds, that the system waits for a response from Context Service
for each operation.

See the application's online help for the minimum, maximum, and default values for this setting for the
component you are registering. Test this setting and tune it to match the latency for your solution.

 Lab Mode—Indicate whether Context Service is in lab mode. In lab mode, you can test, develop, and
debug Context Service. Lab mode allows you to delete objects from Context Service.

Step 3 Click Register.

A popup window appears in your browser prompting you to sign in to Cisco Spark.

Step 4 Enter your Cisco Webex Control Hub admin credentials. Complete the registration in Cisco Webex Control
Hub. (See Register Your Applicartion with Context Service for more information.)

Note Use the same organization admin account to register all components in one contact center solution.

Cisco Webex Control Hub redirects the browser back to the application from which you initiated the registration.

What to do next

To change any of the settings after you register, edit the setting and save your change. You do not need to
reregister.

After you register Cisco Finesse, agents can use the Context Service desktop gadget. It is available on the
M anage Customer tab in the default agent desktop layout. If the gadget is not in your layout, you can add
the gadget with the following XML:

<tab>
<id>manageCustomer</id>
<label>finesse.container.tabs.agent.manageCustomerLabel</label>
<gadgets>
<gadget>/desktop/gadgets/CustomerContext.xml</gadget>
</gadgets>
</tab>

Set the Principal AW for Context Service

Set which Administration & Data Server (AW) manages the credentials for Context Service before registering
with Context Service in Unified CCE Administration.

\}

Note This procedure is applicable only for Packaged CCE 4K or 12K deployment type.
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Procedure

Step 1 In Unified CCE Administration, navigate to Infrastructure> Inventory.

Step 2 In the System I nventory, click the AW that you want to manage the Cisco Spark Control Hub admin credentials
for Context Service.

Step 3 In the Edit AW popup window, check the Principal check box.
Step 4 Enter your solution's Diagnostic Framework credentials.
Step 5 Click Save.

Register Unified CCE Administration to Support Components

You register Unified CCE through the Unified CCE Administration tool. This enables Unified CVP, Finesse,
SocialMiner and Enterprise Chat and Email to access Context Service in a single operation.

)

Note Before you register with Context Service through Unified CCE Administration, upgrade the JRE on your
primary AW to version 1.8.0 151 or higher. For information on upgrading JRE, see the Cisco Unified Contact
Center Enterprise Installation and Upgrade Guide.

Before you begin

* Use the System Inventory in Unified CCE Administration to set the Principal AW before registering
Unified CCE. The Principal AW manages the Context Service credentials.

» When your organization was entitled for Cisco Context Service, you received an email requesting a
sign-in and a password change. Sign in using the registration email, and change the password. Now your
organization is entitled to use Context Service.

Procedure
Step 1 Register from the Unified CCE Administration Overview > Feature> Context Service.
Step 2 Provide the following information:

* Proxy server URL—Specify the URL if your solution uses an optional proxy server to reach Context
Service.

* Timeout—The amount of time, in milliseconds, that the system waits for a response from Context Service
for each operation.

Valid Timeout range is from 200ms to 15000 ms, with a default of 1200 ms. For the CVP component,
the valid Timeout range is from 1200ms to 5000ms, with a default of 2400ms. If the timeout value is
less then 1200ms or greater than 5000ms, the Unified CVP sets the minimum value to 1200ms or maximum
value to 5000ms.

 Lab Mode—Indicate whether Context Service is in lab mode. In lab mode, you can test, develop, and
debug Context Service. Lab mode allows you to delete objects from Context Service.

Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.0(1) .



Context Service |

. Enable the POD.ID Expanded Call Variable

Step 3

Step 4

Click Register.

Your browser displays the Cisco Spark sign-in page.

Enter your Cisco Webex Control Hub admin credentials. Complete the registration in Cisco Webex Control
Hub. (See Register Your Application with Context Service for more information.)

Note Use the same organization admin account to register all components in one contact center solution.

Cisco Webex Control Hub redirects the browser back to the application from which you initiated the registration.

What to do next

Set up the ECE services in the System Console. For more information, see the Enterprise Chat and Email
Deployment and Maintenance Guide (for Unified Contact Center Enterprise) at https://www.cisco.com/c/en/
us/support/customer-collaboration/cisco-enterprise-chat-email/products-maintenance-guides-list.html .

Configure Context Service in ECE. For more information, see the Enterprise Chat and Email Administrator's
Guide to System Console at https://www.cisco.com/c/en/us/support/customer-collaboration/
cisco-enterprise-chat-email/products-maintenance-guides-list.html.

If you register CCE Context Service after it is deregistered, restart the ECE Context Service Process and
Instance from the ECE System Console Page. To set up ECE services in the System Console, see the Enterprise
Chat and Email Deployment and Maintenance Guide (for Unified Contact Center Enterprise) at
https://www.cisco.com/c/en/us/support/customer-collaboration/cisco-enterprise-chat-email/
products-maintenance-guides-list.html.

After you register Cisco Finesse, agents can use the Context Service desktop gadget. It is available in Unified
CCE Administration, under Desktop > Resour ces> Desktop L ayout tab. If the gadget is not in your layout,
you can add the gadget with the following XML:

<tab>
<id>manageCustomer</id>
<label>finesse.container.tabs.agent.manageCustomerLabel</label>
<gadgets>
<gadget>/desktop/gadgets/CustomerContext.xml</gadget>
</gadgets>
</tab>

Add Context Service credentials and connection details to Call Studio. See Configure Context Service
Connection Data in Call Studio, on page 49.

Enable the POD.ID Expanded Call Variable

Enable the built-in POD.ID expanded call variable to send task context data through the system.

)

Note For a new incoming call, CVP creates a new POD and passes that POD information to CCE in POD.ID ECC
Variable . In order for CVP to send POD.ID ECC variable to CCE, the Call Studio script must contain CVP
Subdialog_Start at the beginning of the script with the business logic for creating or updating POD and .must
end with CVP Subdialog_Return. CVP Subdialog_Return captures the caller input and passes the POD ID to

CCE Application.

After enabling the ECC variable, you must add it to an ECC payload to use it in your solution.
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Step 2
Step 3
Step 4
Step 5

Solution Serviceability .

Procedure

In the Configuration Manager, navigate to Tools > List Tools, and open the Expanded Call Variable List.
Click Retrieve.

Click the POD.ID expanded call variable to open that record in the Attributes panel.

Check the Enabled check box.

Click Save.

Solution Serviceability

This section provides the information and resources to troubleshoot Context Service.
You can view service status for Context Service and subscribe to updates at https://status.ciscospark.com.

For Enterprise Chat and Email troubleshooting information, see the Enterprise Chat and Email Administrator's
Guide to System Console at https://www.cisco.com/c/en/us/support/customer-collaboration/
cisco-enterprise-chat-email/products-maintenance-guides-list.html.

Access Context Service Logs

The log file from Context Service is CCBU-runtime.<YYYY-MM-DDTHH-MM-SS.sss>.log.
The path to the log file is /opt/cisco/mmca/logs/runtime.

Context Service logs are stored at C:\icm\tomcat\logs\ContextService.*.log on the Principal AW.

CVP OAMP logs are stored at CVP_ HOME\logs\OAMP

CVP VXML logs are stored at CVP_HOME\logs\VXML

Fusion Management Connector logs are stored at /opt/cisco/ccbu/logs/fusion-mgmt-connector directory
Cisco Finesse logs are stored at /opt/cisco/desktop/logs/finesse-auth

Cisco SocialMiner logs are stored at /opt/cisco/mmca/logs/runtime

For the location of Enterprise Chat and Email logs, see the Enterprise Chat and Email Administrator's Guide
to System Console at https://www.cisco.com/c/en/us/support/customer-collaboration/cisco-enterprise-chat-email/
products-maintenance-guides-list.html.

View Context Service Customer Record Statistics

You can check Context Service customer record statistics from the VXML logs.

Verify the VXML logs for any exceptions. Search the log $CVP_HOME/logs/VXML for the instances “Context
service client stats summary” - Verify the reachability /connectivity. The report displays the count, latency,
etc for each record. Alerts are captured in syslogServer.
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Troubleshooting Context Service Registration Process

This section lists the issues and the possible solutions during registration of the components with the Context
Service Cloud.

Cannot Configure Cisco SocialMiner
You cannot configure Cisco SocialMiner, if Context Service fails to connect with it.

Check the Context service logs at C: \icm\tomcat\logs\ContextService. If there are connectivity
errors, the Context Service logs provide information similar to this:

0000001306: *.*.*.*: Aug 12 2016 16:58:15.629 -0400:
%CCBU_pool-l-thread-35-Infrastructure-1548-3-REST API EXCEPTION:

% [exception=com.sun.jersey.api.client.ClientHandlerException:

java.net.SocketTimeoutException: connect timed out] [message string=Failed
to make request. Exception is caught for rest call:GET
https://*.*.*.*:443/ccp-webapp/ccp/contextServiceConfig]: The REST API
has caught an exception

To fix the issue, check to see if Cisco SocialMiner is up and running. If Cisco SocialMiner is up and running,
check its connection with the principal AW Machine.

If your issue is still unresolved, contact Cisco customer support.

Cannot Register Context Service

When you try to register with Context Service, if registration fails with the following error, check to see if
you have an internet connection.

Failed to register with the Context Service because of a connection error.
Verify that the server has internet access and/or the proxy server URL
is correct.

If your registration fails due to incorrect proxy server URL, check the proxy server configuration in your
browser.

If you are still unable to register, the Context Service SDK could have been corrupted, when an automatic
update was run.

To recover the corrupted Context Service SDK:

1. Stop the Cisco Tomcat service.
2. Delete the C: \icm\ContextService directory.

3. Restart the Cisco Tomcat service. The Context Service directory is recreated.

If your issue is still unresolved, contact customer support.

Cannot Deregister Context Service

If the AW-HDS-DDS side A can access only the key management system but not the rest of Context Service,
registration succeeds. However, deregistration fails because the cluster was not created.
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Context Service Registration Incomplete .

Check the Context Service logs on the Principal AW at:
C:\icm\tomcat\logs\ContextService.*.log.Ifthe cluster was not created, the SDK logs provide
information similar to this:

0000000111: *.*.*.*: Aug 12 2016 10:46:59.835 -0400:
% _Thread-25-6-com.cisco.thunderhead.RESTClient: Error on CREATE:
https://hercules-a.wbx2.com/vl/connectors

0000000112: *.*.*.*: Aug 12 2016 10:46:59.835 -0400:

% Thread-25-3-com.cisco.thunderhead.RESTClient: Error: try #1l: Exception
trying to connect=com.sun.jersey.api.client.ClientHandlerException:
org.apache.http.conn.HttpHostConnectException: Connect to
hercules-a.wbx2.com:443 [hercules-a.wbx2.com/*.*. * *,
hercules-a.wbx2.com/*.*.* *] failed: Connection timed out: connect

To fix this issue, check to see if your server is up and running.

If you are still unable to deregister, the Context Service SDK could be corrupt.
To recover the corrupted Context Service SDK:

1. Stop the Cisco Tomcat service.

2. Delete the C: \icm\ContextService directory.

3. Restart the Cisco Tomcat service.

The Context Service directory is recreated. If the issue is still unresolved, contact Cisco support.

Context Service Registration Incomplete

When registering or de-registering Context Service , the process stops responding and continues to display
one of the following messages:

Registration is in progress

OR

Deregistration is in progress

These messages could occur for the following reasons:

* The proxy is invalid or not reachable. Make sure that the proxy URL is correct and reachable from
Finesse.

* The browser pop-up is disabled. Ensure the browser pop-up is enabled.

* The Context Service Cloud services may not be reachable. For more information, see the Fusion
Management Connector (FMC) logs located at:
/opt/cisco/ccbu/logs/fusion-mgmt-connector directory.

* Fusion Management Connector (FMC) is still in the loading state.

Context Service Registration Status Invalid

Registering Context Service can fail with this error:

The Context service registration status is invalid. Check the Settings
and try again.
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This error could occur for the following reasons:

* An invalid client setting update results in an invalid registration state. To ensure that the update keeps
the connector in registered state, perform the following:

1. Correct the client settings.

2. Save and refresh the page.

If the update is unsuccessful, try restarting the Cisco Tomcat service. If the issue still persists, re-register
Context Service.

* Connection data is invalid. Restart Cisco Tomcat service. If that doesn't help, contact Cisco Support.

Unable to Determine Context Service Registration Status or Client Settings

Errors occur when the Fusion Management web application, deployed on the Platform Tomcat is down, or
the Cisco Tomcat service is down.

When this occurs:

* Verify that the Cisco Tomcat service is up and running. The service may not respond with an XML in
some error scenarios.

* Restart Platform Tomcat and try again.

* Check the logs under: /opt/cisco/ccbu/logs/fusion-mgmt-connector for more
information.

Context Service Registration Incomplete Due to Page Refresh

As part of Context Service registration process, do not refresh the pop up page while the registration or
deregistration process is in progress. This may result in an Undefined state for that respective component.

Troubleshooting Context Service Connectivity Process

This section describes the various connectivity related issues that are encountered and the troubleshooting
that can be performed for a possible solution.

Activity Operation

Exception related to Activity operation failure

Deployment failure, dynamic jar download failure, context service client initialization failure, or incorrect
connection data.

Check that the Context Service extension jar dynamically downloads in the following path:
CVP_HOME\VXMLServer\Tomcat\webapps\CVP\ WEB-INF\contextservice\context-service-sdk-downloads

* Check the network connectivity.

* If you use a proxy server, make sure that it is working.

Ensure that the Context Service client initialization is successful.
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* Restart the VXML Server service.

Verify that the customer ID is valid and exists.

* Create valid customers.

Verify the VXML logs for any exceptions. Search the log $CVP_HOME/logs/VXML for the instances
“CS_SDK_STATUS?” - Verify the reachability /connectivity. Alerts are captured in syslogServer.
Context Service Connection Data Not Published
The connection data is published to the configured subscribers in the following scenarios:
* De-registering or cancelling Context Service.
* Registering with Context Service.

» Updating connection data when Context Services sends a notification.

This issue can occur when there is a change in the connection data in the cloud. Also, check for the following
log statements in the fusion-management-connector logs at
/opt/cisco/ccbu/logs/fusion-mgmt-connector/:

*Error occurred while fetching runtime connector information from DB
* There are no runtime connectors registered in system currently
* Exception ocurred while fetching connection data

* Exception occurred while publishing connection data

If the issue persists, contact Cisco Support.

Activity Count Mismatch Between CVP and Other Components

This issue can occur if there is a count mismatch between CVP and other components due to a break in network
or cloud connectivity. You will get this error message Activity Failed.

Check the statistics. Context Service Statistics: Unified CVP fetches the customer record related statistics
every 30 minutes and writes in the VXML logs and syslogs. These statistics are flushed out immediately post
fetching.

Verify the VXML logs for any exceptions. Search the log $CVP_HOME/logs/VXML for the instances

“CS_SDK STATUS?” - Verify the reachability /connectivity. Alerts are captured in syslogServer.
Activity Failure in Debug Mode

Error/Exception in VXMLlogs

Network issue, incorrect connection data

* Verify that the proxy is correct.
* Check if the proxy is working on the web browser.

 Check if the connection data is valid.
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Verify the VXML logs for any exceptions. Search the log $CVP_HOME/logs/VXML for the instances
“CS_SDK_STATUS?” - Verify the reachability /connectivity. Alerts are captured in syslogServer.
Periodic Logging of Context Service SDK Connector Status
* Context Service status information is logged periodically into the respective log files.

* The periodic interval is 30 minutes, and this is synchronized to the wall clock time. The log should appear
at 1100hrs, 1130hrs, 1200hrs and so on.

* The status message lists the overall status, services used by the connector, information on whether it is
reachable, latency and so on.

* Fusion Management Connector logs are located at
/opt/cisco/ccbu/logs/fusion-mgmt-connector

* Finesse Auth logs are located at: /opt/cisco/desktop/logs/finesse-auth.

Periodic Logging of Context Service JMX Counters

The JMX statistics information is logged into the logs located at /opt/cisco/desktop/logs/finesse-auth directory"
with the text "CS_SDK STATS SUMMARY".

\}

Note This statistics information is not logged into the Fusion Management Connector logs.

Troubleshooting Context Service Runtime Process

This section describes the runtime related issues that are encountered during the runtime connection with the
Context Service Cloud. The troubleshooting tips and the possible solution for each are presented.

Unable to Access Customer Context Information

In the Cisco Finesse desktop gadget, there may be instances where the customer's context information is not
accessible and the following error message is displayed:

Experiencing issues with accessing customer's context information
This error message could occur due to the following reasons:

» Invalid client settings. Check and correct the client settings.
* Due to connectivity issues. Check if the Context Service connectivity is accessible from Cisco Finesse.

* Cisco Finesse is not registered with Context Service. Check your Context Service registration. If Context
Services is not registered, try again

Deregister a Component with Context Service

After registering a server, you can deregister it if you decide to stop using Context Service with that server.
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Before you begin

Ensure that your web browser allows popups.

Procedure

Step 1 In Unified CCE Administration, choose Overview > Features > Context Service.
Step 2 Click Deregister.

Your browser displays the Cisco Spark sign-in page.

Step 3 Sign in with your Cisco Webex Control Hub admin credentials and confirm the removal of your Hybrid
Services cluster.
You are redirected to the application page for the completion of the deregistration process. The browser
window closes automatically after a successful deregistration. Avoid making any changes to the client settings
until the deregistration is completed successfully.
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CHAPTER 6

Courtesy Callback

* Courtesy Callback, on page 61
* Configure Courtesy Callback, on page 63

Courtesy Callback

Courtesy Callback gives a caller the option to have an agent return their call. This option limits the time a
caller waits on the phone for an agent to answer.

Each call has a calculated Estimated Wait Time (EWT). When a caller's EWT approaches zero, the script
places a call back to the caller. When the caller answers, the script inserts the caller back into the queue with
their original order. The caller reaches an agent in the same time as if they had stayed on the phone.

Figure 7: Courtesy Callback

Call back - still in queue

214

Courtesy Callback Call Flows

If the caller opts for a callback, they leave their name and phone number. Their request remains in the system.
The system places a callback to the caller when the Estimated Wait Time (EWT) reaches the correct value.
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The caller answers the call and confirms that they are the original caller, and the system connects the caller
to the agent after a short wait.

\)

Note Courtesy Callback is also supported for IP-originated calls.

A typical call flow for this feature follows this pattern:

1. The call arrives at Unified CVP and the call is treated in the normal VRU environment.

2. The Call Studio and Unified CCE Courtesy Callback scripts determine if the caller is eligible for a callback
based on your rules.

3. Ifthe caller is eligible, the system announces the EWT and offers the caller a callback when an agent is
available.

4. The caller chooses what to do:

a. Ifthe caller chooses not to use the callback feature, queuing continues as normal.

b. If the caller chooses to receive a callback, the system prompts the caller to record their name and to
key in their phone number.

5. The system writes a database record to log the callback information.

N

Note If the database is not accessible, the system does not offer a callback to the caller.

6. The caller disconnects from the TDM side of the call. However, the IP side of the call in Unified CVP
and Unified CCE is still active. This keeps the call in the same queue position. No queue music plays, so
Voice Browser resources used during this time are less than for a caller actually in the queue.

7. When an appropriate agent is close to being available (as determined by your callback scripts), then the
system calls the person back. The system announces the recorded name when the callback is made to
ensure that correct person accepts the call.

8. A VRU session asks the caller to confirm that they are the correct person and that they are ready for the
callback.

If the system cannot reach the callback number (for example, busy lines, RNA, or network problems),
then the call is not sent to an agent. The call also does not go to the agent if the caller does not confirm
that they are the correct person. The agent is guaranteed that someone is waiting when they take the call.
The system assumes that the caller is already on the line by the time the agent gets the call.

This feature is called preemptive callback because the system assumes that the caller waits a minimal
time for the agent and the caller is on the line when the agent answers.

9. The system presents the call context on the agent screen-pop, as normal.
If the system cannot reach the caller after a configurable number and frequency of retries, the callback cancels

and the database status updates appropriately. You can run reports to determine if any manual callbacks are
necessary based on your business rules.
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See the Configuration Guide for Cisco Unified Customer Voice Portal at https://www.cisco.com/en/US/
products/sw/custcosw/ps1006/products_installation_and configuration guides_list.html for a call flow
description of the scripts providing the Courtesy Callback feature.

Configure Courtesy Callback

Configure Gateway

Configure the VXML Gateway for Courtesy Callback

Complete the following procedure to configure the VXML gateway for Courtesy Callback:

Procedure

Step 1 Copy cvp_ccb_vxml.tcl from the CVP Operations Console to the flash memory of the gateway, as follows:
a) Select Bulk Administration > File Transfer > Scriptsand Media.
b) In Device Association, select Gateway for Device Type.
c) Select the required gateway from the Available list.
d) Click the right arrow icon to move the available gateway to the Selected list.
e) From the default gateway files, highlight cvp_ccb_vxml.tcl.
f) Click Transfer.
Step 2 Log on to VXML gateway.
Step 3 Add the cvp_cc service to the configuration service cvp_cc flash:cvp_ccb_vxml.tcl.

This service does not require any parameters.

Step 4 Enter the following command to load the application:

call application voice load cvp_cc

Step 5 On the VoIP dial-peer that defines the VRU from Unified CCE, verify that the codec can be used for recording.

Example:
The following example verifies that g711ulaw can be used for recording in Courtesy Callback:

dial-peer voice 123 voip
service bootstrap

incoming called-number 123T
dtmf-relay rte-nte
h245-signal
h245-alphanumeric

codec g7llulaw

no vad!

Step 6 Configure the following to ensure that SIP is setup to forward SIP INFO messaging:

voice service voip
signaling forward unconditional

Step 7 To play the beep to prompt the caller to record their name in the BillingQueue example script add the following
text to the configuration:
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. Configure the Ingress Gateway for Courtesy Callback

vxml version 2.0

Note Whenever you enable vxml version 2.0 on the gateway, vxml audioerror is off by default. When an
audio file cannot be played, error.badfetch will not generate an audio error event.

To generate an error in the gateway, enable vxmlaudioerror.

Example:
The following example uses config terminal mode to add both commands:

config t

vxml version 2.0
vxml audioerror
exit

Configure the Ingress Gateway for Courtesy Callback

Step 1

Step 2
Step 3

Step 4

Complete the following procedure to configure the ingress gateway for courtesy callback:

Procedure

Copy surviability.tcl from the Operations Console to the flash memory of the gateway, as follows:
a) Select Bulk Administration > File Transfer > Scriptsand Media.

b) In Device Association, select Gateway for Device Type.

c) Select the required gateway from the Available list.

d) Click the right arrow icon to move the available gateway to the Selected list.

e) From the default gateway files, highlight survivability.tcl.

f) Click Transfer.

Log onto the ingress gateway.

Add the following to the survivability service:

param ccb id:<host name or ip of this gateway>;loc:<location name>; trunks:<number of callback

trunks>

* id - A unique identifier for this gateway and is logged to the database to show which gateway processed
the original callback request.

* loc - An arbitrary location name specifying the location of this gateway.
¢ Trunks- The number of DS0's reserved for callbacks on this gateway. Limit the number of T1/E1 trunks

to enable the system to limit the resources allowed for callbacks.

Example:
The following example shows a basic configuration:

service cvp-survivability flash:survivability.tcl
param ccb id:10.86.132.177;1loc:doclab;trunks:1!

Create the incoming POTS dial peer, or verify that the survivability service is being used on your incoming
POTS dial peer.

Example:
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Step 5

Step 6

Configure CUBE-E for Courtesy Callback .

For example,

dial-peer voice 978555 pots
service cvp-survivability
incoming called-number 9785551234
direct-inward-dial!

Create outgoing POTS dial peers for the callbacks. These are the dial peers that place the actual call back out
to the PSTN.

Example:
For example,

dial-peer voice 978555 pots
destination-pattern 978555....
no digit-strip port 0/0/1:23!

Use the following configuration to ensure that SIP is set up to forward SIP INFO messaging:

voice service voip signaling forward unconditional

Configure CUBE-E for Courtesy Callback

)

Note If you are using CUBE-E then you need sip profile configuration and apply it on outgoing dial-peer through

cvp. See the below the example:

A "sip-profile” configuration is needed on ISR CUBE E for the courtesy callback feature. To configure the
"sip-profile", the following must be added

voice class sip-profiles 103
request INVITE sip-header Call-Info add "X-Cisco-CCBProbe: <ccb param>"

where "<ccb param>" is the "ccb" parameter defined in the survivability service. Add this "sip-profile" to the
outgoing dial-peer to the CVP.

The following is a configuration example

voice class sip-profiles 103

request INVITE sip-header Call-Info add "X-Cisco-CCBProbe: id:10.10.10.180;sydlab;trunks:4"
dial-peer voice 5001 voip

description Comprehensive outbound route to CVP

destination-pattern 5001

session protocol sipv2

session target ipv4:10.10.10.10

dtmf-relay rtp-nte

voice-class sip profiles 103

codec g7llulaw
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B configure Unified CVP

no vad

In the above example, 10.10.10.180 is the CUBE IPand 10.10.10.10 is the CVP Call Server IP.

\)

Note If CUBE E is used for Courtesy Call Back then under voice service voip class in CUBE E must have media
flow-through for Courtesy Call Back to work.

Configure Unified CVP

Configure the Reporting Server for Courtesy Callback

Step 1

Step 2
Step 3

Step 4
Step 5

Step 6

A reporting server is required for the Courtesy Callback feature. Complete the following procedure to configure
a reporting server for Courtesy Callback:

Before you begin

Install and configure the Reporting Server.

Procedure

In the Operations Console, select System > Courtesy Callback.
The Courtesy Callback Configuration page displays.

Choose the General tab.

Click the Unified CVP Reporting Server drop-down, and select the Reporting Server to use for storing
Courtesy Callback data.

If required, select Enable secure communication with the Courtesy Callback database.

Configure allowed and disabled dialed numbers.

These are the numbers that the system should and should not call when it is making a Courtesy Callback to
a caller.

Note Initially, there are no allowed dialed numbers for the Courtesy Callback feature. Allow Unmatched
Dialed Numbers is de-selected and, the Allowed Dialed Numbers window is empty.

Adjust the Maximum Number of Calls per Calling Number to the desired number.

By default, this is set to 0 and no limit is imposed. This setting allows you to limit the number of calls that
are eligible to receive a callback from the same calling number.

If this field is set to a positive number (X), then the Courtesy Callback Validate element only allows X callbacks
per calling number to go through the preemptive exit state at any time.

If there are already X callbacks offered for a calling number, new calls go through the none exit state of the
Validate element.

In addition, if no calling number is available for a call, the call always goes through the none exit state of the
Validate element.
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Step 7

Step 8

Step 9

Configure the Call Studio Scripts for Courtesy Callback .

Choose the Call Server Deployment tab and move the Call Server you want to use for Courtesy Callbacks
from the Available box to the Selected box.

Click Save.

The configuration becomes active (is deployed) the next time the Reporting Server is restarted.

You can also deploy the new Reporting Server configuration immediately by clicking Save & Deploy.

Note After all the updates are configured, restart the Reporting Server to update the configuration.

Configure the Call Studio Scripts for Courtesy Callback

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6
Step 7

Step 8

Step 9

Step 10

Step 11

The Courtesy Callback feature is controlled by a combination of Call Studio scripts and ICM scripts. Complete
the following procedure to configure the Call Studio scripts:

Procedure

Access the .zip file from the CVP OAMP machine from the location
C:\Cisco\CVP\OPSConsoleServer\StudioDownloads\CourtesyCallbackStudioScripts.zip.

Extract the example Call Studio Courtesy Callback scripts contained in CourtesyCallbackStudioScripts.zip
to a folder of your choice on the computer running CallStudio.

Each folder contains a Call Studio project having the same name as the folder. The five individual project
comprise the Courtesy Callback feature.

Note Do not modify the scripts CallbackEngine and CallbackQueue.
Modify the scripts BillingQueue, CallbackEntry, and CallbackWait to suit your business needs.

Start Call Studio by selecting Start > All Programs > Cisco > Cisco Unified Call Studio.
Select File > Import.

The Import dialog box displays.

Expand the Call Studio folder and select Existing Call Studio Project Into Workspace.
Click Next .

The Import Call Studio Project From File System displays.

Browse to the location where you extracted the call studio projects. For each of the folders that were unzipped,
select the folder (for example BillingQueue) and select Finish.

The project is imported into Call Studio.

Repeat the action in previous step for each of the five folders.

The five projects display in the upper-left of the Navigator window.

Update the Default Audio Path URI field in Call Studio to contain the IP address and port value for your
media server.

For each of the Call Studio projects previously unzipped, complete the following steps:

a) Select the project in the Navigator window of Call Studio.
b) Choose Project > Properties> Call Studio > Audio Settings.
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. Configure the Call Studio Scripts for Courtesy Callback

Step 12

Step 13

Step 14
Step 15
Step 16
Step 17

Step 18

Step 19
Step 20
Step 21

Step 22

¢) On the Audio Settings window, modify the Default Audio Path URI field to http://<media-server
>/en-us/VL/.

d) Click Apply then click OK.
Under CallbackEntry Project, if required, modify the caller interaction settings in the SetQueueDefault_01
node.

a) In the Call Studio Navigator panel, open the CallBackEntry project and double-click app.callflow to
display the application elements in the script window.

b) Open the Start of Call page of the script using the tab at the bottom of the script display window.

¢) Select the SetQueueDefault_01 node.

d) In the Element Configuration panel, choose the Setting tab and modify the default settings as required.

In the CallbackEntry project, on the Wants Callback page, configure the following:
a) Highlight the Record Name node and choose the Settings tab.

b) In the Path setting, change the path to the location where you want to store the recorded names of the
callers.

¢) Highlight the Add Callback to DB 1node.

d) Change the Recorded name file setting to match the location of the recording folder that you created in
the previous step.

e) Ensure the keepalive Interval(in seconds) is greater than the length of the queue music being played. In
the Start of Call page.

The default is 120 seconds for the SetQueueDefaults 01 node.

f) Save the CallbackEntry project.
g) In the CallbackWait Project, modify values in the CallbackWait application.

In this application, you can change the IVR interaction that the caller receives at the time of the actual
callback. The caller interaction elements in CallbackWait > AskIfCallerReady page may be modified.
Save the project after you modify it.

h) Validate each of the five projects associated with the Courtesy Callback feature and deploy them to your
VXML Server.

Right-click each Courtesy Callback project in the Navigator window and select Validate.

Right-click each of the projects and click Deploy, then click Finish.

Using windows explorer, navigate to $CVP_HOMES$\VXMLServer\applications.

For each of the five Courtesy Callback applications, open the project's admin folder,
in%CVP_Home%\VXMLServer\applications, and double-click deployApp.bat to deploy the application to
the VXML Server.

Verify that all the applications are running by going into $CVP_HOME%\VXMLServer\admin and
double-clicking status.bat. All five applications should display under Application Name and with the status
Running.

Click Deploy.
In the Deploy Destination area, select Archive File and click Browse.

Navigate to the archive folder that you have set up.
Example:

C:\Users\Administrator\Desktop\Sample.

Enter the name of the file.
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Step 23
Step 24
Step 25
Step 26
Step 27

Step 28

Configure the Media Server for Courtesy Callback .

Example:

For example Samplefile.zip.

Click Save.

In the Deploy Destination area click Finish.

Log in to OAMP and choose Bulk Administration\File Transfer\VXML Applications.
Select the VXML Server to which you want to deploy the applications.

Select the zip file that contains the applications.

Example:
Samplefile.zip.
Click Transfer.

Configure the Media Server for Courtesy Callback

Step 1

Step 2

Step 3

Several Courtesy Callback specific media files are included with the sample scripts for Courtesy Callback.
Complete the procedure to configure the Media Server for Courtesy Callback:

Procedure

During the Unified CVP installation, the media files are copied as:
$CVP_HOMES$\OPSConsoleServer\CCBDownloads\CCBAudioFiles.zip.

Unzip the special audio files and copy to your media server VXMLServer\Tomcat\webapps\CVP\audio.

The sample scripts are set up to use the default location "\CVP\audio" for the audio files.

Change the default location of the audio files in the sample scripts to be your media server path.

Configure Unified CCE

Configure the ICM Script for Courtesy Callback

Following figure shows the sample Courtesy Callback ICM script.
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Figure 8: Sample Courtesy Callback ICM script
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Callusermicroapp FromExti:MLE],
sallide", Call uzer.mediaid)

concatente]
Calluser microapp.FromExtVXMLE],
"izallid=" Call uzer medinid)

4
FUN SCRIPT: CalbackEngine

Complete the following procedure to configure ICM to use the sample Courtesy Callback ICM script:

Procedure

Step 1 Copy the CCE example script, CourtesyCallback.|CM Sto the CCE Admin Workstation.
The example CCE script is available in the following locations:

* On the CVP install media in \CVP\Downloads and Samples\.
* From the Operations Console in % CVP_HOM E%\OPSConsoleSer ver\| CM Downloads.

* In the Import Script - Manual Object Mapping window, map the route and skill group to the route and
skill group available for courtesy callback.

Note For Small Contact Center Deployment Model, copy the CourtesyCallback.ICMS Routing Script
on the desktop where Internet Script editor is installed.

Step 2 In Script Editor, select File > Import Script...

Note For Small Contact Center Deployment Model follow the below steps.

a. Log In to ISE by sub customer user and Click on File>Import Script.
b. Select the Routing script which is copied in the desktop CourtesyCallback.ICMS.
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Step 3

Step 4

Step 5

Step 6

Step 7
Step 8

Step 9

Configure the ICM Script for Courtesy Callback .

In the script location dialog, select the CourtesyCallback.lCM S script and click Open.

Note You can bypass the set variable "Set media server" Highlighted as number 1 node in the Figure
57. Sample Courtesy Callback ICM script , as VXML Server, Call Server, and Media Server are
collocated.

Define a new ECC variable for courtesy callback.

A new ECC variable is used to determine if a caller is in a queue and can be offered a callback.

Navigate to ICM Admin Workstation > 1CM Configuration Manager > Expanded Call VariableList
tool to create the ECC Variable user.CourtesyCallbackEnabled specific to Courtesy Callback.

Set up the following parameters that are passed to CallbackEntry (VXML application):
Example:
» ToExtVXML][0] =concatenate("application=CallbackEntry",";ewt=",Call.user.microapp. ToExtVXML[0])
» ToExtVXML[1] = "qname=billing";
* ToExtVXML[2] = "queueapp=BillingQueue;"
* ToExtVXML[3] = concatenate("ani=",Call.CallingLinelD,";");

CallbackEntry is the name of the VXML Server application that will be executed:
ewt is calculated in Block #2.

gname is the name of the VXML Server queue into which the call will be placed. There must be a unique
gname for each unique resource pool queue.

queueapp is the name of the VXML Server queuing application that will be executed for this queue.
ani is the caller's calling Line Identifier.

Create Network VRU Scripts.

Navigate to | CM Configuration Manager > Network VRU Script List tool, create the following Interruptible
Script Network VRU Scripts.

Name: VXML _Server_Interruptible
Network VRU: Select your Type 10 CVP VRU
VRU Script Name: GS,Server,V,interrupt
Timeout: 9000 seconds

Interruptible: Checked

Choose |CM Configuration Manager > Network VRU Script List tool to create the following
Non-Interruptible Script Network VRU Scripts.

Name - VXML _Server_Nonlnterruptible

Network VRU - Select your Type 10 CVP VRU

VRU Script Name - GS,Server,V, nointerrupt

Timeout - 9000 seconds ( must be greater than the maximum possible call lifein Unified CVP)
Interruptible: Not Checked
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Step 10 Verify that the user.microapp. ToOExtVXMLECC variable is set up for an array of five items with a minimum
size of 60 characters and the user.microapp.FromExtVXML variable is set up for an array of four with a
minimum size of 60 characters.

Note

Verify that you have at least one available route and skill group to map to the route and skillgroup in the
example script.

Step 11 Save the script, then associate the call type and schedule the script.

Note For Small Contact Center Deployment Model ensure the resources used in this Routing Script, like
Network VRU Scripts , ECC variables etc are specific to the sub customer.
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Database Integration

* Database Integration, on page 73
* Configure Database Integration , on page 73

Database Integration

You can integrate your contact center with an external database. Database integration provides create, update,
and retrieve operations on tables in the external database. Database integration uses the Database Element in
the CVP Call Studio.

Configure Database Integration

Configure Unified CCE

Configure ICM Database Lookup

Complete the following procedure to configure ICM Database Lookup.

Procedure

Step 1 Select Enable Database Routing in Router options to edit Router setup for database lookup changes.
Step 2 Configure Database Lookup explorer:

a) Click Start > All programs> Cisco Unified CCE Tools> Administration Tools> Configuration
M anager.

b) Open Tools> Explorer Tools> Database L ookup Explorer.

¢) Configure Script Table and Script Table Column as shown in the following example:

Script Table:
Name: AccountInfo
Side A: \\dblookupl\DBLookup.AccountInfo

Side B: <Update Side B of database here>
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. Configure ICM Database Lookup

Step 3

Step 4

Description: <Provide description here>

dblookupl is external database server name, DBLookup is external database name, and AccountInfo is
the table name.

Script Table Column:
Column name: AccountNo

Description: <Provide description here>

Configure the following to change the registry settings in Unified CCE:

a)

b)

Navigate to HKEY _LOCAL_MACHINE > SOFTWARE > Cisco Systems, Inc. > ICM > <Instance
Name> > Router A > Router > CurrentVersion > Configuration > Database registry.

Instance Name is the name of the Instance that is configured.
Set the SQLLogin registry key as shown in the following example:

Example:

\\dblookupl\DBLookup= (sa, sa)

Where DBLookup is the external database name and (sa,sa) are the SQL server authentication.

Create the ICM script with the database lookup node with the respective table and lookup value.

The following figure shows AccountInfo as the table name and Call.CallingLineID as the lookup value.
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Configure Unified CVP ]

Figure 9: Example ICM Database Look Up
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Configure Unified CVP

Configure VXML Database Element

You need to configure Java Database Connectivity (JDBC) for VXML Database Element configuration.
Complete the following procedures for JDBC configuration:

* Install JDBC driver, on page 76
* Add JNDI Context, on page 76
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Install JDBC driver

Step 1

Step 2
Step 3

Add JNDI Context

Step 1
Step 2

Step 3

Database Integration |

* Configure VXML Studio Script, on page 77

* Create ICM Script, on page 77

Complete the following procedure to install the JDBC driver:

Procedure

Download the .exe file for Microsoft JDBC Driver for SQL Server

Example:
1033\sgljdbc _3.0.1301.101 enu.exe
Run the executable and install the .exe file in the location C: \ temp\

Copy thefileC: \temp\sgljdbc 3.0\enu\sgljdbc4. jar tothe Unified CVP VXML servers' folder
C:\Cisco\CVP\VXMLServer\Tomcat\common\lib

Complete the following procedure to add the Java Naming and Directory Interface (JNDI) context configuration:

Procedure

Go to the context.xml file located at C:\Cisco\CVP\VXMLServer\Tomcat\conf\context.xml file.

Enter the JNDI name, SQL server address, SQL database name, username and password.
The following is an example of the SQL authentication context.xml file:

<Context>

<WatchedResource>WEB-INF/web.xml</WatchedResource>

<Manager pathname="" />

<Resource name="7jdbc/dblookup"

auth="Container"

type="javax.sqgl.DataSource"
DriverClassName="com.microsoft.sglserver.jdbc.SQLServerDriver"
url="jdbc:sglserver://<dblookupnode ipaddress>:1433;databaseName=DBLookup;user=sa;password=sa"
>

</Context>

Perform following steps to restart VXML server services:

a) Goto Run window and enter services.msc command.
b) Select Cisco CVP VXML Server option.
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c)

Configure VXML Studio Script [JJj

Right-click and select Restart option.

Configure VXML Studio Script

Step 1

Step 2

Step 3

Create ICM Script

Complete the following procedure to configure the VXML studio script:

Procedure

Configure the following to create the VXML application with the database element.

a)
b)

¢)

Select single under Type.
Enter the database lookup name in JNDI Name.

Query SQL:

For example, select AccountNo from AccountInfo where CustomerNo = {CallData.ANI}
Where AccountNo - Value to be retrieved

AccountInfo - Table name

CustomerNo - condition to be queried

Data:

Create a database element with the following values:

Name - AccountNo

Value - {Data.Element.Database 0l.AccountNo}

Deploy the script to the local computer or to the remote computer (VXML call server directly) to create CVP
Subdialog return element.

If you saved this to the local machine, copy the whole folder to the following location:

<Install dir>:\Cisco\CVP\VXMLServer\applications and deploy it using deploy App windows batch file located
inside the admin folder of applications.

Create an ICM script similar to the one shown in the following figure:
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. Create ICM Script

Figure 10: Sample Script with ICM database Lookup
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Mobile Agent

* Capabilities, on page 79

* Initial Setup, on page 95

* Administration and Usage, on page 106
* Serviceability , on page 109

Capabilities

Cisco Unified Mobile Agent Description

Mobile Agent enables an agent to use any PSTN phone and a broadband VPN connection (for agent desktop
communications). The agent has the same capabilities as an agent in your call center using a Cisco IP Phone.

Unified Mobile Agent supports call center agents using phones that your contact center enterprise solution
does not directly control. You can deploy a Mobile Agent as follows:

* Outside the contact center, by using an analog phone or a mobile phone in the home.

* On an IP phone connection that is not CTI-controlled by Unified CCE HCS-CC or by an associated
Unified Communications Manager.

* On any voice endpoint of any ACD (including endpoints on other Unified Communication Managers)
that the contact center Unified Communication Manager can reach by a SIP trunk.

A Mobile Agent can use different phone numbers at different times; the agent enters the phone number at
login time. An agent can access the Mobile Agent functionality using any phone number that is included in
the Unified Communications Manager dial plan.

With Cisco Unified Mobile Agent, contact centers can:

* Add or enable temporary staft during seasonal high call volume who can be brought on line with reduced
startup costs

* Provide agents with the flexibility to work from home with similar quality, function, performance,
convenience, and security as are available in the corporate headquarters contact center

+ Allow agents to use the device they are most comfortable with, which improves agent productivity, helps
to retain agents, and reduces training costs
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* Hire skilled employees where they live and integrate remote workers into geographically dispersed teams
with access to equivalent corporate applications

The sections that follow highlight some of the benefits of Unified Mobile Agent, and describe its features.

Unified Mobile Agent Extends Unified CCE Capabilities

Before Mobile Agent, Unified CCE used a JTAPI interface to Unified CM to connect customer calls arriving
on a voice gateway to an agent's [P phone. Mobile Agent enables the Unified CCE architecture to connect
customer calls to an agent phone that Unified CCE does not directly control.

Mobile Agent uses a pair of CTI ports that function as proxies for the Mobile Agent phone and the caller
phone. Every logged-in Mobile Agent requires two CT1I ports (local and remote). The two CTI ports take the
place of the Cisco IP Phone monitored and controlled by Unified CM JTAPI. The agent at login uses the local
CTI port DN. When this agent is selected, the router transfers the caller to that CTI port. The remote CTI port
calls the agent either at login for a nailed (permanent) connection or upon being selected for a call-by-call
connection.

Cisco Unified Contact Center functionality remains intact whether an agent is mobile or local:

* Mobile Agents have the same capabilities and functionality that local agents have.

* Mobile Agents do not need any specialized equipment; they can receive calls on an analog or mobile
phone.

+ Unified Mobile Agent supports Cisco Finesse.
* Mobile Agent activity is recorded in the same contact center reports as local agent activity.

* Mobile Agent CTI and application data uses the same security mechanisms as local agent data.

Unified Mobile Agent Provides Agent Sign-In Flexibility

Agents can be either local agents or Mobile Agents, depending on how they sign in at various times.

Regardless of whether agents sign in as local or Mobile Agents, their skill groups do not change. Because
agents are chosen by existing selection rules and not by how they are connected, the same routing applies
regardless of how the agents log in. If you want to control routing depending on whether agents are local or
mobile, assign the agents to different skill groups and design your scripts accordingly.

Connection Modes

Cisco Unified Mobile Agent allows system administrators to configure agents to use either call by call dialing
or a nailed connection, or the administrator can configure agents to choose a connection mode at login time.

Mobile Agents are defined as agents using phones not directly controlled by Unified CC, irrespective of their
physical location. (The term local agent refers to an agent who uses a phone that is under control of Unified
CC, irrespective of physical location.)

You can configure Mobile Agents using either of two delivery modes:

* Call by Call—In this mode, the Mobile Agent's phone is dialed for each incoming call. When the call
ends, the Mobile Agent's phone is disconnected before being made ready for the next call.

* Nailed Connection—In this mode, the agent is called at login time and the line stays connected through
multiple customer calls.
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caliby call [Jii

Call by Call

Note

The administrator can select the Agent chooses option, which allows an agent to select a call delivery mode
at login.

In a call by call delivery mode, the Mobile Agent's phone is dialed for each incoming call. When the call ends,
the Mobile Agent's phone disconnects before is it made ready for the next call.

The call by call call flow works as follows:

1
2.

At login, the agent specifies an assigned extension for a CTI port.

A customer call arrives in the system and, through normal Unified ICM configuration and scripting, is
queued for a skill group or an agent. (This is no different than existing processing for local agents.)

The system assigns an agent to the call. If the agent's Desk Setting is Unified Mobile Agent-enabled and
configured for either call by call or Agent chooses mode, the router uses the extension of the agent's CTI
port as a label.

The incoming call rings at the agent's CTI port. The JTAPI Gateway and PIM notice this but do not answer
the call.

A call to the agent is initiated on another CTI port chosen from a preconfigured pool. If this call fails,
Redirect on No Answer processing is initiated.

\}

Note In call by call mode, the Answer Wait Time is 3 to 15 seconds longer than in a local agent inbound call

6.

7.

\)

scenario. Specify a Redirect on No Answer setting large enough to accommodate the extra processing time.

When the agent takes the remote phone off-hook to answer the call, the system directs the customer call
to the agent's call media address and the agent's call to the customer's call media address.

When the call ends, both connections are terminated and the agent is ready to accept another call.

Nailed Connections

Note

To configure Mobile Agent in call by call delivery mode, you must set the wrap-up timer to at least one second
using the Agent Desktop Settings List tool in the Configuration Manager.

In call by call delivery mode, callers often perceive a longer ring time compared to nailed connection delivery
mode. This is because callers hear the ringtone during the call flow; ringing stops only after the agent answers.
From the Unified CCE reporting perspective, a Mobile Agent in call by call delivery mode has a longer Answer
Wait Time for the same reason.

Related Topics

Configure Agent Desk Settings with Configuration Manager, on page 100

In nailed connection delivery mode, the agent is called once, at login, and the phone line remains connected
through multiple customer calls. See the following figure.
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Figure 11: Nailed Connection Call Flow
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The nailed connection call flow works as follows:

1
2.

At login, the agent specifies an assigned extension for a CTI port from a pool.

A call to the agent is initiated on another CTI port chosen from a preconfigured pool. The agent answers
the call. (The agent must answer this setup call to complete the connection and finalize the login procedure.)

A customer's call arrives in the system and, through normal Packaged CCE configuration and scripting,
is queued for a skill group or an agent. (This is no different than existing processing for local agents.)

The system assigns an agent to the call. If the agent's Desk Setting is Unified Mobile Agent-enabled and
configured for either nailed connection or Agent chooses mode, the router uses the extension of the agent's
CTI port as a label.

The incoming call rings at the agent's CTI port. The JTAPI Gateway and PIM notice this but does not
answer the call.

The agent desktop indicates a call is ringing and the agent clicks Answer.

When the agent indicates that they will answer the phone, the system directs the customer call to the
agent's call media address and the agent call to the customer's call media address.

When the call ends, the customer connection is terminated and the agent state is set to Ready.
At login, the agent enters the directory number of the local CTI port (LCP) in the Instrument Number

field and the remote phone number in CTI OS Desktop. The remote phone number can be any phone
number reachable by Unified CM.

When the agent clicks the Login button, a call is initiated to the agent's remote CTI port (RCP) and the
agent's remote phone rings.

When the agent answers the call, the call is then nailed up. This means that the agent will remain on this
call until the agent logs out or hangs up.

A customer's call arrives in the system , and scripting, is queued for a skill group/precision queue. (This
is no different than existing processing for local agents.)

When the agent clicks the Answer button, the voice path between the agent and the customer phone is
established, and the two parties can talk.

When the system assigns an agent to the call, the call is routed to the agent's LCP port. The agent then
hears the connect tone on the headset.
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6. When the call ends, the customer connection is terminated and the agent state returns to Ready.

Connect Tone

The Connect Tone feature in the nailed connection mode enables the system to play a tone to the Mobile
Agent through the agent's headset to let the agent know when a new call is connected. In the nailed connection
mode, you can configure an audible connect tone in addition to a call arrival notice (on the desktop only).

Connect Tone is particularly useful when Auto Answer is enabled or the agent is an Outbound agent. Here
are its features:

* An audible tone (two beeps) is sent to the Mobile Agent headset when the call to the nailed connection
Mobile Agent is connected. It is a DTMF tone played by Unified CM and cannot be modified.

* The Connect Tone plays only when the nailed connection Mobile Agent receives a call, as in the following
examples:

* The agent receives a consultation call.

* The agent receives an outbound call.

* The Connect Tone does not play when the nailed connection Mobile Agent initiates a call, as in the
following examples:

* The agent makes a call.
* The agent makes the consultation call.
* Outbound direct preview call is made.

* Supervisor barge-in call is made.

Related Topics
Enable Mobile Agent Connect Tone, on page 105

Agent Greeting and Whisper Announcement
The Agent Greeting and Whisper Announcement features are available to Unified Mobile Agents. The following
sections explain more about how these features apply to Unified Mobile Agents.

Agent Greeting

You can use the Agent Greeting feature to record a message that plays automatically to callers when they
connect to you. Your greeting message can welcome the caller, identify you, and include other useful
information.

Limitations
The following limitations apply to the Agent Greeting feature for Mobile Agents.

* If a Mobile Agent hangs up when an Agent Greeting plays, the customer still hears the complete Agent
Greeting before the call ends. This applies for both call by call and nailed-up calls.
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\}

Note Inthe Agent Greeting Call Type Report, this call does not appear as a failed agent
greeting call.

* A supervisor cannot barge in when an Agent Greeting is playing.

* [f a Peripheral Gateway (PG), JTAPI Gateway (JGW), or PIM failover occurs when an Agent Greeting
plays for a Mobile Agent, the call fails.

« [f a Mobile Agent hangs up when an Agent Greeting plays, the customer still hears the complete Agent
Greeting before the call ends.

\)

Note Inthe Agent Greeting Call Type Report, this call does not appear as a failed agent
greeting call.

* If a Peripheral Gateway (PG), ITAPI Gateway (JGW), or PIM failover occurs when an Agent Greeting
plays for a Mobile Agent, the call fails. This applies for both call-by-call and nailed-up calls.

\}

Note  You can use Agent Greeting for Mobile Agents only with parent/child deployments that are approved by
Cisco Assessment-to-Quality (A2Q) with Design Mentoring Services (DMS).

For more information about Agent Greeting, see Capabilities, on page 19.

Whisper Announcement

With Whisper Announcement, agents can hear a brief prerecorded message just before they connect with each
caller. The announcement plays only to the agent; the caller hears ringing (based on existing ringtone patterns)
while the announcement plays. The announcement can contain information about the caller, such as language
preference or customer status. This information helps the agent prepare for the call.

Configuration Requirement

For the Whisper Announcement feature for Unified Mobile Agents, you require a Media Termination Point
(MTP) resource on an incoming SIP device.

Feature Requirements

Hardware and Software Requirements

Hardware and software requirements for the Unified Mobile Agent are identical to those of Unified CCE. For
more information about limitations and scalability for Unified Mobile Agent, see the Hardware & System
Software Specification (Bill of Materials) for Cisco Unified ICM/Contact Center Enterprise & Hosted, Release
9.0(1).
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Phone Requirements
A Unified Mobile Agent can use an analog, digital, or IP phone to handle calls.

Conference Requirements

To use Agent Greeting for Mobile Agents, you must configure external conference-bridge (hardware) resources.
To estimate the number of required resources, you can use the following formula:

Number of conference bridge resources = Maobile Agent call rate x Average greeting time (in seconds)

For information about configuring external conference-bridge resources, see the dspfarm profile 1
for conference configuration section in the sample configuration gateway, listed in Media Termination
Points Configuration, on page 101.

CTI Port Requirements
You need two CTI ports (local and remote) for every logged-in Mobile Agent.

Unified Mobile Agent uses Unified CM CTI Port as a proxy for the agent's phone. When this proxy is set up,
whenever a Mobile Agent is selected to handle a customer call, the following happens:

* The call is directed to the CTI port extension.
* Unified CCE, using the JTAPI Gateway, intercepts the call arriving on the CTI Port and directs Unified
CM to connect the call to the Mobile Agent.
Unified Mobile Agent requires that maximum number of calls is set to 2 and busy trigger is set to 1.
For Unified Mobile Agent to work properly, you must configure two CTI ports:
* One port to serve as the agent's virtual extension.
* The other port to initiate calls to the agent.
You must assign these CTI ports to the Unified ICM application. The ports are recognized by Unified ICM
when receiving the Unified CM configuration.

For these CTI ports in IPv6 enabled deployments, you have to set |P Addressing Modeto | Pv4 Only. You
do this by creating a Common Device Configuration and referencing it to these CTI ports.

Supported Unified CCE/Unified CCH Features

The following features are supported:
+ Unified CCE supports temporary uninstallation while preserving Mobile Agent data.

For more information about temporary uninstallation, see the Cisco Unified Contact Center Enterprise
Installation and Upgrade Guide.

* Mobile Agents can participate in outbound campaigns, but they must use a nailed-up connection for all
outbound dialing modes.

+ Unified Mobile Agent supports Redirect on No Answer (RONA). If the Mobile Agent fails to answer,
the agent is made Not Ready, and the call is redirected to a RANA DN route point.

* Unified Mobile Agent supports G.711A-law, G.711u-law, and G.729 codecs.
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* There is no direct interaction between Unified Mobile Agent and multichannel applications. Email and
Chat are IP applications that continue to operate normally, assuming the Mobile Agent has a desktop
with enough bandwidth on the broadband connection to support them.

+ Unified Mobile Agent supports Cisco Unified Customer Voice Portal (Unified CVP) and Cisco Unified
IP-IVR (Unified IP IVR).

Related Topics
Silent Monitoring, on page 88

Fault Tolerance Support
Fault tolerance for the Unified Mobile Agent follows the behavior of Unified CCE:

* The JTAPI Gateway, Unified CCE PIM, and CTI components record key events related to Unified Mobile
Agent as part of their normal logging.

 As with standard Unified CCE calls, if a Peripheral Gateway (PG) component such as the JTAPI Gateway
fails, the phone call is not lost, but subsequent call control (transfer, conference, or hold) might not be
possible after a failover. The Mobile Agent is notified of a failure (on the desktop), but they must log in
again after a Unified CM or Unified ICM failure occurs.

» Where CTI data is delivered for screen pops, CTI data is preserved.

Unified Mobile Agent can experience many of the same failure cases as Unified CCE:
* Side A/B failure
* VRU failure
* Unified CM failure

» CTI server failure

There are also some failure cases that are unique to Unified Mobile Agent:

* A situation where a Mobile Agent is using a cellular phone and the connection is dropped due to
non-availability of a signal, is deemed as external failure. The agent must call back and log-in again.

* [f a Mobile Agent's phone line disconnects while using nailed connection mode, the agent must log in
again to receive new calls.

Important Considerations

Before you proceed, consider the following Unified Mobile Agent limitations and considerations:

Failover

* During a failover, if an agent in call by call mode answers an alerting call, the call can drop. This occurs
because the media cannot be bridged when there is no active PG.

* During a prolonged Peripheral Gateway (PG) failover, if an agent takes call control action for a Unified
Mobile Agent-to-Unified Mobile Agent call, the call can drop. This occurs because the activating PG
may not have information for all agents and calls at that point.
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* Unified Communications Manager failover causes a Mobile Agent call to be lost.

« If a call by call Mobile Agent initiates a call (including a supervisor call) and does not answer the remote
leg of the call before PG failover, the call fails. The agent must disconnect the remote agent call leg and
reinitiate the call.

Performance

* Mobile Agent call processing uses more server resources and therefore reduces the maximum number
of supported agents on both Unified CM and the Unified ICM Agent PG.

For more information about sizing Mobile Agents, see the Solution Design Guide for Cisco Unified
Contact Center Enterprise.

* Because Unified Mobile Agent adds processing steps to Unified CCE/Unified CCH default functionality,
Mobile Agents may experience some delay in screen popup windows.

* From a caller's perspective, the call by call delivery mode has a longer ring time compared with the nailed
connection delivery mode. This is because Unified CCE/Unified CCH does not start to dial the Mobile
Agent's phone number until after the call information is routed to the agent desktop. In addition, the
customer call media stream is not connected to the agent until after the agent answers the phone.

The caller hears a repeated ringtone while Unified CCE/Unified CCH makes these connections.

Codec
The codec settings on the Peripheral Gateway and Voice Gateway must match. Perform the following procedure:
1. Launch the Peripheral Gateway Setup.
2. In the Peripheral Gateway Component Properties, select the UCM PIM and click Edit.

3. In the CallManager Parameters section, select the appropriate codec from the Mobile Agent Codec drop
down list.
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Figure 12: Mobile Agent Codec Selection
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Silent Monitoring

Unified Mobile Agent provides the following silent monitoring support:

+ Unified Mobile Agent requires that caller and agent voice gateways be on separate devices if silent
monitoring is to be used.

* Unified Mobile Agent does not support desktop monitoring.

* Whenever silent monitoring is used on Unified Mobile Agent, caller and agent voice gateways must be

on separate devices. Similarly, if MTP is enabled when silent monitoring is used, MTP resources for
caller and agent must also be on separate devices.

Mobile Agent Scalability

Mobile Agent scalability may be contingent on specific Unified CM versions. For more information, see the
Solution Design Guide for Cisco Unified Contact Center Enterprise at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-implementation-design-guides-list. html.

Unsupported Features

The following is a list of unsupported features for Mobile Agent:
* Web Callback
* Blended Collaboration
* Unified CM-based Silent Monitoring

» Agent Request
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Unified Mobile Agent Call Flows

This section provides sample Unified Mobile Agent call flows for:

* Inbound calls
* Local consultation calls
» Remote consultation calls

* Remote conference calls

In all Unified Mobile Agent call flows, the JTAPI Gateway maintains the signaling association between the
inbound and outbound calls and, if necessary, performs further operations on the call. JTAPI Gateway, however,
does not terminate media; it uses CTI to deliver the customer call from the inbound gateway port to the
outbound gateway port.

This means that a Mobile Agent must use an agent desktop application to log in, change agent state, log out,
send dual-tone multifrequency (DTMF) digits, and perform call control.
About Figures in This Section

The figures in this section:

* Show a caller and a Mobile Agent in a cellular network. However, the same concepts apply whether the
Mobile Agent is using an enterprise desk phone, an IP Phone spanning another Unified CM cluster,
standard analog phone, or a third-party ACD phone.

* Focus solely on call media flow; a Mobile Agent must use a CTI Desktop with broadband access to
perform agent state and call control.

* Show only a sampling of the call flows possible with Unified Mobile Agent.

Inbound Call Flow

The following figure shows an inbound call flow.
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Figure 13: Mobile Agent Inbound Call Flow
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Note Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring
is required.

The following describes an inbound call flow:
1. The Mobile Agent becomes available to answer calls by:
» Logging in to the corporate domain using VPN over the ADSL/Cable connection
» Launching the agent desktop interface and logging in with their remote phone information

* Entering the Ready mode

2. A customer call arrives at the Unified CC.

3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile
Agent.

4. The Router passes the call to the local CTI Port of a Mobile Agent.
5. The JTAPI Gateway places a call on a network CTI port to the agent's cell phone.

6. The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the
call from the inbound (caller) gateway port to the outbound (agent) gateway port.

Local Consult Calls

The following figure shows a consult call flow between a Mobile Agent and a local agent.
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Figure 14: Mobile Agent Consult Call Flow
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Note Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring
is required.

The following describes a local consult call flow:
1. The Mobile Agent becomes available to answer calls by:
» Logging in to the corporate domain using VPN over the ADSL/Cable connection
» Launching the agent desktop interface and logging in with their remote phone information

* Entering the Ready mode

2. A customer call arrives at the Unified CC.

w

The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile
Agent.

The Router passes the call to the local CTI Port of a Mobile Agent.
The JTAPI Gateway places Agent Connection Call 1 on a network CTI port to the agent's cell phone.

The Mobile Agent places the customer call on hold and consults a local Unified CCE/Unified CCH agent.

N o g &

The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the
call from the IP hard phone to the outbound gateway port.
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Remote Consult Calls

The following figure shows a remote consult call flow between two Mobile Agents.

Figure 15: Mobile Agent Remote Consult Call Flow
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Note Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring
is required.

The following describes a remote consult call flow:
1. The Mobile Agent becomes available to answer calls by:
* Logging in to the corporate domain using VPN over the ADSL/Cable connection
» Launching the agent desktop interface and logging in with their remote phone information

* Entering the Ready mode

2. A customer call arrives at the Unified CC.

3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile
Agent.

4. The Router passes the call to the local CTI Port of a Mobile Agent.
5. The JTAPI Gateway places Agent Connection Call 1 on a network CTI port to the agent's cell phone.

6. Mobile Agent 1 puts the customer call on hold and consults Mobile Agent 2.
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7. The JTAPI Gateway uses the network CTI port of Mobile Agent 1 and the network CTI port of Mobile

Agent 2 to stream the media for the call from the outbound gateway port on Agent Gateway 1 to the
outbound gateway port on Agent Gateway 2.

Remote Conference Calls

The following figure shows a remote conference call flow between two Mobile Agents.

Figure 16: Mobile Agent Remote Conference Call Flow
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Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring
is required.

)

Note

The following describes a remote conference call flow:
1. The Mobile Agent becomes available to answer calls by:
» Logging in to the corporate domain using VPN over the ADSL/Cable connection

 Launching the agent desktop interface and logging in with their remote phone information

* Entering the Ready mode

2. A customer call arrives at the Unified CC.
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3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile
Agent.

4. The Router passes the call to the local CTI Port of a Mobile Agent.

5. Unified CM redirects the media stream 1 from inbound gateway on the Caller Gateway to the conference
bridge during call merging process.

6. The JTAPI Gateway uses local and network CTI ports of Mobile Agent 1 to loop the Media Stream 2 for
the call from the outbound gateway port on the Agent Gateway 1 to the conference bridge.

7. The JTAPI Gateway uses local and network CTI ports of Mobile Agent 2 to loop the Media Stream 3 for
the call from the outbound gateway port on the Agent Gateway 2 to the conference bridge.

Outbound Option Call Flow

The following figure shows a Outbound Option call flow between a customer and a Mobile Agent.

\}

Note Unified Mobile Agent supports Outbound Option calls in nailed connection delivery mode only.

Figure 17: Mobile Agent Outbound Call Flow
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Note Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring
is required.

The following describes an Outbound Option call flow:
1. The Mobile Agent becomes available to answer calls by:

» Logging in to the corporate domain using VPN over the ADSL/Cable connection
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* Launching the agent desktop interface and logging in with their remote phone information
* Entering the Ready mode

2. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile
Agent.

3. Outbound Option dials the customer number and, after reaching a live customer, the Dialer redirects the
customer call to the local CTI Port of an Outbound Option Mobile Agent.

4. The JTAPI Gateway places a call on a network CTI port to the agent's cell phone.

5. The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the
call from the inbound gateway port to the outbound gateway port.

Unified Mobile Agent Reporting

Unified Mobile Agent-specific call data is contained in the following Cisco Unified Intelligence Center reports:
Agent Team Historical, Agent Real Time, and Agent Skill Group Historical. These “All Field” reports contain
information in multiple fields that show what kind of call the agent is on (nonmobile, call by call, nailed
connection) and the Unified Mobile Agent phone number.

Notes about Mobile Agents and reporting:

» The Mobile Agent must be logged in through the agent desktop for call data to be recorded in Unified
CC reports.

* Service level for Mobile Agent calls might be different than local agent calls, because it takes longer to
connect the call to the agent.

For example, a call by call Mobile Agent might have a longer Answer Wait Time Average than a local
agent. This is because Unified CCE/Unified CCH does not start to dial the Mobile Agent phone number
until after the call information is routed to the agent desktop. In addition, the customer call media stream
is not connected to the agent until after the agent answers the phone.

For more information about Unified Mobile Agent fields in the database schema, see Database Schema
Handbook for Cisco Unified Contact Center Enterprise.

Initial Setup

Summary of Unified Mobile Agent System Configuration Tasks
The following table describes system configuration tasks for Unified Mobile Agent.

Table 2: Unified Mobile Agent System Configuration Tasks

Task See

Configure Unified CM CTI Port Unified CM CTI Port Configuration and Mapping for Unified Mobile
pools Agent, on page 96
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Task See

Configure Unified CM Call Duration | Maximum Call Duration Timer Configuration, on page 99
Timer

Configure Agent Desk Settings Agent Desk Setting Configuration for Unified Mobile Agent, on page
100

Configure Devices Device Configuration for Unified Mobile Agent, on page 101

Configure Media Termination Points | Media Termination Points Configuration, on page 101

Unified CM CTI Port Configuration and Mapping for Unified Mobile Agent

This section describes the CTI Port Pool configuration tasks specific to Mobile Agent Option configuration.
It does not discuss installation or configuration of Unified CCE.

\)

Note For more information about installing and configuring Unified CM with Unified CCE, see the Cisco Unified
Contact Center Enterprise Installation and Upgrade Guide.

Unified Mobile Agent must have two CTI ports configured on Unified CM:

* A local CTI port, which Unified Mobile Agent uses as the agent's virtual extension.

» A remote CTI port, which Unified Mobile Agent uses to initiate a call to the Mobile Agent's phone.

Naming Conventions for Local and Network Ports

* The local port must begin with the string LCP.
* The remote port must begin with the string RCP.

* The remaining characters in the device names for the LCP and RCP pair must match. For example an
LCP port named LCP0000 has a corresponding RCP port named RCP0000.

* For example, you can use the following naming convention:

* For alocal CTI Port pool name, configure a name in the format LCPxxxxFyyyy, where LCP identifies
a local CTI Port Pool, xxxX is the peripheral ID for the Unified CM PIM, and yyyy is the number of
local CTI Port.

Example: LCP5000F0000 represents CTI Port: 0 in a local CTI Port pool for the Unified CM PIM
with the peripheral ID 5000.

* For a network CTI Port pool name, use the same format, except substitute RCP as the first three
characters.

Note While you do not require a naming convention, the substrings identifying the
Unified CM PIM peripheral ID and the CTI Port must match for each
local/network pair.
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CTI Port configuration consists of the following steps:

1. Add the CTI port as you would for an IP Phone.

2. Use the naming convention described above to map the local and network CTI ports.

N

Note Each local CTI port must have a corresponding network CTI port.

3. Add a directory number for the local CTI port (that is, the agent's virtual extension).

4. Map the local and network CTI ports with the PG user.

Music on Hold Design

If you want callers to hear music when a Mobile Agent places the caller on hold, you must assign Music on
Hold (MoH) resources to the ingress voice gateway or trunk that is connected to the caller (as you do with
traditional agents). In this case, the user or network audio source is specified on the local CTI port configuration.
Similarly, if a Mobile Agent must hear music when the system puts the agent on hold, you must assign MoH
resources to the ingress voice gateway or trunk that is connected to the Mobile Agent. In this case, the user
or network audio source is specified on the remote CTI port configuration.

Do not assign MoH resources to local ports and remote CTI ports, because it might affect the system
performance.

If a remote Mobile Agent calls over a nailed connection and if there is no active call to the agent, the agent
is put on hold. Enable MoH to the Mobile Agent phone for nailed connection calls. If MoH resources are an
issue, consider multicast MoH services.

If a remote Mobile Agent calls over a nailed connection, and if MoH is disabled, the hold tone plays to the
agent phone during the hold time. This depends on the call processing agent that controls the Mobile Agent
remote phone. For Unified CM, the hold tone is enabled by default (it is similar to the Mobile Agent connect
tone). Because the hold tone is similar to the connect tone, it is difficult for the agent to identify if a call arrived
from listening to the Mobile Agent connect tone. The hold tone prevents the agent from hearing the connect
tone.

Therefore, disable the hold tone by changing the setting of the Tone on Hold Timer service parameter to 0.
For more information about setting this parameter, see the Unified CM product documentation available at:
https://www.cisco.com/c/en/us/support/unified-communications/unified-communications-manager-callmanager/
tsd-products-support-series-home.html.

Configure Unified CM CTI Port Pools for Unified Mobile Agent

Step 1
Step 2
Step 3
Step 4

Perform the following steps to configure CTI Ports.

Procedure

In Unified CM Administration, select Device > Phone.
Click Add a New Phone.

From Phone Type, select CT| Port.

Click Next.
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Step 5

Step 6
Step 7

Step 8

Step 9

Step 10
Step 11
Step 12
Step 13
Step 14

Step 15
Step 16

Step 17
Step 18
Step 19

Step 20

In Device Name, enter a unique name for the local CTI Port pool name; click OK when finished.
Using the naming convention format LCPXXxXyyyy:
* LCP identifies the CTI Port as a local device.

* XXxx is the peripheral ID for the Unified CM PIM.

* yyyy is the local CTI Port.

The name LCP5000F0000 would represent CTI Port: 0 in a local CTI Port pool for the Unified CM PIM with
the peripheral ID 5000.

The name LCP0000 represents the local port.

In Description, enter text that identifies the local CTI port.

Use the Device Pool drop-down list to choose the device pool to which you want to assign the network CTI
port pool. Do not select Default. (The device pool defines sets of common characteristics for devices.)

Click Save.

Highlight a record and select Add a New DN.

Add a unique directory number for the CTI port you just created.
In Maximum Number of Calls, enter 2.

In Busy Trigger, enter 1.

When finished, click Save, and click Close.

Repeat the preceding steps to configure the network CTI port pool.

In Device Name, using the naming convention format RCPxxxxyyyy, where:

* RCP identifies the CTI port as the Remote CTI port where the call between the agent's remote device
and the Unified CM Port is nailed up at agent login time.

* XXXX is the peripheral ID for the Unified CM PIM.

* yyyy is the network CTI port.

The name RCP5000F0000 represents CTI Port: 0 in a network CTI Port pool for the Unified CM PIM with
the peripheral ID 5000.

In Description, enter text that identifies the network CTI port pool.

Use the Device Pool drop-down list to choose the device pool to which you want to assign the network CTI
port. Do not select Default. pool. (The device pool defines sets of common characteristics for devices.)

Click Save.
Highlight a record and select Add a New DN.
Add a unique directory number for the CTI port you just created.

The extension length can be different from the extension length of the LCP Port if your dial plan requires it.

When finished, click Save, and click Close.

Map Local and Remote CTI Ports with Peripheral Gateway User

After you define the CTI Port pool, you must associate the CTI Ports with PG users.
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Procedure

Step 1 In Unified CM Administration, select Application User.

Step 2 Select a username and associate ports with it.
Step 3 When finished, click Save, and then click Close.

Note If CTI ports for Unified Mobile Agent are disassociated at the Unified CM while a Mobile Agent
is on an active call, the call can drop.

Maximum Call Duration Timer Configuration

By default, Mobile Agents in nailed connection mode log out after 12 hours. This happens because a Unified
CM Service Parameter—the Maximum Call Duration Timer—determines the amount of time an agent phone
can remain in the Connected state after login.

If you anticipate that nailed connection agents in your Unified Mobile Agent deployment will be logged on
longer than 12 hours, use the following instructions to either:

* Increase the Maximum Call Duration Timer setting.

* Disable the timer entirely.

Configure Maximum Call Duration Timer

\}

Note  This procedure applies only to Unified Mobile Agent deployments where agents logged in to nailed connection
mode are to remain connected longer than 12 hours. Also, if your Mobile Agent deployment uses intercluster
trunks, you must perform the following steps on both local and network Unified CM clusters.

Procedure

Step 1 In Unified CM Administration, choose System > Service Parameters.
Step 2 In the Server drop-down list, choose a server.

Step 3 In the Service drop-down list, choose a server .

The Service Parameter s Configuration windowappears.

Step 4 In the Cluster-wide Parameters section, specify a Maximum Call Duration Timer setting.
The default is 720 minutes (12 hours); the maximum setting allowed is 35791 minutes.

Note To disable the timer, enter O.

Step 5 Click Save.
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Agent Desk Setting Configuration for Unified Mobile Agent

This section describes Agent Desk Settings that you must modify to accommodate Unified Mobile Agent
features.

Configure Agent Desk Settings with Configuration Manager

This section describes Agent Desk Settings configuration settings you should specify in Unified ICM
Configuration Manager to accommodate Unified Mobile Agent features.

The following instructions describe how to configure one Agent Desk Setting. Repeat this process for each
different Agent Desk Setting in your deployment.

Procedure

Step 1 From the Unified ICM Configuration Manager, choose Configurel CM > Enter prise> Agent Desk Settings
List.

The Unified ICM Agent Desk Settings List dialog box opens.
Step 2 Click Retrieve.
Step 3 Click Add.

Step 4 Fill in the following Attributes tab information, making sure to include settings for the following fields and
check boxes:

* Ring no answer time. The system allows a call to ring at the agent's station before redirecting the call.
This can be from 1 to 120 seconds.

Note If you use call by call mode, the answer wait time will be longer than in a local agent inbound
call scenario, so specify a value in this field to accommodate the extra processing time.

« Logout non-activity time. The number of seconds of agent inactivity while in the not ready state before
the system logs out the agent. A blank entry disables the timer.

» Cisco Unified M obile Agent (check box). Enables the Mobile Agent feature so that the agent can log
in remotely and take calls from any phone.

» Mobile Agent mode. Select how call connections are made to the Mobile Agent's phone:

* Agent chooses. Agent selects call by call or nailed connection at login.

+ Call by call. Agent's phone is dialed for each incoming call. When a call ends, the connection is
terminated before the agent is made ready for next call.

* Nailed connection. Agent is called once, at login. The line stays connected through multiple customer

calls.

Step 5 Click Save.
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Note For more information about configuring Agent Desk Settings in Unified CCE, see Cisco Unified Contact
Center Enterprise Installation and Upgrade Guide.

Device Configuration for Unified Mobile Agent

Use the Agent Targeting Rules (ATR) mechanism described in the Cisco Unified Contact Center Enterprise
Installation and Upgrade Guide to configure a device as you would for a phone, but using the LCP Port in
place of the agent's phone extension.

Media Termination Points Configuration

If you use SIP trunks, you must configure Media Termination Points (MTPs). You must also configure MTPs
if you use TDM trunks to create an interface with service providers.

Additionally, MTPs are required for Mobile Agent call flows that involve a Cisco Unified Customer Voice
Portal (CVP) solution. Because in DTMF signaling mode the Mobile Agent uses out-of-band signaling,
whereas Unified CVP supports in-band signaling, the conversion from out-of-band to in-band signaling
requires an MTP resource.

MTPs may be allocated as required in deployments that use a mix of IPv4 and IPv6 connections. MTP resources
are allocated provided that the Media Resource Group List is configured on the IPV4 endpoint.

MTPs are available in the following forms, but not all are supported in Mobile Agent environments:

* Software-based MTPs in Cisco IOS gateways—use these MTPs for Mobile Agent as they provide codec
flexibility and improved scalability compared with other MTP options. The following is a sample
configuration on a gateway.

sccp local GigabitEthernet0/0

sccp ccm 10.10.10.31 identifier 1 priority 1 version 7.0
sccp ccm 10.10.10.131 identifier 2 priority 2 version 7.0
sccp

1

sccp ccm group 1

associate ccm 1 priority 1

associate ccm 2 priority 2

associate profile 3 register gw84xcode
associate profile 1 register gw84conf
associate profile 2 register gw84mtp

1

dspfarm profile 3 transcode

codec g729abr8

codec g729%ar8

codec g7llalaw

codec g71llulaw

codec g729r8

codec g729%br8

maximum sessions 52

associate application SCCP

1
dspfarm profile 1 conference

codec g729%br8

codec g729r8

codec g729abr8

codec g729%ar8
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codec g7llalaw
codec g71llulaw
maximum sessions 24

associate application SCCP

|

dspfarm profile 2 mtp

codec g71llulaw

maximum sessions software 500
associate application SCCP

» Hardware-based MTPs in Cisco IOS gateways—These MTPs are supported. If you choose these, consider
the extra cost, codec restrictions, and scalability constraints.

* Software-based MTPs using the Cisco IP Voice Media Streaming Application—These MTPs are not
supported with Mobile Agents.

)

Note Because Unified CM-based software MTPs are used implicitly, you must add a special configuration to avoid
using them. Create a new Media Resource Group (MRG) as a place holder, and place the software MTPs in
that MRG. For instructions, refer to the Unified CM help documentation.

Configure Media Termination Points in Unified CM

Add MTP Resources to Unified CM
Perform these steps to add media termination points (MTPs) to Unified CM.

Procedure

Step 1 In Unified CM Administration click M edia Resources > Media Ter mination Point.
Step 2 Click Add New.

Step 3 Choose Cisco |OS Enhanced Software Media Termination Point from the M edia Ter mination Point
Type drop-down list.

Step 4 Enter an MTP name. This name must match the device name you chose in IOS. In the example in the previous
section, the MTP was called gw84mtp, as from the config line: associate profile 2 gw84mtp.

Step 5 Choose the appropriate device pool.
Step 6 Click Save and then click Apply config.

Step 7 Navigate back to M edia Termination Point and ensure the newly added MTP is listed as being registered
with <Unified CM subscriber IP address> in the Status column.

Step 8 Repeat steps 1 through 7 for each sccp ccm group you configured on each of your gateways.

Configure Media Termination Point Resources in Unified CM

This section explains how to create media resource groups and media resource group lists.
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Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

Step 8

Associate Media Resource Group List with Device Pools .

Procedure

Navigate to M edia Resour ces> M edia Resour ce Group in Unified CM Administration.
Click Add New.
Specify a name and description.

From the Available Media Resources that you just created, move the those devices from the Available to the
Selected list by clicking the down arrow. Ensure that you do not include Unified CM Software resources. For
example, type anything that starts with ANN_, MTP_, or MOH_ .

Navigate to M edia Resour ces > M edia Resource Group List.
Click Add New.

Move the Media Resource Group you just created from the Available Media Resource Groups to the Selected
Media Resource Groups.

Click Save.

Associate Media Resource Group List with Device Pools

Step 1

Step 2

Procedure

Navigate to System > Device Pool and click on the device pool that contains the CTI ports for Mobile Agent.
If there are multiple pools, perform the next step for each device pool that applies.

In the Media Resource Group List drop-down list, select the Media Resource Group List that you just created,
click Save and then click Apply config.

Quarantine Unified CM Software-Based Resources

Step 1
Step 2

Insert MTPs

Unified CM-based software MTPs are used by default. However, Cisco contact center deployments do not
support these resources because they may cause performance problems in call processing. You must quarantine
them with a special configuration. Perform the following steps:

Procedure

Create a new Media Resource Group (MRG) as a place holder.
Place the software MTPs in that MRG.

For further instructions, refer to the Unified CM help documentation.

If you use SIP trunks, you must configure MTPs. This also applies if you use TDM trunks to interact with
service providers. Mobile Agent cannot use an MTP with codec pass through. When you configure the MTP,
you must select No pass through. KPML is not supported with Mobile Agent.
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Step 1
Step 2
Step 3

Procedure

Log in to Unified CM Administration and select Device > Trunk.
Select the trunk on which you want to configure MTPs.
Depending on the scenario listed below, perform the corresponding step listed in the Description column.

Note that if you configure Trunk Groups to dynamically insert MTPs, only the calls that require MTPs use
them.

* If you want to always insert MTPs for inbound and outbound calls through a given trunk: In the Trunk
Configuration settings, select the M edia Termination Point Required check box.

* If you want to dynamically insert MTPs when Unified ICM detects media or signaling incompatibility
between the caller and called endpoints: In the Trunk Group Configuration settings, in DTMF Signaling
Method, select RFC2833.

Enable Call Progress Tones for Agent-Initiated Calls

Procedure

When M TP Required is not enabled, extra configuration is required to enable an agent to hear call progress
tones for agent initiated calls. If instead you have dynamic MTP allocation by forcing mismatched DTMF
settings, then configure the Unified Communications Manager to enable Early Offer.

For information on configuring the Unified Communications Manager, see the Unified Communications
Manager product documentation at https://www.cisco.com/c/en/us/support/unified-communications/
unified-communications-manager-callmanager/tsd-products-support-series-home.html. The Cisco Annunciator
does not generate ringback and other call progress tones, as it does for regular phones and softphones. Instead,
Mobile Agent relies on the called party generating these tones (and the early offer setting triggers sending
these tones to the agent).

Note This selection does not affect MTP sizing for IP Phones and other endpoints that support RFC2833
signaling, as is the case for many Cisco phones. For more information about supported phones, see
the Contact Center Enterprise Compatibility Matrix at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list. html.

Verify MTP Resource Utilization

Since Unified CM comes preconfigured with Software MTP resources, these resources may sometimes be
used to provide MTP for Mobile Agent calls without proper configuration. Because we don't support the use
of Unified CM based software MTPs, we explicitly quarantined them in the above section, Disabling Unified
CM Based Software MTPs. To ensure that the new 10S-based MTPs are the ones being used for Mobile
Agents, perform the following steps to verify that correct MTPs are used.
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Step 1

Step 2
Step 3

Step 4
Step 5

Step 6

Enabled Connect Tone Feature .

Procedure

Install the Unified CM Realtime monitoring tool. This tool can be downloaded under Application > Plugins
within Unified CM Administration.

Place a call to a logged-in Mobile Agent.

Open the Unified CM Realtime monitoring tool and navigate to System > Perfor mance> Open Perfor mance
Monitoring.

Expand the node(s) that are associated with your I0S-based MTP resources and choose Cisco M TP Device.

Double-click Resources Active and choose all of the available resources to monitor. This includes both I0S
and Unified CM-based resources. Ensure that the only resources that are active during the Mobile Agent
phone call are the IOS-based resources. Also, ensure that all UCM-based MTP resources are not active.

Repeat the previous step for each node that has MTP resources associated with it.

Enabled Connect Tone Feature

In a nailed connection, the system can play a tone to the Unified Mobile Agent through the agent headset to
let the agent know when a new call is connected. In the default Installation, the Mobile Agent Connect Tone
feature is disabled.

Enable Mobhile Agent Connect Tone

Step 1
Step 2

Step 3
Step 4

If you require Unified Mobile Agent Connect Tone, you must make the following change in the Windows
Registry for the key PlayMAConnectTone under the JTAPI GW PG registry entries.

Perform the following procedure to allow a Mobile Agent in the nailed connection mode to hear a tone when
a new call is connected.
Before you begin

MTP resources must be associated with the CUCM trunk that connects to the Agent Gateway.

Procedure

On the PG machine, open the Registry Editor (regedit.exe).

Navigate to HKEY LOCAL MACHINE\SOFTWARE\Cisco Systems,
Inc.\ICM\<InstanceName>\PG1A\PG\CurrentVersion\JGWS\jgwl \JGWData\Config\PlayMAConnectTone.

The Edit DWORD Value dialog box appears.

In the Value data: field, enter 1 to enable Mobile Agent Connect Tone and click OK.
Exit the Registry Editor to save the change, and cycle the PG service.
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Administration and Usage

Cisco Finesse

Finesse provides a browser-based desktop for agents and supervisors. Mobile agents can perform the same
call control functions as Unified CCE agents. Mobile supervisors can perform all call control functions except
for silent monitoring.

Sign in to Cisco Finesse Desktop

Step 1

Step 2
Step 3
Step 4

Step 5

Step 6

Step 7

Procedure

Enter the hostname of the Finesse server in the fully qualified domain name (FQDN) format: https://<FQDN
of Finesse server>, where FQDN is the fully qualified domain name of the Finesse server.

In an IPv6-enabled environment, you must include the port number in the URL (https://FQDN of Finesse
server:8082/desktop).

In the ID field, enter your agent ID.
In the Password field, enter your password.

In the Extension field, enter your extension.

For a mobile agent, the extension represents the virtual extension for the agent, also known as the local CTI
port (LCP).

Check the Sign in asa M obile Agent check box.
The Mode and Dial Number fields appear.

From the Mode drop-down list, choose the mode you want to use.
In Call by Call mode, your phone is dialed for each incoming call and disconnected when the call ends.

In Nailed Connection mode, your phone is called when you sign in and the line stays connected through
multiple customer calls.

In the Dial Number field, enter the number for the phone you are using.
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Verify Sign-In to Cisco Finesse .

D 1234
—
Extension® [kl

H sign in as a Mobile Agent 2

Mode* Mailed Connection = |l

8
3
Option Description
ID The agent ID.
Password Your supervisor assigns this password.
Extension The agent's extension.
Sign in as Unified Mobile Agent Select to sign in as a Unified Mobile Agent.
Mode Call by Call or Nailed Connection
Dial Number The number of the phone being used.
Step 8 Click Sign In.
Note In Nailed Connection mode, the desktop must receive and answer a setup call before sign-in is

complete.

In Call by Call mode, the dial number provided is not verified. To ensure that the number is correct,
verify the number in the header on the Agent Desktop after sign-in is complete.

Verify Sign-In to Cisco Finesse

Procedure

Check to be sure the Finesse Agent Desktop displays the following in the header:
» Mobile Agent before your agent name
* The mode used (Call by Call or Nailed Connection)

* The dial number you provided
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y1]1s1]1, Mobile Agent AgentTest Mobile (2272012) - Extension 7777 (Nailed Connection @ 3333)
CISCO ~ NotReady *
|' PHomEY  Manage call

\ Make a New Call

& 2010-2011 Cisco Systems, Inc. All rights reserved.

Enable Ready State

Make a Call

Step 1

Step 2
Step 3

You must be in Ready state to process incoming calls.

Procedure

Choose Ready from the drop-down list below the agent name.

Note If you are in call-by-call mode, you must answer and end each incoming call on your physical phone.
After you answer a call, you must perform all other call control functions (such as Conference,
Transfer, Hold, Retrieve) using the desktop.

With call-by-call connection, an agent cannot end one leg of a transfer without terminating it at the
other end. The transfer must either be fully completed or both legs completely dropped.

If you are in Nailed Connection mode, after you answer the initial setup call, you must perform all
other call control functions using the desktop.

Procedure

From the drop-down list below the agent name, choose Not Ready.

Note You must be in Not Ready state to make a call.

Click Make a New Call.
Enter the number you want to call on the keypad, and then click Call.

If you are in Call by Call mode, the CTI server sends a setup call to your phone. A message appears on the
keypad that states the following:

A call will be initiated to your phone which must be answered before an
outbound call to your destination can be made.

After the setup call is answered, the system establishes the outbound call to the destination specified.
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Serviceability

On a Mobile Agent call flow, CUCM may return a 404 error due to the absence of a agent greeting, leading
to call failure. To fix this issue, do the following:

1. Create anew Run External Script node. Map the backup media of the script to the agent greeting recording
(media file).

2. Addthe Run External Script node between the failure path of the AgentGreeting Run External Script node
and the End node.

3. Connect the Run External Script node's success path to the existing Release Call node and failure path to
the existing End node.

)

Note This fix may add a short delay of one to two seconds to the call flow.

For information about Create Agent Greeting Play Script, on page 29.
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Music on Hold

* Capabilities, on page 111
* Configure Music on Hold, on page 112

Capabilities

Hold and Resume

Agents use Hold to suspend a call temporarily. If Music on Hold resources are available, the caller hears music
while on hold. Otherwise, the caller hears a tone.

Multicast Music-on-Hold

As an alternative to the unicast Music-on-Hold (MOH), you can multicast MOH with supplementary services
on Unified CM. You have these options when deploying MOH with this feature:

» With Unified CM multicasting the packets on the local LAN

* With the branch gateway multicasting on their local LAN

Use branch gateway multicasting when you have configured survivable remote site telephony (SRST) on the
gateway. This method enables the deployment to use MOH locally and avoid MOH streaming over the WAN
link.

\}

Note For information about configuring MOH on the Call Manager Enterprise (CME), see https://www.cisco.com/
c/en/us/td/docs/voice_ip_comm/cucme/admin/configuration/manual/cmeadm/cmemoh.html#wpmkr1022205.

Music on Hold with Mobile Agent

You can use Music on Hold (MoH) for mobile agents just as you do for traditional agents. To let callers hear
music, assign MoH resources to the Ingress Voice Gateway. Specify the user or network audio source on the
local CTI port configuration. To let the agent hear music when on hold, assign MoH resources to the Egress
Voice Gateway. Specify the user or network audio source on the remote CTI port configuration.
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. Configure Music on Hold

\)

Note Always assign the MoH resources to the gateways. Do not assign MoH resources to local and remote CTI

ports. It is unnecessary and can have a performance impact on the system.

A Mobile Agent remote call over a nailed connection is put on hold when there is no active call to the agent.
In general, enable MoH to the mobile agent phone for nailed connection calls. If MoH resources are an issue,
consider multicast MoH services.

For a nailed connection, disabling MoH for the remote phone might lead to the hold tone playing instead.
This depends on the call processing agent that controls the remote phone. For Unified CM, the hold tone is
enabled by default and is similar to the Mobile Agent connect tone. With the Unified CM hold tone enabled,
it is difficult for the agent to identify if a call has arrived by listening for the Mobile Agent connect tone.
Therefore, disable the hold tone for Unified CM by changing the setting of the Tone on Hold Timer service
parameter on Unified CM.

For additional information about MoH design, see the Cisco Collaboration System Solution Reference Network
Designs.

Configure Music on Hold

Configure Unified Communication Manager

A Unified Communications Manager Music On Hold (MoH) server can generate MoH stream from an audio
file or a fixed source. Either of this can be transmitted as unicast or multicast.

MoH server can be deployed in two modes.

1. Along with Unified CM on the same server for HCS for CC deployments with less than 1250 users in a
CM Cluster.

2. As standalone node (TFTP/MoH Server) for HCS for CC deployments with more than 1250 users in a
CM Cluster

* Configure Music On Hold Server Audio Source, on page 112
* Set up Service Parameters for Music on Hold, on page 113

* Set up Phone Configuration for Music on Hold, on page 113

Configure Music On Hold Server Audio Source

Step 1
Step 2
Step 3
Step 4

Procedure

Login to Cisco Unified Communications Manager Administration page.
Select M edia Resour ces> Music On Hold Audio Sour ce.

Retain the default sample audio source.

Select Initial Announcement from drop down list (optional).
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Step 5
Step 6

Set up Service Parameters for Music on Hold .

Click Save.

Perform the following steps to create new Audio Source.

a) Click Add New.

b) Select MOH audio stream number from the drop down list.
¢) Select MOH audio source file from the drop down list.

d) Enter the MOH source name .

e) Choose Initial Announcement from the drop-down list.

f) Click Save.

Set up Service Parameters for Music on Hold

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Procedure

Login to Cisco Unified Communications Manager Administration page.

Select System > Service Parameters.

Select the MoH server from the drop-down list .

Select the app service from Cisco | P Voice M edia Streaming App Service drop-down list.
Select the required codec in the Supported MOH Codecs field and click Ok.

Click Save.

Set up Phone Configuration for Music on Hold

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Procedure

Login to Cisco Unified Communications Manager Administration page.
Select Device > Phone.

Select the phone to configure MOH.

Select a audio source from User Hold MOH Audio Source drop-down list.
Select a audio source from Network Hold MOH Audio Source drop-down list.
Click Save and click Apply and reset the phone.
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Precision Queue

* Capabilities, on page 115
* Initial Setup, on page 121

Capabilities

Precision Queues

Precision routing offers a multidimensional alternative to skill group routing: using Unified CCE scripting,
you can dynamically map the precision queues to direct a call to the agent who best matches the caller's precise
needs. Precision queues are the key components of precision routing.

To configure Precision Routing, you must do the following:

1. Create attributes. Attributes are characteristics that can be assigned a True | False value or a Proficiency
rating from 1 to 10.

2. Assign attributes to agents.
3. Create precision queues.

4. Create routing scripts.

There is no need to add an agent to a precision queue; agents become members of precision queues automatically
based on their attributes. If a precision queue requires an agent who lives in Boston, who speaks fluent Spanish,
and who is proficient in troubleshooting a specific piece of equipment, an agent with the attributes Boston =
True, Spanish = True, and Repair = 10 is automatically part of the precision queue. A Spanish caller in Boston
who needs help with equipment is routed to that agent.

A precision queue includes:

» Terms: A term compares an attribute against a value. For example, you can create the following term:
Spanish == 10. The term of the attribute is the highest proficiency in Spanish.

Each precision queue can have multiple attributes, and these attributes can be used in multiple terms.
For example, to select an agent with a Spanish proficiency value between 5 and 10, you would create
one term for Spanish > 5 and another for Spanish < 10.

» Expressions: An expression is a collection of one or more terms. The terms in an expression must share
the same operator—they must all be AND or must all be OR relationships.
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Step 1

Congider If
Wait for B, 1
Expression:t Add Atrbute |~
Spanish Q| == |z| Insert EHpreEmn
AND [] Bnston Q| = [z] | Tre [ =

0K Cancel

302762

* Steps: A precision queue step is a time-based routing point within the precision queue. A step is a
collection of one or more expressions.

A step may also include wait time and a Consider If formula. Use wait time to assign a maximum amount
of time to wait for an available agent. Use a Consider If formula to evaluate the step against predefined
criteria, for example, another queue.

Steps

Mame  Criteria
Step 1 [ (Spanish == 10) and (Boston == true) | OR [ (ServerXYZ == 6) and (Spanish >=6) ]

302761

Administrators can see and manage attributes. Supervisors can configure attributes for their supervised agents
on the Attributes tab of the Agents tool.

Skill Groups or Precision Queues?

Should you use skill groups or precision queues for the routing needs of your organization? This section
distinguishes the two methods.

Use a Skill Group

A skill group represents a competency or responsibility. For example, it could be a predefined collection of
traits, such as salespeople who are in charge of selling to England. The skill group could be called “English
sales”. If you wanted to divide the agents in this group into two types of proficiencies (perhaps based on
experience), you would need to set up two separate skill groups; for example, English Sales 1 and English
Sales 2. You would then associate an agent with one of them, based on the agent's proficiency. Do this by
accessing the skill group and locating the agent that you want to add to it (or add that skill group to the agent).
To summarize, creating a skill group involves first building a concept of what combinations of traits you want
for each agent, like English Sales 2.

Use a Precision Queue

In contrast to skill groups, a precision queue breaks down attribute definitions to form a collection of agents
at an attribute level. The agents that match the attribute level of the precision queue become associated with
that precision queue.

With precision queues, the preceding English sales example involves defining the attributes English and Sales,
and associating agents that have those traits to them. The precision queue English Sales would dynamically
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Attributes

Attributes .

map all those agents that had those traits to the precision queue. In addition, you can define more complex
proficiency attributes to associate with those agents. This would allow you to build, in a single precision
queue, multiple proficiency searches like English language proficiency 10 and sales proficiency 5.

To break down the precision queue example into skill groups, you would need to set up two separate skill
groups: English language proficiency 10 and sales proficiency 5. With precision queues, you can refine agents
by attributes. With skill groups, you define a skill group and then assign agents to it.

Decide on Skill Groups or a Precision Queue

Precision routing enhances and can replace traditional routing. Traditional routing looks at all of the skill
groups to which an agent belongs and defines the hierarchy of skills to map business needs. However, traditional
routing is restricted by its single-dimensional nature.

Precision routing provides multidimensional routing with simple configuration, scripting, and reporting.
Agents are represented through multiple attributes with proficiencies so that the capabilities of each agent are
accurately exposed, bringing more value to the business.

If your routing needs are not too complex, consider using one or two skill groups. However, if you want to
conduct a search involving as many as ten different proficiency levels in one easily managed queue, use
precision queues.

Attributes identify a call routing requirement, such as language, location, or agent expertise. You can create
two types of attributes: Boolean or Proficiency.

When you create a precision queue, you identify which attributes are part of that queue and then implement
the queue in a script. When you assign a new attribute to an agent and the attribute value matches the precision
queue criteria, the agent is automatically associated with the precision queue.

You must take system limits into account when you assign attributes to agents, and satisfy both of the following
conditions:

* A) an agent can have a maximum of 50 attributes

and

* B) an agent can belong to a maximum total of 50 combined precision queues and skill groups

Failure to meet both of these conditions will result in an unsuccessful configuration operation.

For example, if a particular attribute is used in many precision queues, and that attribute is assigned to an
agent, that agent belongs to all of those precision queues. It is therefore possible to exceed condition B by
assigning just a few attributes to an agent, if those attributes are used in many precision queues.

It is therefore prudent to plan carefully and to keep system limits in mind when creating attributes and adding
them to precision queues.

Navigate to Unified CCE Administration > Organization > Skills > Attributesto configure attributes.

Administrators can see and manage attributes. Supervisors can configure attributes for their supervised agents
on the Attributes tab of the Agents tool.
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Precision Queue Call Flow Example

At a high level, consider a 5-step precision queue with a Consider If formula for Caller is Premium Member
attached to the Step 1:

* Step 1 - Attribute: Skill > 8 - Consider If: Caller is Premium Member
* Step 2 - Attribute: Skill > 6

* Step 3 - Attribute: Skill > 4

* Step 4 - Attribute: Skill >3

* Step 5 - Attribute: Skill >= 1

Caller John, who is not a premium customer, calls 1-800-repairs. John's call is routed to this precision queue.

* Since John is not a premium customer, he is immediately routed out of Step 1 (because of the Consider
If on Step 1) and into Step 2 where he waits for his call to be answered.

* After the Step 2 wait time has expired, John's call moves to Step 3 to wait for an agent.
* After the Step 3 wait time has expired, John's call moves to Step 4 to wait for an agent.

* When it arrives at Step 5, John's call will wait indefinitely for an available agent. This step cannot be
avoided by any call because there is no routing logic past this.

The overarching idea is that customer will use each successive step to expand the pool of available agents.
Eventually, when you reach the "last" step (the step with the highest number), the call is waiting in a potentially
very large pool of agents. With each extra step, the chances of the call being handled increase. This also puts
the most valuable and skilled agents in the earlier precision queue steps. Calls come to them first before
moving on the less appropriate agents in later steps.

\)

Note When two or more agents have the same proficiently level for the attributes the PQ step leverages the Longest
Available Agent (LLA).

Scripts for Precision Queues

To implement Precision Routing in your contact center, you must create scripts.
You can create and use configured (static) and dynamic precision queue nodes in your scripts.

« Static precision queue nodes target a single, configured precision queue. When the script utilizes a single
precision queue, use static precision queues.

* Dynamic precision queue nodes are used to target one or more previously configured precision queues.
Use dynamic precision queues when you want a single routing script for multiple precision queues (for
example, when the overall call treatment does not vary from one precision queue to another). Dynamic
precision queues can simplify and reduce the overall number of routing scripts in the system.
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Precision Queue Script Node

Use the Precision Queue script node to queue a call based on caller requirements until an agent with desired
proficiency become available. This node contains multiple agent selection criteria which are separated into
steps.

A single call can be queued on multiple precision queues. If an agent becomes available in one of the precision
queues, the call is routed to that resource. You cannot reference multiple precision queues with a single
Precision Queue node. However, you can execute multiple Precision Queue nodes sequentially to achieve
this.

The Precision Queue node includes a Priority field, which sets the initial queuing priority for the calls processed
through this node versus other calls queued to the other targets using different nodes. The priority is expressed
as an integer from 1 (top priority) to 10 (least priority). The default value is 5.

If more than one call is queued to a precision queue when an agent becomes available, the queued call with
the lowest priority number is routed to the target first. For example, assume an agent in a precision queue
becomes available and two calls are queued to that precision queue. If one call has priority 3 and the other
has priority 5, the call with priority 3, the lower value, is routed to the precision queue while the other call
continues to wait. If the priorities of the two calls are same, then the call queued first is routed first.

VRU (voice response unit) script instructions are not sent to the VRU. If a call enters the precision queue
node and no resource is available, the call is queued to the precision queue and the node transfers the call to
the default VRU, if the call is not already on a VRU. The script flow then exits immediately through the
success branch. The script should then continue with a run external script node to instruct the VRU what to
do while holding the call until an agent becomes available. Typically, this invokes a network VRU script that
plays music-on-hold, possibly interrupted on a regular basis with an announcement. The script flow can also
use other queuing nodes to queue the same call to other targets, for example, Queue to Skill Group and Queue
to Agent.

Queuing Behavior of the Precision Queue Node

Precision queues internally are configured with one or more time-based steps, each with a configured wait
time. After a call is queued, the first step begins and the timer starts. This occurs although the execution path
of the script exited the success node and a new node may be targeted (for example, Run Ext. Script).

If the timer for the first step expires, control moves to the second step (assuming one exists), and so on. As
long as the call remains in queue and there are steps left to execute, the call internally continues to move
between steps regardless of the path the call takes after it leaves the precision queue node. If a call is queued
to two or more precision queues, the call internally walks through the steps for each precision queue in parallel.
After the call reaches the last step on a precision queue, it remains queued on that step until the call is routed,
abandoned, or ended.

If there is an update to the precision queue definition, then all queued calls in the precision queue are
re-evaluated and the execution begins again from the first step.

For example, consider the wait time for an ongoing call at step 1 to be 1080 seconds, of which 1000 seconds
has already elapsed. Now, suppose the wait time is changed to 900 seconds, then the wait time for this call is
also reset to 900 seconds, even though only 80 more seconds are left to move to the next step.
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Dynamic Limits for Skill Groups and Precision Queues Per Agent

The number of skill groups and precision queues per agent significantly affects the following subcomponents

of Unified CCE:

* Cisco Finesse servers

» Agent PGs
* Router

* Logger

\}

Note

We use queue as a common term for skill groups and precision queues.

To maintain the performance of your solution, periodically remove unused queues.

The Reference Designs set a standard limit for the average queues per agent on each PG. On a particular PG,
some agents can have more queues than other agents. As long as the average across all the agents on the PG
is within the limit, you can still have the maximum active agents on that PG.

For example, assume that you have three groups of agents on a PG in a 4000 Agent Reference Design:

* Group A has 500 agents with five queues each.

* Group B has 1000 agents with 15 queues each.

* Group C has 500 agents with 25 queues each.

These three groups average to 15 queues per agent, so you can have them all on a single PG under the standard

limits.

You can also exceed that standard limit if you reduce the number of agents on each PG and on the whole

system.
)
Note See the configuration tables in the configuration limits chapter for the standard limits.

The Cisco Finesse server does not display statistics for unused queues. So, the active queues affect the
performance of the Cisco Finesse server more than the total configured queues.

The Cisco Finesse desktop updates queue (skill group) statistics at 10-second intervals. The Cisco Finesse
Desktop also supports a fixed number of queue statistics fields. You cannot change these fields.

This table shows the approximate reduction in the number of agents your solution can support with more

queues per agent:

Table 3: Dynamic Agents and Queues Limits

Queues per Agent

Maximum Agents
per PG

Maximum Agents for
2000 Agent
Reference Design

Maximum Agents for
4000 Agent
Reference Design1

Maximum Agents for
12000 Agent
Reference Design

Maximum Agents for
24000 Agent
Reference Design

10

2000

2000

4000

12000

24000
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Queues per Agent | Maximum Agents | Maximum Agents for | Maximum Agents for | Maximum Agents for | Maximum Agents for
per PG 2000 Agent 4000 Agent 12000 Agent 24000 Agent
Reference Design | Reference Design1 Reference Design | Reference Design

15 2000 2000 4000 12000 16000

20 1500 1500 3000 9000 12000

30 1000 1000 2000 6000 8000

40 750 750 1500 4500 6000

50 600 600 1200 3600 4800

! You cannot have more than 4000 Agents on a Rogger deployment.

Unified CCE supports a maximum of 50 unique skill groups across all agents on a supervisor’s team, including
the supervisor’s own skill groups. If this number is exceeded, all skill groups that are monitored by the
supervisor still appear on the supervisor desktop. However, exceeding this number can cause performance
issues and is not supported.

)

Note

the precision queue.

Each precision queue that you configure creates a skill group for each Agent PG and counts toward the
supported number of skill groups per PG. The skill groups are created in the same Media Routing Domain as

Initial Setup

When you configure precision queues associated with a large number of agents, the system avoids potential
overload conditions by updating the agent associations as system resources allow. Updates may take a few
minutes. If you submit multiple configuration updates, the system has a threshold of five concurrent
configuration updates, and will reject any updates that exceed the threshold.

Add Attributes

Step 1
Step 2
Step 3

Procedure

Navigate to Unified CCE Administration > Organization > Skills> Attributes.
In the List of Attributes window, click New.
Complete the following fields on the General tab:

Field

Required

Description

Name

yes

Type a unique attribute name. For example, to create
an attribute for mortgage insurance, type mortgage.
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Field Required Description

Description no Enter a maximum of 255 characters to describe the
attribute.

Type no Select the type: Boolean or Proficiency.

Default no Select the default (True or False for Boolean, or a
number from 1 to 10 for Proficiency).

Step 4 Click Save.

Search for Agents
The Search field in the Agents tool offers an advanced and flexible search.
Click the + icon at the far right of the Sear ch field to open a popup window, where you can:
* Select to search for agents only, supervisors only, or both.
* Enter a username, agent ID, first or last name, or description to search for that string.
* Enter one or more site names separated by spaces. (Site is an OR search.)

* Enter one or more peripheral set names separated by spaces (Peripheral Set is an OR search). The search
is case-insensitive and does not support partial matches.

\ )

Note Search by department is available only when departments are configured.

Assign Attributes to Agents

Procedure

Step 1 With the selected agent displayed, click the Attributes tab.
Step 2 Complete the Attributestab:

This tab shows the attributes associated with this agent and their current values.
Click Add to open a popup list of all attributes, showing the name and current default value for each.

a) Click the attributes you want to add for this agent.
b) Set the attribute value as appropriate for this agent.
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Add Precision Queue

Procedure

Step 1 Navigate to Unified CCE Administration > Organization > Skills> Precision Queues.

This opens a List of Precision Queues window showing all precision queues that are currently configured.

Step 2 Click New to open the New Precision Queue window. Complete the fields.
Name Required Description
Description no Enter up to 255 characters to

describe the precision queue.

Media Routing Domain no MRDs organize how requests for
media are routed. The system routes
calls to skill groups or precision
queues that are associated with a
particular communication medium;
for example, voice or email. This
field defaults to Cisco_\oice.
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Required

Description

ServiceLevel Type

yes

Select the service level type used
for reporting on your service level
agreement.

Service level type indicates how
calls that are abandoned before the
service level threshold affect the
service level calculation.

* Ignore Abandoned Calls(the
default): Select this option if
you want to exclude
abandoned calls from the
service level calculation.

Abandoned Calls have
Negative Impact: Select this
option if you want only those
calls that are answered within
the service level threshold
time to be counted as treated
calls. The service level is
negatively affected by calls
that abandon within the
service level threshold time.

Abandoned Calls have
Positive Impact: Select this
option if you consider a call
that is abandoned within the
service level threshold time as
a treated call. With this
configuration, abandoned calls
have a positive impact on the
service level.

Service Level Threshold

yes

Enter the time in seconds that calls

are to be answered based on your

service level agreement, from 0 to
2,147,483,647.

The time that you enter in this field
is used to report on service level
agreements and does not affect how
long a call remains in a precision
queue. The length of time a call
remains in a step is determined by
the wait time for each individual
step.
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Step 3

Step 4

Add Precision Queue .

Required

Description

Agent Order

yes

Select an option to determine which
agents receive calls from this
queue.

The ordering of agents does not

dictate the agents who are selected
into a Precision Queue step. Agents
are included or excluded based on
the conditions specified for the step.

* Longest Available Agent (the
default): The default method
of agent ordering for a
precision queue. The call is
delivered to the agent who has
been in the available (or
ready) state the longest.

Most Skilled Agent: The call
is delivered to the agent who
has the highest competency
sum from all the attributes
pertinent to the Precision
Queue step. In an agent-rich
environment, this can mean
that more competent agents
would be utilized more than
less competent agents.

Least Skilled Agent: The call
is delivered to the agent who
has the lowest competency
sum from all the attributes
pertinent to the Precision
Queue step.

Bucket Intervals

no

Select the bucket interval whose
bounds are to be used to measure
the time slot in which calls are
answered.

The field defaults to the system
default.

To select a different bucket
interval:

Click the numbered Step Builder link (Step 1, Step 2, and so on) to build a precision queue step in the Step

Builder popup window.

When you have finished adding, click Save.
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Consider If Formula for Precision Queue

If you are not on the last step of the precision queue, then you can enter a Consider If formula for that step.
A Consider If formula evaluates a call (within a step) against additional criteria. Each time a call reaches a
step with a Consider If expression, the expression is evaluated. If the value for the expression returns as true,
the call is considered for the step. If the value returns as false, the call moves to the next step. If no expression
is provided for a step, the step is always considered for calls.

To add a Consider If formula, type the formula into the Consider If box. Alternatively, you can use the Script
Editor to build the formula and then copy and paste it into the Consider If box. Objects used in Consider If
formulas are case-sensitive. All Consider If formulas that you add to a precision queue must be valid. If you
add an invalid formula, you cannot save the precision queue. To ensure that the formula is valid, use Script
Editor to build and validate the formula.

Only the following scripting objects are valid in a Consider If formula:

* Call

«PQ

» Skillgroup
* ECC

* PQ Step

* Call Type

* Custom Functions (You can create custom functions in Script Editor.)

It is possible that a valid Consider If formula can become invalid. For example, if you delete an object used
in the formula after you create or update the precision queue, the formula is no longer valid.

Consider If Formula Examples

» PQ.PQ1.LoggedOn > 1--Evaluates whether there is more than one agent logged in to this queue.

« CallType.CallTypel.CallsRoutedToday > 100--Evaluates whether more than 100 calls of this call type
were routed today.

» PQStep.PQ1.1.Router AgentsL oggedl n > 1--Evaluates whether there is more than one router agent
logged in to this queue for Step 1.

» CustomFunction(Call.PeripheralVariablel) > 10--Evaluates whether this formula using a custom
function returns a value greater than 10.

Build Precision Queue Steps

Every precision queue must have a step, and every step must have an Expression. An Expression is a collection
of attribute terms.

Procedure

Step 1 Click the numbered step link in the Steps panel (Step 1, Step 2, and so on).
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Step 2

Step 3

Step 4

Step 5

Step 6
Step 7
Step 8

Build Precision Queue Steps .

The step number popup window opens.

Build the first step as follows.

a)
b)
c)

d)

Click the magnifying glassicon to the right of the Select Attribute field in the Expression 1 panel.
Select an attribute from the list.

Use the two Select fields to establish the terms of the attribute. Click the first Select field to choose an
operator.

* For Boolean attributes, choices are the operators for Equal and Not Equal.

* For Proficiency attributes, choices are the operators for True, False, Less Than, Less Than or Equal
To, Greater Than, and Greater Than or Equal To.

Click the second Select field to choose a value.

* For Boolean attributes, values are True and False.

* For Proficiency attributes, values are numbers from 1 to 10.

Your selection creates an attribute term for the Expression.

To add a second attribute to the first Expression, click Add Attribute in the Expression 1 row.

a)
b)

Select AND or OR to establish the relationship between the first and second attributes.
Repeat steps 2b, 2¢, and 2d.

Continue to add attributes to Expression 1.

All attributes within an expression must be joined by the same logical operator. They must all be ANDs, or
they must all be ORs.

To add a second Expression, click the Add Attribute drop-down in the Expression 1 row and select Add
Expression.

Select AND or OR to establish the relationship between the first and second Expressions.

Add attributes to Expression 2.

Continue to add Expressions as needed.

Step 1

Caonsider If
Wait for - 0 seconds
Expression 1 Add Attribute -
Spanish Q E |Z| g |Z| x
AND =] ServersyZ Q| os= EE B
Expression 2 OR |Z| Add Attribute -
MewEngland o == |Z| True |Z| x
OR E Boston Q| == |Z| True |Z| =

m Cance‘

302765
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In this example, a Spanish caller located in the Boston area needs an onsite visit from a technician to repair

his ServerXYZ. An ideal agent should be fluent in Spanish and have the highest proficiency in ServerXYZ.

This can be seen in Expression 1. Expression 2 allows us to specify that the selected agent must also be from
either Boston or the New England area.

Step 9 When you have completed the step, click OK to add it to the precision queue.
Step 10 To build the next step, click Add Step.

Each successive step is prepopulated with the Expressions and attributes of its predecessor. Decrease the
attribute qualifications and competencies in successive steps to lower the bar such that the pool of acceptable
agents increases.

Step 11 When you have created all steps, you can open any step except the last and enter values in the Consider if
and Wait for fields.

» Consider if is a formula that evaluates a call within a step against additional criteria. (See Consider If
Formula for Precision Queue, on page 126 for more information about Consider If.)

* Wait for is a value in seconds to wait for an available agent. A call will queue at a particular step and
wait for an available agent matching that step criteria until the number of seconds specified. A blank
wait time indicates that the call will proceed immediately to the next step if no available agents match
the step criteria. Wait time defaults to 0 and can take a value up to 2147483647.

Configure a Static Precision Queue

Procedure
Step 1 In the Precision Queue Properties dialog box, select the Statically option.
Step 2 From the list, select a precision queue to which to route all calls that enter this node.

Step 3 In the Priority selection box, select the initial queuing priority for calls processed through this node. You
can select from 1 - 10. The default is 5.

Step 4 Check the Enabletarget requery check box to enable the requery feature for calls processed through this
node.

Step 5 To edit a precision queue, select a precision queue from the list, and then click Edit Precision Queue.

Configure a Dynamic Precision Queue

Procedure
Step 1 In the Precision Queue Properties dialog box, select the Dynamically option.
Step 2 In the Priority selection section, select the initial queuing priority for calls processed through this node. You

can select from 1 - 10. The default is 5.
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Step 3 Check the Enable target requery check box to enable the requery feature for calls processed through this
node.

Step 4 Select a queue option:

* To dynamically route calls that enter this node to a precision queue name, select the Precision Queue
Name option.

* To dynamically route calls that enter this node to a precision queue 1D, select the Precision Queue |D
option.

Step 5 Click Formula Editor to create a formula that determines the precision queue name or ID to which to route
calls.
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Post Call Survey

* Post Call Survey, on page 131

* Configure Post Call Survey (not used), on page 132
* Configure Post Call Survey in CVP, on page 132

* Configure Unified CCE, on page 133

Post Call Survey

A Post Call Survey takes place after normal call treatment. Typically, you use the survey to determine whether
a customer was satisfied with the call experience. You configure a call flow that sends the call to a DNIS for
the Post Call Survey after the agent disconnects from the caller.

Your VRU asks callers whether they want to participate in a Post Call Survey. If they choose to do so, they
are automatically transferred to the Post Call Survey after the normal call flow completes.

Post Call Survey Use Case

The caller is typically asked if they want to participate in a survey after the call. Your solution can determine
based on dialed numbers to invoke the post call survey at the end of a call. When the customer completes the
conversation with an agent, the customer is automatically redirected to a survey. The hang-up event from the
last agent in the call triggers the post call survey.

A customer can use the keypad on a touch tone phone and voice with ASR/TTS to respond to questions asked
during the survey. For the solution, the post call survey call is just like another regular call. The post call
survey retrieves the call context information from the original customer call.

Post Call Survey Design Impacts

Observe the following conditions when designing a Post Call Survey:

* A Post Call Survey triggers at the hang-up event from the last agent. When the agent hangs up, the call
routing script launches a survey script.

* The mapping of a dialed number pattern to a Post Call Survey number enables the Post Call Survey
feature for the call.

* The value of the expanded call variable user.microapp.isPostCallSurvey controls whether the call
transfers to the Post Call Survey number.
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* If user.microapp.isPostCallSurvey is set to y (the implied default), the call transfers to the mapped
post call survey number.

« If user.microapp.isPostCallSurvey is set to n, the call ends.
* To route all calls in the dialed number pattern to the survey, your script does not have to set the
user.microapp.isPostCallSurvey variable. The variable is set to y by default.
* You cannot have a REFER call flow with Post Call Survey. REFER call flows remove Unified CVP

from the call. But, Post Call Survey needs Unified CVP because the agent has already disconnected.

* For Unified CCE reporting purposes, the Post Call Survey call inherits the call context for the initial call.
When a survey starts, the call context of the customer call that was transferred to the agent replicates
into the call context of the Post Call Survey call.

* The expanded call variable isPostCall Survey will be cached only when the UCCE router generates a
label for CVP.

Configure Post Call Survey (not used)

Configure Post Call Survey in CVP

Complete the following procedure to configure Post Call Survey in Unified CVP.

Procedure

Step 1 Log in to the Unified CVP Operations Console and choose System > Dialed Number Pattern.

Step 2 Enter the following configuration settings to associate incoming dialed numbers with survey numbers:
« Dialed Number Pattern - Enter the appropriate dialed number.

The incoming Dialed Number for calls being directed to a Post Call Survey Dialed. This is the Dialed
Number you want to redirect to the survey.

» Enable Post Call Survey for Incoming Calls - Select to enable post call survey for incoming calls.

» Survey Dialed Number Pattern - Enter the dialed number of the Post Call Survey. This is the dialed
number to which the calls should be transferred to after the normal call flow completes.

* Click Saveto save the Dialed Number Pattern.

Step 3 Click Deploy to deploy the configuration to all Unified CVP Call Server devices.
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Configure Unified CCE

Configure ECC Variable

Step 1

Step 2
Step 3
Step 4

You need not configure Unified CCE to use Post Call Survey, however, you can turn the feature off (and then
on again) within an ICM script by using the ECC variable user.microapp.isPostCallSurvey and a value of
n or y (value is case insensitive) to disable and re-enable the feature.

Configure the ECC variable to a value of n or y before the label node or before the Queue to Skillgroup node.
This sends the correct value to Unified CVP before the agent transfer. This ECC variable is not needed to
initiate a Post Call Survey call, but you can use it to control the feature when the Post Call Survey is configured
using the Operations Console.

When the DN is mapped in the Operations Console for Post Call Survey, the call automatically transfers to
the configured Post Call Survey DN.

Complete the following procedure to enable or disable the Post Call Survey:

Procedure

On the Unified CCE Administration Workstation, using configuration manager, select the Expanded Call
Variable List tool.

Create a new ECC Variable with Name: user.microapp.isPostCallSurvey.
Set Maximum Length to 1.
Select the Enabled check box then click Save.
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Task Routing

* Task Routing, on page 135

* Task Routing API Request Flows, on page 144
* Failover and Failure Recovery, on page 151

» Task Routing Setup, on page 154

» Sample Code for Task Routing, on page 165

« Task Routing Reporting, on page 166

Task Routing

Task Routing describes the system's ability to route requests from different media channels to any agents in
a contact center.

You can configure agents to handle a combination of voice calls, emails, chats, and so on. For example, you
can configure an agent as a member of skill groups or precision queues in three different Media Routing
Domains (MRD) if the agent handles voice, e-mail, and chat. You can design routing scripts to send requests
to these agents based on business rules, regardless of the media. Agents signed into multiple MRDs may
switch media on a task-by-task basis.

Enterprise Chat and Email provides universal queue out of the box. Third-party multichannel applications
can use the universal queue by integrating with CCE through the Task Routing APIs.

Task Routing APIs provide a standard way to request, queue, route, and handle third-party multichannel tasks
in CCE.

Contact Center customers or partners can develop applications using SocialMiner and Finesse APIs in order
to use Task Routing. The SocialMiner Task API enables applications to submit nonvoice task requests to
CCE. The Finesse APIs enable agents to sign into different types of media and handle the tasks. Agents sign
into and manage their state in each media independently.

Cisco partners can use the sample code available on Cisco DevNet as a guide for building these applications
(https://developer.cisco.com/site/task-routing/).
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Figure 18: Task Routing for Third-party Multichannel Applications Solution Components
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SocialMiner and Task Routing
Third-party multichannel applications use SocialMiner'sTask API to submit nonvoice tasks to CCE.

The API works in conjunction with SocialMiner task feeds, campaigns, and notifications to pass task requests
to the contact center for routing.

The Task API supports the use of Call variables and ECC variables for task requests. Use these variables to
send customer-specific information with the request, including attributes of the media such as the chat room
URL or the email handle.

)

Note CCE solutions support only the Latin 1 character set for Expanded Call Context variables and Call variables
when used with Finesse and SocialMiner. Arrays are not supported.

CCE and Task Routing
CCE provides the following functionality as part of Task Routing:

* Processes the task request.

* Provides estimated wait time for the task request.

* Notifies SocialMiner when an agent has been selected.

* Routes the task request to an agent, using either skill group or precision queue based routing.

* Reports on contact center activity across media.
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Finesse and Task Routing

Finesse provides Task Routing functionality via the Media API and Dialog APIL.

With the Media API, agents using third-party multichannel applications can:

Sign into different MRDs.

Change state in different MRDs.

With the Dialog API, agents using third-party multichannel applications can handle tasks from different
MRDs.

Task Routing Deployment Requirements

Task Routing for third-party multichannel applications deployment requirements:

Finesse and SocialMiner are required. Install and configure Finesse and SocialMiner before configuring
the system for Task Routing.

See the Finesse documentation at https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/
tsd-products-support-series-home.html.

See the SocialMiner documentation at https://www.cisco.com/c/en/us/support/customer-collaboration/
socialminer/tsd-products-support-series-home.html.

By default, access to the Social Miner administration user interface is restricted. Administrator can
provide access by unblocking the IP addresses of the clients. For more details, see the Control Social
Miner Application Access topic in the Cisco Social Miner Installation and Upgrade Guide guide at
https://www.cisco.com/c/en/us/support/customer-collaboration/socialminer/
products-installation-guides-list.html.

You can install only one SocialMiner machine in the deployment.

SocialMiner must be geographically colocated with one side of the Media Routing Peripheral Gateway
(MR PG).

SocialMiner must be geographically colocated with one side of the Media Routing Peripheral Gateway
(MR PG).

Install SocialMiner in a location from which CCE, Finesse, and the third-party multichannel SocialMiner
Task Routing application can access it over the network.

If you install SocialMiner in the DMZ, open a port for CCE and Finesse to connect to it. The default port
for CCE to connect to SocialMiner is port 38001. Finesse connects to SocialMiner over HTTPS, port
443.

Install the third-party multichannel application locally with SocialMiner, or open a port on the SocialMiner
server for the application to connect to it.

Supported Functionality for Third-Party Multichannel Tasks

Blind transfer is supported for third-party multichannel tasks submitted through the Task Routing APIs.

We do not support the following functionality for these types of tasks:

Agent-initiated tasks.
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* Direct transfer.

* Consult and conference.

Plan Task Routing Media Routing Domains

Media Routing Domains (MRDs) organize how requests for each communication medium, such as voice and
email, are routed to agents. You configure an MRD for each media channel in your deployment.

Finesse agents can sign in to any of the multichannel MRDs you create for Task Routing.
Important factors to consider when planning your MRDs include the following:

* Whether the MRD is interactive.

* The maximum number of concurrent tasks that an agent can handle in an MRD.

* Whether the MRDs are interruptible.

* For interruptible MRDs, whether Finesse accepts or ignores interrupt events.

To configure the settings and parameters described in the following sections, see the following documents:

« Cisco SocialMiner Developer Guide at https://developer.cisco.com/site/socialminer/documentation/
« Cisco Finesse Web Services Developer Guide at https://developer.cisco.com/site/finesse/documents/

* Unified CCE Administration, Unified CCE Configuration Manager, and Unified CCDM Portal
Configuration, on page 162

* Unified CCE Administration and Configuration Manager Tools, on page 160

Interactive and Non-interactive MRDs

Interactive tasks are tasks in which an agent and customer communicate in real time with each other, such as
chats and SMS messages. The customer usually engages with the agent through an application, like a chat
window, and leaves this application open while waiting to be connected to an agent. Non-interactive tasks
are asynchronous, such as email. The customer submits the request and then may close the application, checking
later for a response from an agent.

API Parameter or Setting API/Tool Possible Values
Interactive Task/MRD | Non-interactive
Task/MRD
requeueOnRecovery SocialMiner Task False - customers are | True- customers are not
Submission API waiting at an interface | waiting at an interface

Whether SocialMiner re-queues

or discards the task when

SocialMiner recovers from a

failure.

Set this parameter when
submitting a task request.

for an agent and can be
notified if there is a
problem. You don't need
to resubmit these tasks.

for an agent, and there is
no way to alert them that
there was a problem.
You need to resubmit
these tasks.
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You can monitor status of
submitted and queued tasks
using either the SocialMiner
Task API to poll for status or
SocialMiner XMPP BOSH
eventing.

to monitor the status of
a single contact/task.

API Parameter or Setting API/Tool Possible Values
Interactive Task/MRD | Non-interactive
Task/MRD
dialogL ogoutAction Finesse Media Sign In | Close- customers are Transfer - customers are
Whether active tasks are closed API engaged with an agent, [notengaged w1th an
or transferred when an agent and can be notified that |agent, and there is no
Sions out or [0ses presence the task has ended. way to alert them that
£ p ' the task has ended.
Set this parameter when an
agent signs in to a Media
Routing Domain.
Start Timeout Media Routing Shorter duration - Longer duration -
The amount of time that the Domalns tool in f:ustomer 1s waiting at an customer 18 not waiting
. Unified CCE interface for the agent | at an interface for an
system waits for an agent to Administration acent
accept an offered task. When &
this time is reached, the system
makes the agent not routable and
re-queues the task.
Set this parameter when
configuring an MRD.
Monitoring status of SocialMiner Task API | Use SocialMiner Task | Use SocialMiner XMPP
submitted tasks or XMPP BOSH API status polling for | BOSH eventing to
eventing MRDs when you want | receive updates on all

contacts/tasks in the
campaign supporting
Universal Queue over
one channel.

Maximum Concurrent Tasks Per Agent

Specify the maximum number of concurrent tasks for an agent in an MRD when an agent signs into the Finesse
application, using the maxDialogL imit parameter in the Finesse Media - Sign In API.

See the Solution Design Guide for Cisco Unified Contact Center Enterprise at https://www.cisco.com/c/en/
us/support/customer-collaboration/unified-contact-center-enterprise/
products-implementation-design-guides-list.html for the maximum number of tasks supported within an MRD
and across MRDs for a single agent.

See the Solution Design Guide for Cisco Hosted Collaboration Solution for Contact Center at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/
products-implementation-design-guides-list.html for the maximum number of tasks supported within an MRD
and across MRDs for a single agent.

For agents handling interactive tasks, consider how many concurrent tasks an agent can handle reasonably.
How many simultaneous chat sessions, for example, can an agent handle and provide good customer care? If
you are using precision queue routing, keep in mind that CCE assigns tasks to agents who match attributes
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for step one, up to their task limit, until all of those agents are busy. CCE then assigns tasks to agents who
match attributes for step two, up to their task limit, and so on.

Interruptible and Non-Interruptible MRDs

When you create an MRD in the Unified CCE Administration Media Routing Domains tool, you select whether
the MRD is interruptible.

* Interruptible: Agents handling tasks in the MRD can be interrupted by tasks from other MRDs.
Non-interactive MRDs, such as an email MRD, are typically interruptible.

 Non-interruptible: Agents handling tasks in the MRD cannot be interrupted by tasks from other MRDs.
The agents can be assigned tasks in the same MRD, up to their maximum task limits. For example, an
agent can handle up to three non-interruptible chat tasks; if the agent is currently handling two chat tasks,
CCE can assign the agent another chat, but cannot interrupt the agent with a voice call. Interactive MRDs,
such as a chat MRD, are typically non-interruptible. Voice is non-interruptible.

When an agent is working on a non-interruptible task, CCE does not assign a task in any other MRD to the
agent. Any application handling the non-voice MRDs must follow the same rule. In certain cases, it is possible
that a task from another media routing domain gets assigned to an agent who is working on a non-interruptible
task in an MRD.

For example, if an agent is working on a non-interruptible chat MRD and makes an outbound call (internal
or external) using the desktop or phone, CCE cannot prevent the agent from making that call. Instead, the
system handles this situation differently. CCE marks the agent temp not routable across all media domains
until the agent has completed all non-interruptible tasks the agent is currently working on. Because of this
designation, the agent is not assigned any new tasks from any MRDs until finishing all current tasks. Even if
the agent tries to go ready or routable, the agent's temp not routable status is cleared only after all tasks are
complete.

)

Note
agent logs out and then logs back in on that MRD.

If you change the MRD from interruptible to non-interruptible or vice versa, the change takes effect once the

Accept and Ignore Interrupts

Specify whether an MRD accepts or ignores interrupt events when an agent signs into the Finesse application,
using the interruptAction parameter in the Finesse Media - Sign In API. This setting controls the agent's
state in an interrupted MRD and ability to work on interrupted tasks. The setting applies only when a task
from a non-interruptible MRD interrupts the agent.

» Accept: When an agent is interrupted by a task from a non-interruptible MRD while working on a task
in an interruptible MRD, Finesse accepts the interrupt event.

The agent, CCE task, and Finesse dialog state in the interrupted MRD change to INTERRUPTED.

The agent cannot perform dialog actions while a task is interrupted.

|

Important  The application is responsible for disabling all dialog-related activities in the
interface when an agent's state changes to INTERRUPTED.

The agent's time on task stops while the agent is interrupted.
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Example: An agent has an email task for 20 minutes, and is interrupted for 3 of those minutes with a chat
task. The handled time for the email task is 17 minutes, and the handled time for the chat task is 3 minutes.

_ eMail handled time =17 mins )
eMail Offered eMail Handled

12 mins | 5 mins

0. T, T T

‘ Chat handled time =
3 minsg

393250

Chat Offered Chat Handled

* Ignore: When an agent is interrupted by another task while working on a task in an interruptible MRD,
Finesse ignores the interrupt event.

The new task does not affect any of the agent's other assigned tasks. The agent, CCE task, and Finesse
dialog state in the interrupted MRDs do not change.

The agent can perform dialog actions on original task and the interrupting task at the same time. The
agent's time on the original task does not stop while the agent is handling the interrupting task.

Example: An agent has an email task for 20 minutes, and is interrupted for 3 of those minutes with a chat
task. The handled time for the email task is 20 minutes, and the handled time for the chat task is 3 minutes.
This means that during a 20-minute interval, the agent handled tasks for 23 minutes.

eMail Oﬁered eMail Handled

eMail handled time = 20 mins

CEECEECEED

‘ Chat handled time =
3 mins

BIRH

Chat Offered Chat Handled

If an agent is working on a task in an interruptible MRD and is routed a task in another interruptible MRD,
CCE does not send an interrupt event. Therefore, interruptAction setting does not apply.

Plan Dialed Numbers

Dialed numbers, also called script selectors, are the strings or numbers submitted with Task Routing task
requests through SocialMiner. Each dialed number is associated with a call type, and determines which routing
script CCE uses to route the request to an agent.

Dialed numbers are media-specific; you associate each one with a Media Routing Domain.

For Task Routing, plan which dialed numbers the custom SocialMiner application will use when submitting
new task requests. Consider whether you will use the same dialed numbers for transfer and tasks that are
requeued on RONA, or if you need more dialed numbers.
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|

Important  You must associate each Task Routing dialed number with a call type. The default call type is not supported
for Task Routing.

Skill Group and Precision Queue Routing for Nonvoice Tasks

Routing to skill groups and precision queues is largely the same for voice calls and nonvoice tasks. However,
the way that contact center enterprise distributes tasks has the following implications for agents who can
handle multiple concurrent tasks:

* Precision queues—In precision queue routing, Unified CCE assigns tasks to agents in order of the
precision queue steps. Unified CCE assigns tasks to agents who match the attributes for step one, up to
their task limit, until all those agents are busy. Unified CCE then assigns tasks to agents who match
attributes for step two, and so on. If you configure agents to handle three concurrent tasks, Unified CCE
assigns three tasks to each agent in the first step. It then moves on to the second step and assigns any
remaining tasks to those agents.

« Overflow skill groups—Routing scripts can specify a preferred skill group and an overflow skill group.
Unified CCE assigns tasks to all agents in the preferred skill group, up to their task limit, before assigning
any tasks in the overflow skill group. If you configure agents to handle three concurrent tasks, Unified
CCE assigns three tasks to each agent in the preferred skill group. It then moves on to the overflow skill
group and assigns any remaining tasks to those agents.

)

Note The number of available slots is an important factor in the Longest Available
Agent (LAA) calculation.

The number of available slots = The maximum concurrent task limit for the MRD
that an Agent has logged into - Current tasks being handled by the Agent or routed
to the Agent.

If there are multiple skill groups that are part of the queue node, then the skill
group that has the higher LAA is picked. Then, the agents within the picked skill
group (or the Precision Queue) who have the highest number of available slots
for non-voice tasks get prioritised.

Agents with the same number of available slots get prioritized based on the time
in the available state or the LAA mechanism.

Agent State and Agent Mode

An agent's state and routable mode in an MRD work together to determine whether CCE routes tasks to the
agent in that MRD.

Agent Routable Mode

The agent's routable mode controls whether CCE can assign the agent tasks in that MRD. If the agent is
routable, CCE can assign tasks to the agent. If the agent is not routable, CCE cannot assign tasks to the agent.
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The agent changes to routable/not routable through Finesse Media - Change Agent to Routable/Not Routable
API calls.

Agent State

The agent's state in an MRD indicates the agent's current status and whether the agent is available to handle
a task:

* Ready: The agent is available to handle a task.

* Reserved/Active/Paused/Work Ready/Interrupted: The agent is available to handle a task if the agent
has not reached their maximum task limit in the MRD.

» Not Ready: The agent is not available to handle a task.
The agent changes to Ready and Not Ready through calls to the Finesse Media - Change Agent State API.

The agent's state while working on a task depends on the actions the agent performs on the Finesse dialog
related to the task, through calls to the Finesse Dialog - Take Action on Participant API.

How Mode and State Work Together to Determine if an Agent Receives Tasks
CCE will route an agent a task in the MRD if ALL of the following are true:

* The agent's mode is routable, and

* The agent is in any state other than NOT READY, and

* The agent has not reached the maximum task limit in the MRD, and

* The agent is not working on a task in a different and non-interruptible MRD.

CCE will NOT route an agent a task in the MRD if ANY of the following are true:

* The agent's mode is not routable, or
* The agent is NOT_READY, or
* The agent has reached the maximum task limit in the MRD, or

* The agent is working on a task in a different and non-interruptible MRD.

Why Change the Agent's Mode to Not Routable?

By changing the agent's mode to not routable, you stop sending tasks to the agent without changing the agent's
state to Not Ready. You may want to make an agent not routable if the agent is close to ending the shift, and
needs to complete in progress tasks before signing out.

If an agent changes to Not Ready state while still working on tasks, CCE reports show those tasks as ended;
time spent working on the tasks after going Not Ready is not counted. By making the agent not routable
instead of Not Ready, the agent's time on task continues to be counted.

In RONA situations, in which agents do not accept tasks within the Start Timeout threshold for the MRD,
Finesse automatically makes agents not routable. Finesse resubmits the tasks through for routing through
SocialMiner. The application must make the agent routable in order for the agent to receive tasks again.
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SocialMiner and Finesse Task States

In most cases, SocialMiner social contact states do not map directly to Finesse dialog states. For SocialMiner,
social contacts are created when the customer submits a task request. For Finesse, the dialog with which the
agent engages with the customer is created when the task is routed to the agent.

This table shows the relationships between SocialMiner social contact task states and Finesse dialog states.

SocialMiner Social Contact Task State Finesse Dialog State

Unread: The task request has not been submitted to | None
the contact center.

Queued: The task request is successfully submitted | None
to the contact center as a result of creating a new task
or resubmitting a task due to agent transfer, automatic
transfer on agent logout, or automatic transfer for
RONA.

Reserved: The task is assigned to an agent. This state | Offered: The dialog is being offered to the agent.
includes all work on a task.

Accepted: The agent accepted the dialog but has not
started working on it.

Active: The agent is working on the dialog.

Paused: The agent paused the dialog.

Wrapping Up: The agent is performing wrap up
activity on the dialog.

Interrupted: The agent is interrupted with a task from
anon-interruptible Media Routing Domain. The agent
cannot work on this task until the interrupting task is
complete.

Handled: SocialMiner receives a handled notification | Closed: The agent ended the task. Finesse sends a
from Finesse indicating that the task ended. handled notification to SocialMiner.

Task Routing APl Request Flows

Task Routing APl Basic Task Flow

This topic provides the SocialMiner and Finesse API calls and events when an active email task is interrupted
by a chat request.

In this scenario, the email MRD is interruptible. When the agent signs into the email MRD, the application
uses the Finesse Media API to accept interrupts. The chat MRD is non-interruptible.

1. The email application submits a new email task request to CCE, and polls for status and Estimated Wait
Time (EWT).
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| &

Task API: create

Task: queuved

|
Task APL: poll: returns status: queued »

& Task: EWT updated

Task APL: poll: returns EWT

2. An agent signs in to the email MRD and changes state to Ready.

MRD{email): login

B

Medialemail) API: login(acceptinterrupts)

MRD{email} event: not_ready

.

Medialemail) event: not_ready

Media(email) API: ready

MRD{email): ready

MRD{email) event: ready

Media(email) event: ready

B E

3. CCE assigns the agent the email task. The Call and ECC variables used to create the task are included in
the dialog's media properties, and contain information such as the handle to the email. The variables can be
used to reply to the email. The agent starts work on the email dialog in Finesse.
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Task routad 1 agen

MADema) event msms:lh Madiajamail) avant: resarvad

Task: routed Task{amail): routad

F

Y

Task APL poll: relums status: resanvad Dialog{email) evant offerad

Déalog{email) APL accept

Taskdamail): accapt

Task jarmail] even: accaplad

Dialoo{emall) event: accaplad

¥

Taskjemal:star L Déalogiemail) APL: stan

 MRD{emal] avert: acive
»  Madialemall) avant active

Taskjarmal) evant started

Dialog{email) event active

e | e |

4. The chat application submits a new chat request, and polls for status and EWT. The same agent logs into
the chat MRD.

Tasc APLcraate  Madiajchal) APL:login
Task: quauad .|, MRDicha): login

Task API: polll: redums slakis: quaed

™ Task:EWTupdated  MRDichal] event not_ready

Madialchal) event nod_ready oy

-

C I

5. The agent changes state to Ready in the chat MRD. CCE assigns the chat task to the agent. The Call and
ECC variables used to create the task are included in the dialog's media properties, and contain information
such as the chat room URL. The variables can be used to join the chat room with the customer. The agent
starts the chat dialog in Finesse. The Email dialog is interrupted.

Task APL poll: retlums EWT

h 4
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Madia APl{chat): ready

_ MRD{chat): ready

MAD(chal} ovenk Bady | ) pociaichaly ovent: ready

Task routed 1o agant

Madialchat) avant: rasansad

MF Dichat) svant: maarved

Y

Task: rouled Taskichat): routed

r

Task APL poll: retums stalus: rasenved |

=

Dialogichat) event: oflered
Cralog{chal] APL accept

Y

Taskfchal):accepl [*

-

Task{chat) avent: acceptad
! pu‘ Déalog{chal) event: acceplad

Taskchail: stanl Dialogichal) APL: star

MRD{chal) aven: active

y

Madajchal) avent: acive

Y

Task{chal) avan: stariad

Dialogichat) evant: active

MAD{enal) evert inf emupted

Madialamail) avent: ntarmupled

R B ) N e

6. The agent completes work on the chat dialog and closes the dialog. Finesse sends a handled event to
SocialMiner for the chat task. The application is responsible for closing the chat room. The agent is not
handling other non-interruptible dialogs, and the email dialog becomes active.

Cialoglchai) APL dosa

Task{chai): and o3

B

MRD{chat ) event: ready

Mada|chai) avant: ready

Taskjchal) event: ended >
AAcTal vnt o Disiogichat) event: ciosed

-

Y

Taskichal): handled

o

Task APL poll: relums staius: handed

MRD{amail) event: acive

e
F

> Mada|amal) event: aclive

7. The agent continues working on the email dialog, including pausing, resuming, and wrapping up the dialog.
The agent closes the dialog. Finesse sends a handle event to SocialMiner for the email task. The application
is responsible for sending the email reply to the customer.
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Dialog{emal) APl pausa

Task{omail): pausa -

“MRDfermail) vt paused

Madia{emal) eveni: pausad

Y

Taskfamail) avant: pausad
»  Dialogiemall] evant pausad

Dialog{amail) API: resume

= Task{amail): rasuma |

MRD{amal) avant: achw_

Madia{amal) avent: active

Task fprmail) avant: active
» Dialogiemall) event: active

Y

Cialogiemail) AP: w
Task{amail}: wrap_up o ) i

MRD jamail) event: wodk_ready
»  Madiamall) event: wiap_up

h 4

Task{amall] svent wap_up
»  Dialog{amsal) avant wiap_up

Dialog{emal) AP dose

" Tagk fmail): and

Task{gmal) mnteﬂd&d‘
Tasi[amail; handled |

Dialogiemail) event: closed

Y

MP: Dy armail) avem: raa:l'."_

MRDy emal) avant: ready

= ) (B [

Task Routing API Agent Transfer Flow

This illustration provides the SocialMiner and Finesse API calls and events when an agent transfers a task.

__'Diaugiarajl] API: fransler: target: newScriptSalector

Task[email): renotify: scrptSelecton: newScrpl Selector

Task: queved with new Scrpt Sedecior Task(emad): end

.
.

Task(emal) evenl: ended

Dislog(emal) event closed

1
]
]
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Task Routing API RONA Flow [

The agent transfers the dialog from the Finesse application, selecting the script selector to which to transfer
the task.

Finesse resubmits the task to SocialMiner, and the task is queued to the script selector as a new task.

Finesse puts the original dialog in the CLOSED state, with the disposition code
CD TASK TRANSFERRED. Finesse does not send a handled notification to SocialMiner.

Task Routing API RONA Flow

This illustration provides the SocialMiner and Finesse API calls and events in a RONA scenario, in which an
agent does not accept an offered task within the Start Timeout threshold for the MRD.

Meddia (email) event: reserved

Task routed fo agent
MR emal) event: resarvad

Y

Taskigmail) event nuked

] Dialogfemal) evert: ofiered
MRD{email) start >
freaut expies

Taskemal) evert: abart Didagfemail) event chesed _

Tasklemail): renotily: scripiSebector: orignalSenpiSal eclor

Tash: queved with ongnal scipl selector

MRAD {email) event: not routatle

Media[emai) svent: not routable

The task is routed to an agent, and the dialog is offered to the agent.
The Media Routing Domain's Start Timeout threshold expires.

CCE instructs Finesse to end the dialog. Finesse puts the dialog in the CLOSED state, with the disposition
code CD_RING_NO_ANSWER. Finesse does not send a handled notification to SocialMiner.

The Finesse server on which the agent was last signed in resubmits the task to SocialMiner with the
original script selector. The task is queued to the script selector as a new task.

CCE instructs Finesse to make the agent not routable in that Media Routing Domain, so that the agent is
not routed more tasks.

Task Routing API Agent Sign Qut with Tasks Flows

The Finesse Media - Sign Out API allows agents to sign out with assigned tasks. The dialogl.ogoutAction
parameter set by the Media - Sign In API determines whether those tasks are closed or transferred when the
agent signs out.
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Close Tasks on Sign Out

This illustration provides the SocialMiner and Finesse API calls and events when agents are set to have
assigned tasks closed on sign out.

Medialemai API: logout

MRDYemnai): logout: dispasiion: ageniLoggedOuDuning Task *

End taskis sart for each acive
fask in iz MRD

Taskjemal): end dsposifion:agentLoggedCuDuringTask | Dialoglemaill event end
dspdsian: agmu.amedmﬂmngmc
Task(email): handied

MRD email event: logout

b

=
-

Medtafemail) event: logout

The agent requests to sign out of the MRD with an active task.

§
3

2. CCE instructs Finesse to end the task. Finesse puts the dialog in CLOSED state, with the disposition code
CD_AGENT LOGGED OUT DURING DIALOG.

3. The agent is signed out of the MRD.

Transfer Tasks on Sign Out

This illustration provides the SocialMiner and Finesse API calls and events when agents are set to have
assigned tasks transferred on sign out.

_ Medialemail) AP logout

_r'uFll}:e.man]:|ag:u1:d|qm1nn:1rms‘nerrejOnﬂ.gmungm

End task is sen for each acive
fask in he MARD

Taskjemail): end: dispasifion: transkerredOn AgertLogaut Dicdagemail) event end
dispasifon: bansteredOndgentLogout

Task(emal): renofly: sciptSelecior: ongnalSeriptSeletion

-
€

Taskjemail) queued with ongingl Scipt selector

MRDesmall) event: bogout

Media(emall) event logout

The agent requests to sign out of the MRD with an active task.

2. CCE instructs Finesse to end the dialog. Finesse puts the dialog in the CLOSED state, with the disposition
code CD_TASK TRANSFERRED ON AGENT LOGOUT. Finesse does not send a handled notification
to SocialMiner.
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3. The Finesse server on which the agent was signed in resubmits the task to SocialMiner with the original
script selector. The task is queued to the script selector as a new task.

4. The agent is signed out of the MRD.

Failover and Failure Recovery

Component

Failover/Failure
Scenario

New Task Request Impact

Queued, Offered, and Active Task Impact

SocialMiner

MR connection
fails. For
example, there is
a networking
problem, the PG
loses connection,
or SocialMiner
loses connection.

Finesse loses
connection with
SocialMiner.

New task requests from
SocialMiner application:
New task requests fail, and
the failures are delivered
back to the application.
Details of these failures are
described in the next
column.

Automatic transfer
request from Finesse (for
transfer on sign out or
RONA): Results in a lost
transfer request.

Agent transfer request:
The request fails, and
Finesse sends an error back
to the application. Finesse
retains the task.

Queued tasks. When tasks are submitted,
they can be set to requeue on recovery.
Typically, non-interactive tasks, such as
email, are set to requeue on recovery
because there is not a way to alert the
customer that there was a problem while
in queue. Interactive tasks, such as chat,
are set not to requeue on recovery because
the customer is waiting at an interface for
an agent, and there is a way to alert the
customer that there is a problem.

If tasks are set to requeue on recovery, the
task is resubmitted when the MR
connection is reestablished. The status and
statusReason of the contact does not
change.

If tasks are set NOT to requeue on
recovery, the task's contact's status is
marked discarded. The task's contact's
statusReason is marked as follows:

SocialMiner failure:

NOTIFICATION CCE SOCIALMINER
SYSTEM_FAILURE

MR connection failure:
NOTIFICATION CCE CONNECTION LOST

Offered and active tasks: No impact.
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connection with
Agent PG or CTI
Server

Component Failover/Failure |New Task Request Impact | Queued, Offered, and Active Task Impact
Scenario
SocialMiner SocialMiner New task requestsfrom | Queued, offered, and active tasks. No
overruns the new | SocialMiner application: |impact.
task queue limit. | New task requests are
See the Cisco discarded with the
SocialMiner statusReason
. NOTIHCATION RATE ILIMITED.
Developer Guide - =
for the limit Automatic or agent
(htips/developarciscocony | transfer requests: No
site/socialminer/ |impact
documentation/).
Finesse Finesse loses New task request from Agents signed into media on the failed

SocialMiner application:
No impact

Automatic transfer
requests from Finesse (for
transfer on logout or
RONA): Automatic
transfers are initiated on the
Finesse server on which the
agent was signed in. Any
outage on that Finesse
server can result in lost
transfer requests.

Agent transfer request:
The request fails because
Finesse is out of service,
and Finesse retains the task.

Finesse server are put into

WORK _NOT_READY state and made
not routable. Tasks on that server are
preserved in their current state, and time
continues to accrue towards the maximum
task lifetime. The agent fails over to the
secondary Finesse server, and must sign
in to the media again. The agent is put into
the previous state. If the agent doesn't have
tasks, the agent is put in NOT_READY
state.

Queued tasks: No impact.

Offered tasks: These tasks RONA
because the agent cannot accept them.

Active tasks: These tasks fail over to the
other Finesse server and are recovered on
that server.

Note Any active tasks that were in
INTERRUPTED state at the
time of the lost connection
change are recovered.
However, these tasks change to
the UNKNOWN state when the
task is no longer
INTERRUPTED. The agent
can only close tasks when they
are in the UNKNOWN state.
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Failover and Failure Recovery .

Component

Failover/Failure
Scenario

New Task Request Impact

Queued, Offered, and Active Task Impact

Finesse

Agent logs out, or
presence is lost
while agent has
active tasks

New task request from
SocialMiner application:
No impact

Automatic or agent
transfer requests: No
impact

Queued tasks: No impact.

Offered tasks: These tasks fail over to the
other Finesse server and are recovered on
that server. If a task's Start Timeout
threshold is exceeded during failover, the
task RONAs.

Active tasks: If an agent logs out with
active tasks, or agent presence is lost with
active tasks, the tasks are either closed or
transferred to the original script selector
depending on how the agent was
configured when signing into the MRD.

If the tasks are transferred, the disposition
code is
CD TASK TRANSFERRED AGENT LOGOUT.

If the tasks are closed, the disposition code
is
CD_AGENT LOGGED OUT DURING
DIALOG.

Finesse
application

Finesse
application fails

New task request from
SocialMiner application:
No impact

Automatic or agent
transfer requests: No
impact

Queued tasks: No impact.

Offered tasks: These tasks may RONA
depending on how the application is
structured. A Task Routing application
may prevent an agent from accepting a
dialog when the application down because
the agent cannot handle the dialog while
the application is down. In this case, the
dialog RONAs.

Activetasks: Varies by application.
Applications are responsible for managing
the tasks while the application is down.
Finesse retains the tasks, and the tasks are
recovered once the application is restored.
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Component Failover/Failure |New Task Request Impact | Queued, Offered, and Active Task Impact
Scenario
CTI Server or | One CTI Server | New task request from Queued tasks: No impact.
OPC or one OPC fails Soc!aJM ner application: Offered tasks: These tasks fail over to the
No impact .
other Finesse server and are recovered on
Automatic transfer that server. If a task's Start Timeout
requests from Finesse (for | threshold is exceeded during failover, the
transfer on logout or task RONAs.
RONA): Results in lost Activetasks: These tasks fail over to the
transfer requests. .
other Finesse server and are recovered on
Agent transfer request: | that server.
The request fails, and . .
Fi tains the task Note Any active tasks that were in
fnesse retains the task. INTERRUPTED state at the
time of the lost connection
change are also recovered.
However, these tasks change to
the UNKNOWN state when the
task is no longer
INTERRUPTED. The agent
only can only close tasks when
they are in the UNKNOWN
state.
OPC Both OPCs fail | New task request from Queued tasks: No impact
SOCI.aIM ner application: Offered and activetasks: These tasks are
No impact
lost
Automatic or agent
transfer requests: Results
in lost transfers.
Task Routing Setup
Initial Setup
Step |Task Notes
Set up CCE
1 Configure Finesse with the AW, so that Finesse can access
SocialMiner connection information.
See Configure Finesse with the AW, on page 156.
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Step |Task Notes
2 Configure a Network VRU and Network VRU scripts.

See Configure Network VRU and Network VRU Scripts, on

page 157.
3 Configure the MR PG and PIM

See Configure the Media Routing PG and PIM, on page 158.

4 Set up the MR PG and PIM for SocialMiner.
See Set up the Media Routing PG and PIM, on page 158.

5 Add SocialMiner as an External Machine in the System The system configures the following
Inventory. settings automatically in SocialMiner
Administration:

See Add SocialMiner as an External Machine, on page 159.
* Enables and configures the CCE
Multichannel Routing settings.

* Configures the Task feed and
the associated campaign and
Connection to CCE notification
needed for the Task Routing
feature.

6 Configure the following in Unified CCE Administration or
Configuration Manager:

* Media Routing Domains

* Call types

* Dialed numbers

» Skill groups or precision queues
» ECC variables

» Agent desk settings

See Unified CCE Administration and Configuration Manager
Tools, on page 160.

See Unified CCE Administration, Unified CCE Configuration
Manager, and Unified CCDM Portal Configuration, on page
162

7 Increase the TCDTimeout registry key value, if you are using
precision queues and will be submitting potentially long
tasks, like email.

See Increase TCDTimeout Value, on page 163.
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. Configure Finesse with the AW

Step |Task Notes

9 Create routing scripts

See Create Routing Scripts for Task Routing, on page 165.

Create SocialMiner and Finesse Applications

10 Create the SocialMiner multichannel application to begin
task requests.

See Sample SocialMiner HTML Task Application, on page
165.

11 Create the Finesse applications to manage nonvoice agent
and dialog states.

See Sample Finesse Code for Task Routing, on page 165.

Set up Finesse

12 Upload the Finesse desktop gadgets to the desktop layout
(optional).

See the Cisco Finesse Administration Guide at
https://www.cisco.com/c/en/us/support/
customer-collaboration/finesse/products-user-guide-list.html.

Configure Finesse with the AW

Step 1

Step 2
Step 3

Finesse connects to SocialMiner to transfer Task Routing tasks and resubmit tasks for RONA. The Finesse
AWDB user requires special database permissions to access SocialMiner connection information. Map the
user to the Side A, AWDB, and primary databases. In these databases, give the user the db_datareader and
public roles.

Before you begin

Configure the Contact Center Administration and Data Server Connection Settings on Finesse. You need the
Finesse AWDB username to complete this procedure.

See the Cisco Finesse Administration Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/
finesse/products-user-guide-list.html.

See the Installing and Configuring Guide for Cisco HCS for CC at https://www.cisco.com/c/en/us/support/
unified-communications/hosted-collaboration-solution-contact-center/products-installation-guides-list.html.

Procedure

Determine whether the Finesse AWDB user is a domain user or a SQL user. If the user is a domain user,
proceed to the last step in the procedure (step 7). Otherwise, complete all of the steps.

Launch Microsoft SQL Server Management Studio on the Unified CCE Administration Client workstation.
Connect to the Side A Logger using the default credentials.
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Step 4

Step 5

Step 6
Step 7

Configure Network VRU and Network VRU Scripts .

Navigate to Security > Logins. Right-click the Finesse AWDB username.
The Login Properties screen opens.

Select the User M apping page, and perform the following:

a) Verify that the databases associated with Side A and AWdb are checked.
b) Check the master database.

c) Select the Side A database. In the Database role member ship for section, check the db_datareader and
public roles.

Repeat this step for the AWdb and master databases.
d) Click OK.
Repeat these steps on the Side B Logger.

Execute the following SQL queries as the SQL administrative user "sa" or as a user with sysadmin privileges.

For <user>, enter the Finesse AWDB username. If the Finesse AWDB user is a domain user, rather than a
SQL user, use the <domain\user> format.

USE master

GO
GRANT CONTROL ON CERTIFICATE :: UCCESymmetricKeyCertificate TO "<user>"
GRANT VIEW DEFINITION ON SYMMETRIC KEY :: UCCESymmetricKey TO "<user>"

Configure Network VRU and Network VRU Scripts

Step 1
Step 2

The Network VRU is used to queue nonvoice tasks if an agent is not available to handle them. The Network
VRU Script is used to return estimated wait time to customers. For more information on writing routing scripts
that return estimated wait time, see the Scripting and Media Routing Guide for Cisco Unified ICM/Contact
Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-user-guide-list.html.

When you configure the Network VRU Script, you specify whether it is interruptible. The Interruptible
setting for the Network VRU Script controls whether the script can be interrupted (for example if an agent
becomes available). This setting is not related to the Media Routing Domain | nterruptible setting, which
controls whether an agent working on a task in that MRD can be interrupted by a task from a non-interruptible
MRD.

Procedure

In Configuration Manager, use the Network VRU Explorer tool to configure and save a type 2 VRU.
Use the Network VRU Script List tool to add a Network VRU Script that references this Network VRU.

You can accept the default values.
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. Configure the Media Routing PG and PIM

Configure the Media Routing PG and PIM

Step 1
Step 2

Step 3
Step 4

Step 5

Procedure

In Configuration Manager, open the PG Explorer tool to configure a media routing PG.

Create a media routing PIM and routing client for SocialMiner.

Write down the Logical Controller ID and the Peripheral ID. You will use them when you set up the PG.

On the Peripheral tab in the PG Explorer tool, check the Enable post routing check box.

On the Routing Client tab in the PG Explorer tool, select the Multichannel option from the Routing Type
drop-down list box.

Note The Default call type setting is not supported for tasks submitted through the Task Routing APIs.

On the Advanced tab in the PG Explorer tool, select the type 2 Network VRU that you created.

Set up the Media Routing PG and PIM

A

Step 1
Step 2

Step 3

Step 4
Step 5
Step 6

Caution

Before performing the step to enable the secured connection between the components, ensure that the security
certificate management process is completed.

Set up the Media Routing PG and PIM

Procedure

From Cisco Unified CCE Tools, select Peripheral Gateway Setup.

On the Components Setup screen, in the Instance Components panel, select the PG Instance component. If
the PG does not exist, click Add. If it exists, click Edit.

On the Components Setup screen, in the Instance Components panel, select the PG Instance component. If
the PG does not exist, click Add. If it exists, click Edit.

In the Peripheral Gateways Properties screen, click Media Routing. Click Next.

Click Yes at the prompt to stop the service.

From the Peripheral Gateway Component Properties screen, click Add, select the next PIM, and configure
with the Client Type of Media Routing as follows.

a)
b)
c)

d)

e)

Check Enabled.
In the Peripheral Name field, enter MR.

In the Peripheral ID field, enter the Peripheral ID that you recorded when you configured the Media
Routing PG and PIM.

In the Peripheral I D field, enter the Peripheral ID that you recorded when you configured the Media
Routing PG and PIM.

For Application Hostname (1), enter the hostname or IP address of SocialMiner.
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Step 7
Step 8

Step 9

Step 10
Step 11
Step 12

2)
h)

i)

Add SocialMiner as an External Machine .

By default, SocialMiner accepts the MR connection on Application Connection Port 38001. The
Application Connection Port setting on SocialMiner must match the setting on the MR PG. If you change
the port on one side of the connection, you must change it on the other side.

Leave the Application Hostname (2), field blank.
Keep all other values.
Check the Enable Secured Connection option.

This establishes a secured connectionbetween MR PIM and Application Server.

Ensure that you provide the correct information in the Application Hostname (1) and Application
Connection Port (1) fields.

Click OK.

On the Peripheral Gateway Component Properties screen, enter the Logical Controller ID that you recorded
when you configured the Media Routing PG and PIM.

On the Peripheral Gateway Component Properties screen, enter the Logical Controller ID that you recorded
when you configured the Media Routing PG and PIM.

Accept defaults and click Next until the Setup Complete screen opens.

At the Setup Complete screen, check Yesto start the service. Click Finish.
Click Exit Setup.

Repeat this procedure for Side B.

Add SocialMiner as an External Machine

When you add SocialMiner as an External Machine in the Unified CCE Administration System Inventory,
the system automatically performs the following SocialMiner configuration:

* Enables and completes the CCE Configuration for Multichannel Routing settings in SocialMiner
Administration.

These settings include the hostnames of the MR PGs and the Application Connection Port you specified
when setting up the MR PG and PIM.

These settings include the hostnames of the MR PGs and the Application Connection Port you specified
when setting up the MR PG and PIM.

* Configures the Task feed and the associated campaign and Connection to CCE notification needed for
the Task Routing feature, with the following names:

* Task feed: Cisco_Default Task Feed
» Campaign: Cisco_Default Task Campaign
* Notification: Cisco_Default Task Notification

» Tag: cisco_task tag

Note If the Task feed has been configured to use a different tag, the Connection to

CCE notification is configured to use that tag.
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. Unified CCE Administration and Configuration Manager Tools

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8
Step 9
Step 10
Step 11

Procedure

Navigate to Unified CCE Administration > I nfrastructure> Inventory.

Click Add.

Click Add.

Select SocialMiner from the drop-down list.

Enter the fully qualified domain name (FQDN), hostname or IP address in the Hostname field.

Note The system attempts to convert the value you enter to FQDN.

Enter the SocialMiner Administration username and password.

Select the Side A and Side B Media Routing PGs.

Enter the Application Port you specified when setting up the MR PG and PIM. The default value is 38001.
Select the Side A and Side B Media Routing PGs.

Enter the Application Port you specified when setting up the MR PG and PIM. The default value is 38001.
Click Save.

Unified CCE Administration and Configuration Manager Tools

Step 1
Step 2

This topic explains the Unified CCE Administration and Configuration Manager tools you need to configure
Task Routing.

Before you begin

For details on the procedures for these steps, refer to the Unified CCE Administration online help and the
Configuration Manager online help.

Procedure

Sign in to Unified CCE Administration.
From the M anage menu, configure the following:

Item to Configure Details

Media Routing Domains | Create an MRD for each type of task that the third-party multichannel application
submits to CCE (email, chat, and so on).

Precision Queues Configure either skill groups or precision queues.
If you configure precision queues:

» For Media Routing Domain, select one of the Task Routing MRDs you
created.

* Associate agents with attributes that are part of the precision queue steps.
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Step 3
Step 4

Unified CCE Administration and Configuration Manager Tools .

Launch Configuration Manager.

Configure the following:

Item to Configure

Details

Call Types

Create call types for Task Routing.

Dialed Numbers

Create dialed numbers for Task Routing. Add the numbers or strings that the custom
application will use when submitting task requests.

* On the Attributes tab, select a Task Routing MRD from the M edia routing
domain drop-down list box.

* On the Dialed Number M apping tab, map the script selector to a call type
you created for Task Routing.

Important Each dialed number must be associated with a call type. Default
call type is not supported for tasks submitted with Task Routing
APIs.

Skill Groups

Configure either skill groups or precision queues.
If you configure skill groups:

* For Media Routing Domain, select one of the Task Routing MRDs you
created.

* Assign agents to the skill group.

Expanded Call Variable

You can use an existing Expanded Call Variable, or you can create an Expanded
Call Variable for Task Routing, depending on the needs of your third-party
multichannel application.

Note Arrays are not supported with the Task Routing feature.

CCE solutions support the Latin 1 character set only for Expanded Call
Context variables and Call variables when used with Finesse and
SocialMiner.

Agent Desk Settings

If agents will use a Task Routing gadget in the Finesse desktop, leave the L ogout
inactivity time setting for those agents blank, or remove the existing value.

Otherwise, if the agent exceeds the L ogout inactivity timein the voice MRD, the
agent is logged out of the Cisco Finesse desktop, even if the agent is actively
working on tasks from nonvoice MRDs. The agent needs log into the desktop again
to continue working on the nonvoice tasks.
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. Unified CCE Administration, Unified CCE Configuration Manager, and Unified CCDM Portal Configuration

Unified CCE Administration, Unified CCE Configuration Manager, and Unified
CCDM Portal Configuration

Step 1
Step 2

Step 3
Step 4

Step 5
Step 6

This topic explains the Unified CCE Administration, Configuration Manager, and Unified CCDM portal tools
you need to configure Task Routing.

Before you begin

For details on the procedures for these steps, refer to the Unified CCE Administration online help, Configuration
Manager online help, and the Unified CCDM portal online help.

Procedure

Sign in to Unified CCE Administration.
From the M anage menu, configure the following:

Item to Configure Details

Media Routing Domains | Create an MRD for each type of task that the third-party multichannel application
submits to CCE (email, chat, and so on).

Launch Configuration Manager.

Configure the following:

Item to Configure Details

Agent Desk Settings If agents will use a Task Routing gadget in the Finesse desktop, leave the L ogout
inactivity time setting for those agents blank, or remove the existing value.

Otherwise, if the agent exceeds the L ogout inactivity timein the voice MRD, the
agent is logged out of the Cisco Finesse desktop, even if the agent is actively
working on tasks from nonvoice MRDs. The agent needs to log into the desktop
again to continue working on the nonvoice tasks.

Log in to the Unified CCDM portal as tenant or sub customer user.
Configure the following:

Item to Configure Details
Call Types Create call types for Task Routing.
Dialed Numbers Create dialed numbers for Task Routing. Add the numbers or strings that the

third-party multichannel application will use when submitting task requests.

* For Media Routing Domain, select one of the Task Routing MRDs.

« For Call Type, select a call type that you created for Task Routing.

Important Each dialed number must be associated with a call type. Default
call type is not supported for tasks submitted with Task Routing
APIs.
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Increase TCDTimeout Value .

Item to Configure Details

Skill Groups Configure either skill groups or precision queues.
If you configure skill groups:

» For Media Routing Domain, select one of the Task Routing MRDs you
created.

* Assign agents to the skill group.

Precision Queues Configure either skill groups or precision queues.
If you configure precision queues:

» For Media Routing Domain, select one of the Task Routing MRDs you
created.

* Associate agents with attributes that are part of the precision queue steps.

Expanded Call Variable | You can use an existing Expanded Call Variable, or you can create an expanded
call variable for Task Routing, depending on the needs of your third-party
multichannel application.

Note Arrays are not supported with the Task Routing feature.

CCE solutions support the Latin 1 character set only for Expanded Call
Context variables and Call variables when used with Finesse and
SocialMiner.

Increase TCDTimeout Value

Complete this procedure only if you are using precision queues and routing tasks with potentially long durations,
like emails.

Several precision queue fields in the Termination Call Detail record are not completed until the end of a
task. These precision queue fields are blank for tasks whose durations exceed the TCDTimeout registry key
value. The default value of theTCDTimeout registry key is 9,000 seconds (2.5 hours).

If you are configuring a system to handle email or other long tasks, you can increase the TCDTimeout registry
key value to a maximum of 86,400 seconds (24 hours).

Change the registry key on either the Side A or B Router.
Change the registry key on either the Side A or B Router.
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Procedure

Modify the following registry key: HKEY LOCAL MACHINE\SOFTWARE\Cisco Systems,
Inc.\Icm\<instance
name>\Router<A/B>\Router\CurrentVersion\Configuration\Global\TCDTimeout.

Context Service

Cisco Context Service is a cloud-based omnichannel solution for Cisco Contact Center Enterprise Solutions.
It enables you to capture your customer’s interaction history by providing flexible storage of
customer-interaction data across any channel.

Various components in the CCE Solution provide out of the box integration with Context Service. Context
Service also provides an API for integration with your own applications or third-party applications to capture
end-to-end customer-interaction data.

For more information about Context Service, see Cisco Packaged Contact Center Enterprise Features Guide
at https://www.cisco.com/c/en/us/support/customer-collaboration/packaged-contact-center-enterprise/
products-maintenance-guides-list.html

For information on Context Service setup, the the "Context Service" chapter.

Context Service for Task Routing Tasks

Context Service can store data for Task Routing task contacts. When Context Service is enabled, SocialMiner
selects pieces of data from an incoming task request and saves it as an activity in the cloud.

You can specify the media type of the request in the task request. If you don't specify the media type, then
the media type defaults to “event”.

If you have already saved the task request information in request and include its reference URL in the task
request, SocialMiner doesn't create a new activity. SocialMiner passes the existing Request ID directly to
Unified CCE for use by the Finesse clients.

When creating a new contact, SocialMiner looks up the customer by the author field of the SocialMiner social
contact. The results of the lookup determine whether the contact includes a customer reference, as follows:

* If zero or many customers are returned, the contact doesn't include a customer reference.

« If one customer is returned, the contact includes that customer reference.

SocialMiner populates the following fields from the Context Service cisco.base.pod field set for Task Routing
task contacts:

» Context_Notes: This field is populated with the value of SocialContact.description.
» Context_POD_Source_Cust_Name: This field is populated with the value of SocialContact.author.

» Context_ POD_Source Email: To populate this field, SocialMiner looks up the email address using
the SocialContact.author field.
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Create Routing Scripts for Task Routing .

Create Routing Scripts for Task Routing

For complete multichannel scripting information, see the Scripting and Media Routing Guide for Cisco Unified
ICM/Contact Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-user-guide-list.html.

For complete multichannel scripting information, see the Scripting and Media Routing Guide for Cisco Unified
ICM/Contact Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-user-guide-list.html.

|

Important  Ensure that the routing scripts include skill groups or precision queues from the appropriate Media Routing

Domains to handle all of the types of tasks that can be routed with the scripts. For example, if a script is used
to route email tasks, be sure that the script includes skill groups or precision queues from an email MRD.

Sample Code for Task Routing

Cisco Systems has made sample Task Routing application code for SocialMiner and Finesse available to use
as baselines in building your own applications.

Sample SocialMiner HTML Task Application

The sample SocialMiner HTML Task application:
* Submits task requests to CCE.

* Retrieves and displays the estimated wait time, if it has been configured in CCE.

)

Note

You cannot copy and paste this code to achieve a working application. It is only a guideline.

The sample application uses the Task API. For more information about how to use the Task API, see the Cisco
SocialMiner Developer Guide at https://developer.cisco.com/site/socialminer/documentation/.

Procedure

Step 1

Download the sample HTML Task application from DevNet: https://developer.cisco.com/site/task-routing/.
Step 2

Read the sample application's readme.xt file to complete the prerequisites and use the sample application.

Sample Finesse Code for Task Routing

The Finesse sample Task Management Gadget application lets agents perform the following actions in
individual nonvoice Media Routing Domains:

* Sign in and out.
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. Task Routing Reporting

* Change state.

» Handle tasks.

The sample gadget also signals the Customer Context gadget to display a customer record.

N

Note  You cannot copy and paste this code to achieve a working application. It is only a guideline.

For more information about how to use the APIs available for Task Routing, see the Cisco Finesse Web
Services Developer Guide at https://developer.cisco.com/site/finesse/.

Procedure

Step 1 Download the sample Task Management Gadget application (TaskManagementGadget-x.x.zip) from DevNet:
https://developer.cisco.com/site/task-routing/.

Step 2 Read the sample application's readme.txt file to complete the prerequisites and use the sample application.

For more information about uploading third-party gadgets to the Finesse server, see the "Third Party Gadgets"
chapter in the Cisco Finesse Web Services Developer Guide at https://developer.cisco.com/site/finesse/.

For more information about adding third-party gadgets to the Finesse desktop, see the "Manage Third-Party
Gadgets" chapter in the Cisco Finesse Administration Guide at https://www.cisco.com/c/en/us/support/
customer-collaboration/finesse/tsd-products-support-series-home.html.

Task Routing Reporting

Cisco Unified Intelligence Center CCE reports include data for voice calls and nonvoice Task Routing tasks.
You can filter these All Fields and Live Data report templates by Media Routing Domain:

» Agent Real Time

* Agent Skill Group Real Time

* Enterprise Skill Group Real Time

* Enterprise Skill Group Real Time

* Peripheral Skill Group Real Time All Fields

* Precision Queue Real Time All Fields

+ Agent Precision Queue Historical All Fields

+ Agent Skill Group Historical All Fields

* Peripheral Skill Group Historical All Fields

* Precision Queue Abandon Answer Distribution Historical

* Precision Queue Interval All Fields
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» Skill Group Abandon-Answer Distribution Historical
* Precision Queue - Live Data

» Skill Group - Live Data

See the Reporting Concepts for Cisco Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/
en/us/support/customer-collaboration/unified-contact-center-enterprise/products-user-guide-list.html for
information about multichannel reporting data.

See the Reporting Concepts for Cisco Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/
en/us/support/customer-collaboration/unified-contact-center-enterprise/products-user-guide-list.html for
information about multichannel reporting data.
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CHAPTER 1 3

Unified Communications Mananger Extension
Mobility

* Capabilities, on page 169
* Configuration, on page 170

Capabilities

Extension Mobility is a Unified Communications Manager feature that you can use in Unified CCE. The
feature enables users to temporarily configure a phone as their own by logging in to that phone. Once a user
logs in, the phone adopts the individual user device profile information, including line numbers, speed dials,
services links, and other user-specific properties of a phone.

Cisco Extension Mobility (EM) works on phones that are located within the same Cisco Unified
Communications Manager cluster. Cisco Extension Mobility Cross Cluster (EMCC) works on phones that
are located in different Cisco Unified Communications Manager clusters.

The main documentation on this feature is in the Unified Communications Manager documentation. For more
information, see the following sources:

Information Type Sources

Design considerations Cisco Collaboration System Solution Reference Network Designs at
https://www.cisco.com/c/en/us/support/unified-communications/
unified-communications-manager-callmanager/
products-implementation-design-guides-list.html

Feature description and Feature Configuration Guide for Cisco Unified Communications
configuration Manager at https://www.cisco.com/c/en/us/support/
unified-communications/unified-communications-manager-callmanager/
products-maintenance-guides-list.html

Extension Mobility API https://developer.cisco.com/site/extension-mobility/
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Configuration

You configure EM and EMCC in the Cisco Unified Communications Manager. Take into account the following
interactions between Unified CCE and Unified Communications Manager for successful implementation of
EM and EMCC within a Unified CCE solution:

* For Unified CCE configurations with multiline agent phone line control on the PG, configure all directory
numbers for the user profile in Cisco Unified Communications Manager as follows:

Setting Value
Maximum Number of Calls 2
Busy Trigger 1

* For Unified CCE configurations with single-line agent phone line control on the PG, configure the
secondary lines (but not the primary ACD line) for the directory number of the user profile in Cisco
Unified Communications Manager as follows:

Setting Value
Maximum Number of Calls 4
Busy Trigger 2

* You cannot use phones with an | P Addressing M ode of I Pv6 Only for Cisco Extension Mobility. If
you want to use Cisco Extension Mobility with the phone, you must configure the phone with an IP
Addressing Mode of | Pv4 Only or | Pv4 and | Pv6.

* Agents can log in to multiple devices, depending on the I ntra-cluster Multiple Login Behavior service
parameter. You can set this parameter for EM implementations. EMCC implementations require that
you set this parameter for multiple logins.

If an agent fails to log out of a device, another agent who attempts to access that device gets a "shared
line" error. Follow these Unified Communications Manager configuration guidelines to avoid shared
line errors:

 For EM implementations with hard phones, set the I ntra-cluster MultipleL ogin Behavior Extension
Mobility service parameter to "Auto Logout".

* For EM implementations with a mix of hard and IP phones and for all EMCC implementations,
limit the time that an agent can remain logged in to a device. Set the I ntra-cluster Maximum
LoginTimesservice parameter to the typical time that an agent remains logged in to a device during
a shift.

For more information on Extension Mobility with Unified CCE, see UCCE Integration with CM Configuration
Example at https://www.cisco.com/c/en/us/support/docs/customer-collaboration/
unified-contact-center-enterprise/117777-config-ucce-00.html.
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CHAPTER 1 4

Whisper Announcement

* Capabilities, on page 171
* Configure Whisper Announcement, on page 173
» Reporting and Serviceability, on page 182

Capabilities

Whisper Announcement plays a brief, prerecorded message to an agent just before the agent connects with
each caller. The announcement plays only to the agent; the caller hears ringing (based on existing ring tone
patterns) while the announcement plays.

The content of the announcement can contain information about the caller that helps prepare the agent to
handle the call. The information can include caller language preference, choices the caller made from a menu
(Sales, Service), customer status (Platinum, Gold, Regular), and so on.

After Whisper Announcement is enabled, the played announcements are specified in the call routing scripts.
The determination of which announcement to play is controlled in the script and is based on various inputs,
such as the dialed number, a customer ID look up in your customer database, or selections you made from a
VRU menu.

While a Whisper Announcement Is Playing

Only one Whisper Announcement can play for each call. While a Whisper Announcement is playing, you
cannot put the call on hold, transfer, conference, or release the call, or request supervisor assistance. These
features become available again after the whisper is complete.
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. Whisper Announcement Call Flows

Whisper Announcement Call Flows

Figure 19: Whisper Announcement Call Flow
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The standard call flow with Whisper Announcement is as follows:

Incoming call arrives at CVP from the carrier.

CVP sends the call to Unified CCE.

Unified CCE instructs CVP to queue the call.

CVP sends the call to the Voice Browser.

Unified CCE sends the agent label with the whisper announcement prompt.
CVP sends the call to Unified CM.

Unified CM sends the call to the agent phone.

The caller continues to hear ringback. The agent hears the whisper announcement.

© © N o 0o k~ w0 D P

When the whisper announcement ends, the caller connects to the agent.

Whisper Announcement Design Impacts

Whisper Announcement has these limitations:

» Announcements do not play for outbound calls made by an agent. The announcement plays for inbound
calls only.

» For Whisper Announcement to work with agent-to-agent calls, use the SendToVRU node before you
transfer the call to the agent. Transfer the call to Unified CVP before you transfer the call to another
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agent. Then, Unified CVP can control the call and play the announcement, regardless of which node
transfers the call to Unified CVP.

» Announcements do not play when the router selects the agent through a label node.
* CVP Refer Transfers do not support Whisper Announcement.

* Whisper Announcement supports Silent Monitoring. However, for Unified Communications
Manager-based Silent Monitoring, supervisors cannot hear the announcements themselves. The supervisor
desktop dims the Silent Monitor button while an announcement plays.

* Only one announcement can play for each call. While an announcement plays, you cannot put the call
on hold, transfer, or conference; release the call; or request supervisor assistance. These features become
available again after the announcement completes.

* The codec settings for Whisper Announcement recording and the agent's phone must match. For example,
if Whisper Announcement is recorded in G.711 ALAW, the phone must also be at G.711 ALAW. If
Whisper Announcement is recorded in G.729, the phone must support or connect using G.729.

* In an [Pv6-enabled environment, Whisper Announcement might require extra Media Termination Points
(MTPs).

Whisper Announcement Media Files

You store and serve your Whisper Announcement audio files from the Unified Contact Center Enterprise
(Unified CCE) media server. This feature supports only the wave (. wav) file type. The maximum play time
for a Whisper Announcement is subject to a timeout. Playback terminates at the timeout regardless of the
actual length of the audio file. The timeout is 15 seconds. In practice, you may want your messages to be
much shorter than that, 5 seconds or less, to shorten your call-handling time.

Whisper Announcement with Transfers and Conferences

When an agent transfers or starts a conference call to another agent, the second agent hears an announcement
if the second agent's number supports Whisper Announcement. For consultative transfers or conferences,
while the announcement plays, the caller hears whatever normally plays during hold. The first agent hears
ringing. In the case of blind transfers, the caller hears ringing while the announcement plays.

Whisper Announcement Sizing Considerations

The impact of Whisper Announcement on solution component sizing is not as significant as the impact caused
by Agent Greeting.

Configure Whisper Announcement

Complete the following procedures for Whisper Announcement configuration:
* Configure Gateway, on page 174
* Configure Unified CVP, on page 174
* Configure Unified CCE, on page 176
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Configure Gateway

Gateway uses two different dialed numbers for Whisper Announcement.

* 91919191 number calls the ring tone that the caller hears while the whisper plays to the agent
* 9191919100 number calls the whisper itself

Configure a dial peer for incoming number 9191919100 and 91919191 as follows:

dial-peer voice 919191 voip
description CVP SIP ringtone dial-peer
service ringtone

incoming called-number 9191T
voice-class sip rellxx disable
dtmf-relay rtp-nte

codec g7l1llulaw

no vad

Configure Unified CVP

Create Whisper Announcement Audio Files

You must create audio files for each different Whisper Announcement you want to use on your system; for
example, “Sales, English” or “Soporte Técnico en Espafiol.” Create the files using the recording tool of your
choice.

When recording your files, follow these rules:

* The media files must be in wave (.wav) format. Your wave files must match Unified CVP encoding and
format requirements (G729, CCITT G.711 A-Law and U-law 8 kHz, 8 bit, mono).

* To avoid cutting off files when they are played, make sure they do not exceed the Whisper Announcement
play limit (15 seconds).

» Test your audio files. Ensure that they are not cut off and that they are consistent in volume and tone.

* To reduce the likelihood of scripting errors, decide ahead of time on a file-naming convention that is
easy for you and others to remember. For example, en_sales.wav, sp_support.wav.

Deploy Whisper Announcement Audio Files to Media Server

Deploy your whisper audio files to your Unified CVP media server using whatever file-transfer method you
prefer. The most important consideration is where on the server to place the files. HTTP requests for media
server audio files are constructed as

http://<media server>/<locale directory>/<application directory>/<file name>.

The CVP defaults for the locale and application directories are en-us/app. Unified CCE automatically
adds en-us/app to the server name when making HTTP requests for media files.

For example, if:

* The script node that defines the media server has a value of http://myserver.mydomain.com
and
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* The script node that defines the audio file to play has a value of en _sales.wav

Then the HTTP request for the file is automatically constructed as
http://myserver.mydomain.com/en-us/app/en_sales.wav

If you store your files in a different locale and application directory, your routing scripts must include variable
nodes that define those alternate locations. Make note of the directories in which you place your files and
communicate the locations to your script authors.

Make sure that the directories in which you deploy your files have the appropriate permissions to allow Read
access.

CVP with the Streaming Audio (Helix) and Whisper Announcement

You must set the user.microapp.media_server variable, to point to the whisper announcement .wav file, for
the CVP Whisper Announcement feature to work while Streaming Audio feature (using Helix) is also on.
This is achieved by setting the Call.Whisper Announcement variable to the complete URL of the whisper
announcement wav file. The Call.Whisper Announcement variable should be put in using the
http://<VXMLserverip>:7000/CVP/audio/XXX.wav URL format.

Using a Default Media Server

Optionally, CVP lets you define a default media server. (You do this in the CVP Operations Console; see
your CVP documentation for more information.) If a default media server is defined in CVP, script authors
need not identify the media server in their call routing scripts provided the files that they request are available
from that server.

Configure the Whisper Announcement Service Dialed Numbers

Unified CVP uses two different dialed numbers for Whisper Announcement:

The first number calls the ring tone service that the caller hears while the whisper plays to the agent. The
Unified CVP default for this number is 91919191.

The second number calls the whisper itself. The Unified CVP default for this number is 9191919100.

For Whisper Announcement to work, your dial number pattern must cover both of these numbers. The easiest
way to ensure coverage is through the use of wild cards such as 9191*. However, if you decide to use an exact
dialed number match, then you must specify both 91919191 and 9191919100.

Configure Dialed Numbers

You configure the dialed numbers for Whisper Announcement in the Unified CVP Operations Console at
System > Dialed Number Pattern > Add new. For the Dialed Number Pattern Types, select Enable L ocal
Static Route. Once Enable Local Static Route is checked, select either Route to Device or Routeto SIP
Server Group for VXML gateways. Then save and deploy the dialed number.

It may be necessary to override the dialed number plan for the default Whisper DN, if the default DN conflicts
with the overall dial number plan.

Change the Whisper Announcement Default Dialed Number

To override the DN pattern from the SIP subsystem level in CVP OAMP:
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Procedure

Step 1 Select Device Management > Unified CVP Server.
Step 2 Select the Call Server on which to override the default whisper DN.
Step 3 Select the SIP tab.

Step 4 Override the default value 0f 91919191 configured under the DN on the Gateway to play theringtone field.
Step 5 Click Save & Deploy.

Configure Unified CCE

Create Whisper Announcement Script

It is very important to deploy Whisper Announcement with the Call. Whisper Announcement variable and to
set .wav file in your Unified CCE routing scripts.

Figure 20: Whisper Announcement Script
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Specify WhisperAnnouncement Call Variable

To include Whisper Announcement in a script, insert a Set Variable node that references the
WhisperAnnouncement call variable. The WhisperAnnouncement variable causes a whisper to play and
specifies the audio file it should use. Typically, you use a single whisper prompt for a single call type. As a
result, you use only one WhisperAnnouncement set node for each script. However, as needed, you can set
the variable at multiple places in your scripts to allow different announcements to play for different endpoints.
For example, for skills-based routing, you can specify the variable at each decision point used to select a
particular skill group or Precision Queue.
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Note Only one Whisper Announcement can play for each call. If a script references and sets the
WhisperAnnouncement variable more than once in a single path through a script, the last value to be set is
the one that plays.

Use these settings in the Set Variable node for Whisper Announcement:

* Object Type: Call.

* Variable: Must use the WhisperAnnouncement variable.

* Value: Specify the filename of the whisper file. For example: “my_ whisper.wav” or “my_ whisper”.
* Specify the filename only, not its path.
* You must enclose the filename in quotation marks.
* The filename is not case sensitive.
* The filename cannot include spaces or characters that require URL encoding.

* The .wav extension is optional. If you omit it, Unified CVP adds it automatically in the HTTP
request.

Specify Unified CVP Media Server Information

If you define a default media server in your CVP Operations Console and it is the server from which you
serve your whisper files, then you need not specify the media server in your routing scripts. However, if you
do not define a default media server, or if you store your whisper file on a server other than the default, then
your scripts must include a Set Variable node that identifies that server.

To specify your media server, use the following settings in the Set Variable node:

* Object Type: Call.
* Variable: Must use the user.microapp.media server ECC variable.

* Value: Specify the HTTP path to the server. For example: “http://myserver.mydomain.net.” You must
enclose the path in quotes.

* Alternately you can specify an IP address in place of a DNS. Include the listening port number if the
media server web server listens on a port other than 80 (for HTTP) or 443 (for HTTPS).

Specify Whisper File Locale and Application Directories

CVP uses a default storage directory for media files: <web_server root>/en-us/app. To take advantage of
this, Unified CCE call routing scripts automatically add “en-us/app,” to the server name when constructing
HTTP requests for media files. For example:

« If the script node that defines the media server has a value of “http://myserver.mydomain.com” and...
* The script node that defines which audio file to play has a value of “en_sales.wav,” then...

* The HTTP request for the file is automatically constructed as

http://myserver.mydomain.com/en-us/app/en_sales.wav
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If your whisper audio files are stored in a different locale directory, you must add a Set Variable node to your
script that identifies the locale directory. Similarly, if your whisper files are stored in a different application
directory, you must add a Set Variable node that identifies that directory.
Specify Locale Directory
Use these settings in the Set Variable node to specify your locale directory:
* Object Type: Call.

* Variable: Must use the user.microapp.locale ECC variable.

* Value: Specify the directory name. For example: “pt-br,” You must enclose the path in quotes.

Specify Application Directory
Use these settings in the Set Variable node to specify your application directory:
* Object Type: Call.
* Variable: Must use the user.microapp.app_media_lib ECC variable.

* Value: Specify the directory name. For example: to use a directory “wav_files” in place of the default
directory “app,” enter “wav_files.” To use a sub-directory “wav_files” “app,” enter “app/wav_files.”
You must enclose the path in quotes.

Variable Length for Media Server Locale and Application Directory Variables

If you do include Set Variable nodes for the media server, locale, or application directories, ensure that the
values you set for them do not exceed the Maximum Length settings for their corresponding ECC variables.

For example, if you include a Set Variable node for the media server with a value of
“http://mysubdomain.mydomain.co.uk,” the string is 33 characters long. Therefore, the Maximum Length
setting for the user.microapp.media_server ECC variable must be 33 or greater. If it is not, you must increase
the Maximum Length setting. Otherwise, the server name is truncated in the HTTP request for the file and
the file is not found. You configure ECC variables in the Unified CCE Configuration Manager at List Tools
> Expanded Call Variables List.

Specify Whisper File Locale and Application Directories

CVP uses a default storage directory for media files: <web_server root>/en-us/app. To take advantage of
this, Unified CCE call routing scripts automatically add “en-us/app,” to the server name when constructing
HTTP requests for media files. For example:

» If the script node that defines the media server has a value of “http://myserver.mydomain.com” and...
* The script node that defines which audio file to play has a value of “en_sales.wav,” then...

» The HTTP request for the file is automatically constructed as

http://myserver.mydomain.com/en-us/app/en_sales.wav

If your whisper audio files are stored in a different locale directory, you must add a Set Variable node to your
script that identifies the locale directory. Similarly, if your whisper files are stored in a different application
directory, you must add a Set Variable node that identifies that directory.
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Specify Locale Directory
Use these settings in the Set Variable node to specify your locale directory:
* Object Type: Call.
* Variable: Must use the user.microapp.locale ECC variable.

* Value: Specify the directory name. For example: “pt-br,” You must enclose the path in quotes.

Specify Application Directory
Use these settings in the Set Variable node to specify your application directory:
* Object Type: Call.

* Variable: Must use the user.microapp.app_media_lib ECC variable.

* Value: Specify the directory name. For example: to use a directory “wav_files” in place of the default
directory “app,” enter “wav_files.” To use a sub-directory “wav_files” “app,” enter “app/wav_files.”
You must enclose the path in quotes.

Variable Length for Media Server Locale and Application Directory Variables

If you do include Set Variable nodes for the media server, locale, or application directories, ensure that the
values you set for them do not exceed the Maximum Length settings for their corresponding ECC variables.

For example, if you include a Set Variable node for the media server with a value of
“http://mysubdomain.mydomain.co.uk,” the string is 33 characters long. Therefore, the Maximum Length
setting for the user.microapp.media_server ECC variable must be 33 or greater. If it is not, you must increase
the Maximum Length setting. Otherwise, the server name is truncated in the HTTP request for the file and
the file is not found. You configure ECC variables in the Unified CCE Configuration Manager at List Tools
> Expanded Call Variables List.

Test Whisper Announcement File Path

To test the path to the whisper file that you defined in you script variables, enter the complete URL into a
browser. The .wav file should play. For example:

* If your script includes: default media server + default locale + default application directory + whisper.wav,
then the path is “http://<default media_server>/en-us/app/whisper.wav”

* If your script includes: http://my_server.my domain.com + default locale + “app/wav_files” +
whisper.wav, then the path is “http://my_server.my domain.com/en-us/app/wav_files/whisper.wav”

Other Script Settings That Are Required for Whisper Announcement
These additional settings are required for Whisper Announcement to work:

* Enable Target Requery on all script nodes that follow the WhisperAnnouncement variable and target an
agent. These include Queue (to Skill Group or Precision Queue), Queue Agent, Route Select, and Select.
If Target Requery is not enabled, the Whisper Announcement does not play.

* When you run an agent transfer or a conference script, use a SendToVRU, a TranslationToVRU, or a
Run Script Request node before you target an agent.
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. Fail-Safe Timeout for Whisper Announcement in Unified CCE

Fail-Safe Timeout for Whisper Announcement in Unified CCE

Step 1
Step 2
Step 3
Step 4

Step 5

Unified CVP sends one message to Unified CCE each time a Whisper Announcement begins and a second
message when the announcement ends. The time stamps from these messages are used to calculate Whisper
Announcement data in Unified CCE reports.

If Unified CVP fails to send a Whisper Announcement end message toUnified CCE, the following occurs:

* Unified CCE cannot accurately calculate the whisper length, thus skewing report data.

* The agent cannot control the call (for example, put it on hold or transfer it) because these controls are
disabled while a Whisper Announcement is playing.

To prevent this, Unified CCE has a Whisper Announcement timeout setting. The value for this setting represents
the maximum Whisper Announcement play time that Unified CCE uses to calculate its report data.

The default is 20 seconds. This default is based on the default Whisper Announcement play time (specified

in Unified CVP) of 15 seconds. The extra 5 seconds in the Unified CCE fail-safe timeout is a buffer against
latency. If you modify the maximum Whisper Announcement play time in Unified CVP, modify the Unified
CCE Whisper Announcement fail-safe timeout accordingly.

The Unified CCE Whisper Announcement fail-safe timeout value should be equal to or greater than the
maximum Whisper Announcement play time setting in Unified CVP. Otherwise, Whisper Announcement
play time in Unified CCE reports are under-reported.

To change the fail-safe timeout value, complete the following steps for theUnified CCE peripheral by using
the PG explorer tool:

Procedure

In Unified CCE Configuration, select Tools> Explorer Tools> PG Explorer.

Click Retrieveto return a list of PGs (Peripheral Gateways).

Double-click the agent PG to expand it, and select the peripheral with client type CUCM or UCCE system.
On the Peripheral tab, enter the following text in the Configuration Parameter s field:

/WHSTMOUT <value in seconds>

Once you are finished, click Save.

Whisper Announcement Sample Scripts

Unified CCE includes sample routing scripts that demonstrate Whisper Announcement. You can use them as
learning tools and as models for your own Whisper Announcement scripts. They are the following:

* WA.ICM S—This script plays a Whisper Announcement.

* WA_AG.|CM S—This script plays both a Whisper Announcement and an Agent Greeting to play on
the same call flow.

The script files are located in the c:\icm\bin directory. In Unified CCE Script Editor, they are installed
to the application root directory.

. Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.0(1)
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\)

wa.cms Script ]

Note

the media server, locale, or application directories.

To use these scripts you must have a default media server configured in Unified CVP, and have the Whisper
file stored in the default location on the media server. For that reason, they do not include variables that specify

WA.ICMS Script

This script sets up a Whisper Announcement by setting the Whisper Announcement variable to the desired
wave file and then queuing the call to a skill group or Precision Queue. After an agent is selected from the
skill group or Precision Queue and the call routed to the agent, the whisper plays to the agent.

)

This script sets up a whisper
announcrment by setting the
whisper announcement variable to
the desired wav file and then queing
the call to a skill group. Once an
agent is selectad from the skill
group and the call routed to the
agent, the whisper will play to the
agent.
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Release the call under error ;

Release Call

Queue the call until agent
becomess available.
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Skill Group No. Y
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WA_AG.ICMS Script
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This script causes both a Whisper Announcement and an Agent Greeting to play.
Set figent Greeting Type,
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This text iz used 55 partof
This seript causes both a the greeting filename. It can
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-
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2% Release Call [V Release Call .
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Import Sample Whisper Announcement Scripts

To view or use the sample Whisper Announcement scripts, you must first import them into Unified CCE
Script Editor. Follow this procedure to import the scripts:
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Procedure

Step 1 Open Script Editor.
Step 2 Select File>Import Script and select the first of the two scripts to import.

In addition to importing the script, Script Editor tries to map imported objects. Some objects that are referenced
in the sample scripts, such as the external Network VRU scripts or the skill groups or Precision Queues, do
not map successfully. You must create these maps manually or change these references to point to existing
Network VRU scripts, skill groups, and Precision Queues in your system.

Step 3 Repeat steps 2 and 3 for the remaining script.

Reporting and Serviceability

Whisper time is not specifically broken out in Unified CCE reports. In agent, skill group, and Precision Queue
reports, the period during which the announcement plays is reported as Reserved agent state time. In the
Termination Call Detail records, it is treated as Ring Time.

Serviceability for Whisper Announcement includes system events to indicate reasons for Whisper
Announcement failures and counters to track the number of failed whisper events.

Component Failure and Whisper Announcement

Failure to Access CVP Media Server

If the connection to the CVP media server fails, or if a requested whisper audio file cannot be found, the call
proceeds normally without Whisper Announcement.

Whisper Announcement in Agent Desktop Software

No configuration is needed to integrate Whisper Announcement with agent desktop software. While a whisper
is playing, software on the agent desktop shows the call in the Ring state. Desk phones show the call in the
Talking state.

Using Agent Greeting with Whisper Announcement

You can use Agent Greeting along with the Whisper Announcement feature. Consider the following when
you use them together:

* On the call, the Whisper Announcement always plays first before the greeting.

* To shorten your call-handling time, you may want to use shorter whispers and greetings than you might
if you were using either feature by itself. A long whisper followed by a long greeting means a long wait
before an agent handles a call.

* Usually, agents that use Whisper Announcement handle different types of calls: for example, "English,
Gold Member, Activate Card, Spanish, Gold Member, Report Lost Card, English, Platinum Member,

. Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.0(1)
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Account Inquiry." Ensure the greetings your agents record are generic enough to cover the range of
customer calls they handle.
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